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1 - Introduction & Installation

Introduction
The Emulator X Software sampler is a professional software sampler and synthesizer 
based on the Emulator series of hardware samplers. The engineers and designers at 
E-MU Systems have brought their years of experience and expertise to create the most 
comprehensive and flexible software instrument ever.

Emulator X
Emulator X allows quick and easy creation of multitimbral setups on up to 32 different 
MIDI channels. Other features include the following:

Emulator X allows the serious synthesist and programmer to literally design custom 
instruments using the renowned Emulator 4 synthesis architecture.

• 24-bit sampling and playback

• Sample streaming from the hard disk allows huge sample banks.

• Up to 192 kHz sampling and playback

• 32-bit floating point internal processing

• Drag and drop sample, voice and preset selection

• Phase Locked Stereo signal path

• Ultra High Precision Pitch Interpolation (user selectable) 

• High Voice Polyphony (system dependent)

• Real-time controllers for all important control points

• 54 different filter types including multi-pole resonant filters, phasers, flangers, vocal 
filters and multi-parameter morphing filters.

• Extremely powerful, yet easy to use voice and sample zones allow crossfading by 
position, velocity or real-time controller up to 128 layers deep.

• Three multi-stage envelopes, two lag processors and two multi-wave LFO’s per 
voice.

• A complete collection of sample-based DSP functions including time compression/
expansion, equalization and sample rate conversion.

• Multiple solo modes and assignment groups let you simulate the playing response 
of physical instruments and classic synthesizers.
E-MU Systems 1
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Before you Begin…
You should have a good working knowledge of you computer’s operation system. For 
example, you should know how to use the mouse, standard menus and commands. You 
should also know how to cut, copy, paste, open and close files.

Notes, Tips and Warnings
Items of special interest are presented in this document as notes, tips and warnings.

System Requirements
To use Emulator X you will need at least:

Software Installation

Programs installed

Important

Install the EMU Digital Audio System audio card before installing and running 
Emulator X.

1. Insert the CD labeled “Emulator X Program Disc” into your CD-ROM drive.

2. On the CD-ROM, locate the file called “Install Emulator X” and double click on it.

3. Follow the instructions on the screen.

• 36 patchcords per voice allow you to get as complex as you want when building 
instruments. Arithmetic modifiers in the patchcord section allow you to construct 
complex synthesis models.

f Notes provide additional information related to the topic being discussed. Often, 
notes describe the interaction between the topic and some other aspect of the 
system.

E Tips describe applications for the topic under discussion.

�  Warnings are especially important, since they help you avoid activities that can 
cause damage to your files, your computer or yourself.

• Pentium III 1GHz or equivalent CPU (P4, 2 GHz or faster recommended)

• 512 MB RAM (1 GB DDR or greater recommended)

• Hard disk capable of 200 MB/sec transfer rate.

• Windows 2000 or XP

• Emulator X Ultra Sampler application

• Emulator X VSTi

• Emulator X Converter

• Emulator X Factory Sound Bank (optional)
2 Emulator X Operation Manual
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• The Emulator X applications have been installed inside “Creative Professional/
EmulatorX/Program Files.”

4. Look for any “ReadMe” files in the Emulator X folder or in the Start menu and read 
these before continuing. The readme files may contain important last minute infor-
mation that didn’t make it into this manual.

5. Remove the Emulator X application disk from the CD-ROM drive.

Install the Emulator X Sound Banks

6. Locate “Sound Disk 1” and insert it into the CD-ROM drive. This disk contains the 
Proteus Composer bank used in the tutorials.

7. If Windows AutoPlay mode is enabled for your CD-ROM drive, the installer begins 
running automatically.

8. Follow the onscreen instructions to install the bank on your hard disk. The Factory 
Sound Banks are installed inside “Creative Professional\ EmulatorX\Sound Banks” 
by default.

9. You can install the other sound bank disks now or at a later time.

10. Launch the Emulator X program by double clicking the Emulator X icon on the 
desktop or by selecting the Emulator X item from the Start menu.

Register your Software
Please register your software today to guarantee uninterrupted use.

Optimizing Your Computer for Emulator X
Windows: The following suggestions can help you configure your windows machine for 
optimal performance. Since systems vary, we recommend that you note the original 
settings of any system parameters you alter so that you can restore them in the event that 
unexpected problems occur as you seek to optimize your system for Emulator X:

• Seriously consider dedicating a computer as your audio workstation. This 
computer can be optimized for best audio performance.

• If possible, avoid assigning slower devices to the IDE controller used by your 
audio drive.

• Get the fastest hard disk drive you can afford, as this is the single most important 
component affecting Emulator X performance. Many drives now offer an 8MB 
data buffer, which can also improve performance. 

• Defragment your hard drive often.

• Perform a “clean” install of your operating system with only the minimum compo-
nents and programs installed. 

• Use the System Restore feature of Windows XP or other restoration program such 

as “Ghost®” or “Go Back®” to keep your system uncluttered and fast.

SCSI and IDE Drive Tips and Considerations
When considering the purchase of a new SCSI or IDE drive for use with Emulator X, 
make sure that the new drive supports a sustained data transfer rate of at least 2 
megabytes per second. While it is impossible to reliably calculate the needs of your 
computer's operating system — which must be considered in addition to Emulator X’s 
requirements — you can get an approximate idea of the necessary speed of your hard 
disk drive based on the bit depth and number of voices you need.
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Data Transfer Rate Chart

• Regularly check your hard drive for fragmentation and de-fragment the drive 
when necessary. Your drive will operate most efficiently when it’s not fragmented.

• If possible, use a two-drive system: one for audio, one for your system.

16 bits 44.1 k sample rate 86.2 k per Channel per second
48 k sample rate 93.8 k per Channel per second

24 bits 44.1 k sample rate 138 k per Channel per second
48 k sample rate 150 k per Channel per second
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Setting up your Audio
Before you can start making music, you have to establish a connection between 
Emulator X and your audio output hardware. This is done by selecting a software driver 
that makes this connection between hardware and software.

1. Select the Preferences screen from the menu bar.

2. In the Audio section of the menu, select E-MU ASIO (if not already selected). This 
setting interfaces with the E-MU Digital Audio System.

3.  With E-MU ASIO selected, the Emulator X will interface properly with the E-MU 
Digital Audio System. After running Emulator X, you may want to adjust the Audio 
Preferences for optimum performance on your computer system. See Audio Prefer-
ences on page 7.

4. If for some reason you want to use hardware that doesn’t support ASIO, select the 
DirectSound driver. For Emulator X to communicate with your sound card, you 
need to have Microsoft DirectSound installed on your computer and there must be a 
DirectSound driver installed for your audio hardware.

Please go to page 7 for complete explanations of the Audio Preferences.
E-MU Systems 5
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Setting up the Preferences
The preferences menu contains a variety of important controls used to configure 
Emulator X for your audio hardware and to customize the controls to suit the way you 
work.

� To Access the Preferences Menu

1. Select Preferences from the Options menu. The following screen appears.

2. The preferences menu is divided into four main groups. Click on the tab heading to 
select one of the four sets of controls.

Audio
Disk Streaming Controls, Audio Hardware Setup & Pitch Shift 
Algorithm selection.

MIDI
MIDI Inputs Channels 1-16 & 17-32, IntelliEdit, and Receive/Ignore 
Program Changes.

Controllers
This section allows you to set up the MIDI Continuous Controllers you 
want the Emulator X to receive.

Other
This group contains three miscellaneous controls that didn’t fit 
anywhere else: Load Last bank At Startup, Clear clip indicators after 
10 seconds, Track changes to multisetup via MIDI
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Audio Preferences

Streaming
When you load an Emulator X bank, you are not actually loading the sample files 
themselves into your computer’s RAM. Only the preset information and the first few 
seconds of the sample are loaded. The rest of the sample data is taken directly from the 
hard disk when needed.

This streaming technique makes fast loading times possible even when using huge 
banks that would clog a RAM-based sampler. Multi-layer, minute-long, stereo samples 
on each key are no problem for Emulator X. Sample streaming is not new. It was origi-
nally developed for hard disk audio recorders so that fast punch-ins and punch-outs 
could be achieved.

You have the option to enable or disable streaming audio. If streaming is turned off, the 
Emulator loads (or attempts to load) the entire bank into your computer’s RAM. 

If streaming is so great, why would you ever want to turn it off? Well, if you’re using your 
computer as an audio workstation, performing multiple simultaneous functions, sooner 
or later, you’ll exceed your computer’s CPU, memory or disk access resources. Sample 
streaming makes very heavy demands on your hard disk. If you’re recording other audio 
tracks, using multiple software plug-ins and playing Emulator X with a lot of voices, you 
may run into a disk access bottleneck. By disabling streaming and loading the bank into 
your unneeded RAM, your hard disk can be reserved for more critical operations.

Pre-roll 
f Tip: Decrease Pre-roll 
time for fast load times 
when auditioning sounds 
and creating new banks.

Increase pre-roll time 
when you’re playing 
many notes or dense 
sequences.

This important control allows you to set how many seconds of each sample should be 
loaded into RAM when the bank is loaded. This setting greatly influences the perfor-
mance of Emulator X when streaming is on. The setting you choose depends on: the 
number of samples you want to use and the amount of RAM in you want to dedicate to 
Emulator X. 

The smaller the pre-roll, the more disk access will be required for sustained sounds. 
Frequent disk access can overtax your computer system depending on its speed and the 
number of other disk dependent applications you have running. Large pre-roll times 
will improve polyphony and performance at the expense of system RAM and slower 
bank loading. If you set the pre-roll high enough, the entire bank will be loaded into 
RAM and no disk streaming will occur.
E-MU Systems 7
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Sample Buffers
This control allocates the amount of RAM that will be set aside for Emulator X (in other 
words, the number of the largest complete samples in the bank that can be kept in the 
RAM cache). As samples are played, they are loaded from the hard disk into RAM. If you 
play those samples again, they don’t have to be reloaded if they are already in RAM. This 
control sets the size of the RAM cache that will be kept and lowers disk access at the 
expense of RAM.

� To Optimize the Performance and Polyphony of your System:

The polyphony of the Emulator X is dependent on a variety of factors including:

Begin by choosing 44.1kHz or 48.kHz as your output sample rate.

The software-based filters can eat up CPU cycles and reduce polyphony.

Synthesizer parameters also use CPU cycles. When creating presets, feel free to use 
modulation cords as needed, but don’t leave cords half connected if you aren’t using 
them since these patch settings waste CPU cycles. Turn off both the source and desti-
nation of unused cords.

Audio Setup
These controls let you set audio quality parameters related to Emulator X and your 
sound card.

Type
You have a choice to use either Direct Sound or ASIO audio drivers. If you have another 
high quality sound card installed in your system, it will be shown in this field.

ASIO (Audio Stream Input/Output) is a cross-platform, multi-channel audio transfer 
protocol. ASIO is fast and supports 16-bit and 24-bit data width. To use Emulator X 
with the E-MU Digital Audio System, select the E-MU ASIO driver.

Selecting Direct Sound uses the audio output device specified in the control panel of 
your computer. In general using Direct Sound is not recommended because of speed 
and latency issues.

• The Pre-roll setting (if streaming is enabled).

• The Sample Buffers setting (if streaming is enabled).

• The CPU Cap setting.

• The bit depth of your samples —16 or 24 bits (24 bits = fewer voices)

• The sample rate of the audio hardware—44.1kHz, 48kHz, 96kHz. 

• The speed of your computer—CPU speed, RAM and hard disk access time.

Cost of Filters on Voice Count

No Filter No additional CPU load.

2nd Order Additional CPU load comparable to playing another 1/2 sample.

4th Order Additional CPU load comparable to playing another 3/4 sample.

6th Order Additional CPU load is comparable to playing 1 more sample.
(polyphony is divided by 2)

12th Order Additional CPU load comparable to playing 2 more samples. 
(polyphony is divided by 3)
8 Emulator X Operation Manual
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Buffer Size
This control sets the number of sample periods between updates of the synthesizer 
parameters. The buffer size can adjusted according to speed of your computer’s CPU. A 
faster CPU can handle a lower buffer size. The default setting is 128 sample periods, a 
good compromise of performance to CPU usage.

Use Optimal Buffer Size
When this box is checked, the Emulator X will choose the best buffer size based on the 
ASIO Buffer Latency setting (located in the ASIO control panel). You should normally 
leave this feature enabled for best audio performance. In certain rare cases you may want 
to manually set the buffer length to improve MIDI or synth performance.

Sample Rate
This control sets the output sample rate of the Emulator X, and will always match 
sample rate of your sound card. The default setting is 44.1kHz.

CPU Cap
� Warning: Sounds 
with long release times 
will exhibit “voice 
stealing” more than short 
percussive sounds.

This control sets percentage of CPU resources that will be used by Emulator X and 
consequently the maximum number of samples that can be played at the same time. 
Depending on the design of the preset, a single Emulator X voice may contain multiple 
samples which play simultaneously. The maximum setting is 80% CPU usage. If you 
hear notes being “stolen” in your sequence or as you play the keyboard, or if the disk 
meter readout at the bottom of the window goes into the red, increase the value of this 
control. If you have other applications running, you may want to reduce the setting of 
this control to free up more CPU for them.

Headroom/Boost
Headroom is the amount of dynamic range remaining before clipping occurs. The 
headroom can be a bit confusing because the higher the number, the lower the volume. 

The amount of headroom is adjustable from 12 dB to -30 dB in 1 dB increments. A 
headroom setting of -15dB provides the hottest output level, (and the highest signal to 
noise ratio) but may produce “clipping” if too many notes are played at once. The 
default headroom setting is -15 dB, which maintains an excellent signal to noise ratio 
while keeping a reasonable amount of headroom in reserve. If you hear the signal 
clipping or breaking up, increase the amount of headroom. In practice, you can think of 
this control as adjusting the control range of the Master Volume control.

Ultra-High Precision Interpolation Button
This button allows you to select between E-MU’s ultra-high precision pitch shifting 
algorithm or a lower quality pitch shifting scheme which uses fewer CPU resources. 

If you are using presets with a sample placed on every key, as is the case on many banks, 
you can switch high precision off to free up CPU with no penalty in audio quality. No 
pitch shifting is occurring anyway. High quality pitch shifting is only needed when you 
are playing presets which have a few samples mapped across the entire keyboard. In this 
case, the Emulator X shifts the pitch of the available samples to fill in the keyboard.

ASIO Control Panel
This button brings up the E-MU ASIO control panel which allows you to set the ASIO 
buffer latency in milliseconds. This important setting determines how fast notes will 
sound after you play them. If this time is too long, (<10mS) the keyboard response will 
feel slow and sluggish. If set too fast, however, you will hear the sound break up and 
crackle when you play too many notes. Experiment to find the setting that gives the best 
performance on your computer.
E-MU Systems 9
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VST Output Buses
This control is only active in the Emulator X VSTI application. This setting allows you to 
add additional VST buses. Emulator X channel outputs can be assigned to VST buses in 
the Multisetup, Output field. These outputs are sent to the VST Mixer in your recording 
application. You must restart the VSTI for the changes to take effect.

MIDI
This group of preferences allow you to set up the MIDI inputs, adjust the master MIDI 
volume and velocity curves and turn the “IntelliEdit” feature on or off.

MIDI Inputs

Channels 1-16, 17-32
The Emulator X can respond to 32 MIDI channels at once. Since there can be only 16 
MIDI channels per MIDI cable (or input) two inputs are provided. Set the MIDI Inputs 
(Ch. 1-16, Ch. 17-32) to match up to two outputs from your MIDI interface or 
sequencer. If you don’t need 32 channels you can turn either input off.

IntelliEdit
This control allows you to set the MIDI device for IntelliEdit. Selecting “None” disables 
the feature.

When editing sample key ranges or editing voices sit is convenient to select the key 
position by simply playing your MIDI keyboard. IntelliEdit lets you selectively edit key 
ranges using the keyboard when you need to, but blocks keyboard editing when you 
may not want it, such as when your keyboard is playing in the background. Here’s how 
it works.
10 Emulator X Operation Manual
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� To Use IntelliEdit:

1. Make sure IntelliEdit is set to the same MIDI port your keyboard is using.

2. In one of the Voices and Sample Zones screens such as “Key Window”, position the 
cursor inside one of the Key Range fields (Low or High).

3. Press and hold, Ctrl+Alt on your computer keyboard.

4. Play your MIDI keyboard. The key range will be edited.

5. In the Voice Edit window, holding Ctrl+Alt lets you select voices for editing. If more 
than one voice is assign to the key, the voices will cycle around with repeated 
pressing of the same key.

6. To select multiple voices, you must use the Group feature. See Groups on page 54.

Receive Program Changes
This button selects whether or not MIDI Program Change messages from your MIDI 
controller or sequencer will be received or ignored by the Emulator X. Depress the 
button to receive program changes.

External Tempo Source
� Important! 
If External Tempo Source 
is set to external, the 
tempo control in the 
Voice Editor will be 
“greyed-out” and non-
functional.

This button selects between internal tempo clock or MIDI clock as the tempo source. 
The Emulator X uses a global master tempo for Tempo-based Envelopes, Tempo-based 
LFOs, and clock modulation. When this button is pressed, MIDI clock will be used for 
the global tempo and the tempo control in the Multisetup window will be disabled.

MIDI Response
These controls allow you to customize the MIDI response of the Emulator X to match 
your MIDI Controller or other instruments.

Velocity Curve
Incoming velocity values can be scaled by one of 24 curves to better adapt to 
your playing style or MIDI controller. Selecting “linear” leaves the velocity data 
unaltered. The shape of the selected curve is displayed in the window. Select the 
curve that works best for you.

Volume Curve
This is an adjustment to help match MIDI controller #7 volume response to other 
manufacturers’ equipment. Three curves are provided: Linear, Inverse Square or 
Logarithmic. The action of this control is displayed in the window.

Volume Sensitivity
This control allows you to modify the response curve for MIDI continuous 
controller #7 (Volume). This allows you to match the Emulator's response to 
other manufacturers’ equipment. Low numbers compress the volume control 
range, raising the volume level at lower controller #7 values. 
E-MU Systems 11
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Controllers
This is where you set up which MIDI Continuous Controllers the Emulator X will 
receive. Match these controls to the MIDI continuous controller numbers that your 
keyboard or sequencer transmits. What the controllers actually do is programmable in 
each preset. See Modulation Cords on page 84.

As you can see, MIDI Continuous Controller numbers are assigned to letters (A-P) or 
labels (Pitch, Mod, Pressure, Pedal, etc.) in this screen. When programming a preset, 
these letter or name labels can be assigned to control various parameters such as filter 
frequency or attack time.

The name labels such as pitch and mod wheels are so commonly used that they have 
their own assigned name, but these can also be freely assigned in any way you choose.

If you’re just getting started, it’s probably best to use the default settings. Press the “Use 
Default” button to restore the default settings which are shown above.

Other Settings
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Load Last Bank at Startup - This feature automatically loads the last bank you had 
loaded whenever you start the Emulator X application.

Clear clip indicators after 10 seconds - This feature automatically clears the main 
output meter clip indicators. If this function is set to Off, the clip indicators will stay on 
until you manually click on them.

Appearance Settings in Windows
Adjusting the “Performance Options” in Windows will make the Preference buttons 
much easier to read and increase the smoothness when dragging windows around on 
the screen.

� To Improve the Appearance Settings:

1. Open the Windows Control Panel. (Start, Settings, Control Panel)

2. Select System.

3. Select the Advanced Settings tab.

4. Under Visual Effects, select Adjust for Best Performance.

5. Click OK.
E-MU Systems 13
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2 - Emulator Architecture

This chapter contains important background information about the organization of the 
various modules of the Emulator X. Although this chapter doesn’t contain any hands-on 
tutorials, this information is vital to your understanding of this ultra powerful 
instrument. Read This!

A Modular System
You can think of the Emulator X as a collection of sound organizing modules, all 
contained within the current bank. The following is a brief description of the five main 
elements of the Emulator X hierarchy starting from the largest element, the Bank.

Bank
Before you can play the Emulator X, you load a Bank of presets. The bank contains all 
the sounds you wish to use in a particular sequence or performance. If you need 
additional sounds, they can be added by simply dragging and dropping them into the 
bank from the system or library. Unneeded sounds can likewise be removed from the 
bank. When loading a bank, the Emulator X only loads a small portion of the digital 
samples and so bank load time is greatly reduced.

Saving
The bank retains data only for as long as your computer is plugged in and turned 
on. Of course, we don’t expect you to leave the thing on all the time, which 
brings us to the subject of saving data.

Saving the bank to a hard disk permanently stores data so that even after turning 
off your computer, the disk stores a record of your work.

IF YOU DO NOT SAVE A BANK, ANY CHANGES YOU HAVE MADE WILL BE 
LOST WHEN YOU TURN OFF THE COMPUTER!

� Whenever you have 
done enough work that 
you would hate to lose it, 
BACK IT UP!

Do not wait until the end of a session to save. Save your work periodically in case 
of power failure or some other unforeseen circumstance that might erase the 
computer’s memory. Hard disks and computers are not infallible. All hard disk 
banks should be backed up periodically to another hard disk or other media. 
Should you improve the preset or sample later, you can always replace the 
original with the revised version. And if something goes wrong, the original will 
still be available to save you the ordeal of starting from scratch.

When you choose Save, (as opposed to Save As) only the edited presets, voices and 
samples will be written, saving time and memory.

When you choose “Save As” from the file menu, the entire bank—presets, voices and 
samples—are re-written to the hard disk. This method, although somewhat wasteful of 
memory, ensures that all your samples remain bound with your bank.
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Multisetup
A map that assigns a preset, volume, pan position and output routing to each of the 32 
MIDI channels. Multisetups can be saved and recalled for use with a particular song or 
sequence so that all the MIDI channels play the proper preset.

E A Preset is the same as 
a MIDI Program.

Preset
One complete keyboard setup controlled by one MIDI channel. Presets are composed 
of multiple voices. The assignment to voices to keyboard keys is completely flexible.

Voice
One complete sound, containing one or more samples with keyboard and velocity 
mappings and all programmable synthesizer parameters. Voices can be assigned to a 
single note on the keyboard, or transposed to cover a wider keyboard range.
E-MU Systems 17
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Sample
An individual digital recording with a name, sample rate and looping information. 

Flexible Architecture 
The Emulator X allows you great flexibility in the way you construct presets. Consider 
this — you can assign multiple samples to the keyboard inside the voice or assign single 
sample voices to the keyboard.

Unless you specify otherwise, only one sample is assigned per voice. In this case you 
would assign voices (and the single sample each one contains) to the keyboard and 
create presets. On the other hand, you may want to create finished voices before you 
start designing presets and treat the voice as your finished sound. In this case, the preset 
can be used to crossfade, layer or switch multiple complex voices.
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Preset Diagram
The diagram below illustrates the concepts of a preset and voice. 

Voices
A voice is a complete sound that can be assigned to a range of the keyboard. A sample is 
the part of a voice that generates the actual sound. You can think of a voice as a 
complete instrument consisting of one or more samples which can then be used as a 
building block in constructing more complicated presets.

A voice consists of one or more samples, a dynamic filter, a dynamic amplifier, up to 
three 6-stage envelope generators, up to two multi-wave LFOs and up to 32 
modulation routings called “Cords” to connect everything together.

Preset A complete keyboard layout with unlimited voices.

Voice A complete synth sound containing a single sample or a Multisample.

Sample An individual digital recording with loop information.
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When you record a sample into the Emulator X, a new voice is typically created for each 
new sample (recording). In this case, each sample will its own complete set of synthe-
sizer parameters.

Multisample Voices
f A voice can contain a 

single sample or 
multiple samples, 
whichever you prefer.

In another scenario, you might record several samples of an instrument (such as a 
piano), then place them into the same voice in order to share the same set of synthesizer 
parameters. If a voice contains more than one sample, this multiple sample object is 
called a “Multisample”. A diagram of a multisample voice is shown below.

Normally these samples would be placed side by side on the keyboard as in the diagram 
above. You assign the sample to a range by setting the original key, (which is usually the 
original pitch of the sample) a high key and a low key. The number of samples needed 
for a realistic emulation varies with the instrument, but in general, “more is better.”

When a sample is taken, it can be automatically placed into a voice with one sample. 
You could also manually place the voice (and its sample) on the keyboard if you wish. If 
more than one voice is assigned to the same range, then pressing a key in that range 
plays all the voices assigned to that range. Voices assigned to the keyboard can be cross-
faded by their position on the keyboard, or the key stroke velocity. Voices can also be 
switched or faded depending on the value of a realtime controller such as a modulation 
wheel, an LFO or an envelope generator.

S27

Multisample Voice

S28
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S30 S32

Positional
Crossfade

Velocity Crossfade

S31

Each Sample:
Orig. Key
Tune
Volume`
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Key Range/Fades
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Loop, Samp Rate Loop, Samp Rate Loop, Samp Rate

Multisample voices are designed to arrange groups of samples into one manageable entity. 
The window below shows an opened multisample. The key mapping of the multisample 
overrides the key mapping of the samples contained within it.
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The Sample
Loading in any sound, in mono or stereo, creates a sample, the raw material with which 
the Emulator X works.

The term sample commonly means two different things:

In this manual, we’ll assume sample means the complete recorded sound unless 
indicated otherwise.

You can modify a raw sample in several ways. A sample can be transposed up or down 
in pitch to cover a particular range of the keyboard making it unnecessary to record a 
sample for every key. Sample editing might consist of Looping a sample (allowing even 
short samples to play indefinitely), Truncating (cutting off unneeded parts of a sample), 
or any of a number of digital processes that actually change the raw sample data. 

The Original Key assignment determines the pitch at which the sample will be 
played back. Therefore it’s important to map your samples to the proper original key.

You can also name samples. It’s usually a good idea to include the original pitch in the 
name so that you can place it on the keyboard later at the proper pitch. 

You can have any number of samples in a bank. The number of possible samples is only 
limited by the size of your computer’s hard disk.

• A digital recording of a complete sound, or

• Each snapshot of the sound that makes up the complete sample. 

Original
Key

Low
Key

HighOrigLow HighOrigLow

High
Key

S02 Piano D3 S03 Piano D5S01 Piano A0

Sample Sample Sample
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3 - Getting Started

Exploring the Tree
In this section you’ll learn how to navigate around Emulator X using the Tree. Don’t 
worry if you don’t know what everything does just yet. Everything will be explained later 
on.

1. With the Emulator X application running, a bank is loaded by selecting Open from 
the File menu.  The screen shown below appears.

The Tree is the section shown on the left of the screen. There are three tabs at the 
bottom of the Tree labeled Sampler, System and Library.

Sampler Allows you to see the contents of the current Emulator X bank.

System
This tab gives you access to your entire computer system: PC, hard disks, CD-ROM 
drives, network, etc. Presets, Samples and Multisetups can be browsed, then 
Merged into the current Bank. Load Emulator 4 banks from this tab.

Library
The Library shows you all Emulator X related files, wherever they may be located 
on hard disks, CD-ROM or network. Presets, Samples and Multisetups can be 
browsed in the Library, then Merged into the current Bank.

The
Tree

Sampler/System/Library Tabs

Sampler 
Bank

Presets 
Folder

Toolbars

Samples 
Folder

Multisetup 
Folder

Presets

Open 
Preset

List View
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Multisetup Page
The Multisetup is the top level of the Emulator hierarchy and is the place where you 
choose and assign presets to each of the MIDI channels.

A multisetup assigns a preset, volume, pan position and output routing to each of the 
32 MIDI channels. Multisetups can be saved and recalled for use with a particular song 
or sequence so that all the MIDI channels play the proper preset.

Click on the Emulator X icon to display the Multisetup screen. See page 39 for a 
complete description of the Multisetup screen.

Changing Presets
Play your MIDI keyboard and note that one of the MIDI activity LEDs comes on. This is 
the channel on which your MIDI keyboard is transmitting. If you don’t see MIDI 
activity, check your MIDI connection and make sure MIDI is set up properly in the 
Preferences menu. See page 10.

� To Audition and Select Presets

1. Click once on the Preset Select button on the channel used by your MIDI keyboard. 
The complete list of all presets in the bank appears.

2. Click once on a preset to audition it. Play your keyboard to hear it.

3. Try out a few more presets. When you find one you like, double-click on it to select 
it and return to the Multisetup screen.

4. Change the Current Preset by clicking on the number to the left of the preset. The 
number you selected turns red.
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5. Play the small keyboard at the bottom of the screen. Notice that the MIDI Activity 
LED of the current preset now plays along with whatever sound is selected for that 
channel. (Your MIDI keyboard still plays on the channel to which it is set.)

6. Change the channel on your MIDI keyboard then play it. The Emulator now plays 
the preset on that channel.

� Selecting Presets from the Tree
When you click on a preset in the tree, you have just selected it for the current MIDI 
channel. This action also calls the Preset Global page.

To go back to the Multisetup page click the back arrow or click on the Emulator X 
icon at the top of the tree.

� Changing the Current MIDI Channel
The Current MIDI Channel is simply the MIDI channel you are currently working 
with. To change the current MIDI channel, click on the channel number in the Mul-
tisetup page. The selected channel number turns red. Note also that the channel 
number at the bottom of the window changes to reflect the current channel.

Adjusting the Controllers
Each preset has a set of 16 continuous controllers which are used to adjust and control 
the sound as you play. Your MIDI keyboard may have several knobs or sliders that are 
transmitted over MIDI. These can be used to control the Emulator X if you match the 
CC numbers your MIDI keyboard transmits to the same CC numbers on the 
Emulator X. These global settings are located under Options, Preferences, Controllers. 
See page 12 for additional information.

� To Modify the Sound using the Controllers

1. Play your MIDI keyboard as you adjust the controllers knobs on the screen. Notice 
that the sound changes. If the sound doesn’t change, make sure the current preset 
(red number) is the same one that your keyboard is playing.

2. If you have controller knobs on your MIDI keyboard and have set up the Controllers 
(Options, Preferences, Controllers) to match your keyboard, you can use these 
knobs to modify the sound. Notice that the screen knob follows the movement of 
the hardware knob.

3. Try changing the filter type. Click on the selector to the right of the filter name and 
select one of the 53 different filter types. 

4. Adjust the Tone and Presence controls while playing the keyboard to hear your 
changes.

5. Change the Volume and Pan controls for the MIDI channel you are using. These 
settings can be adjusted remotely using MIDI controller #7 (volume) and controller 
#10 (pan).
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Create Your Own Custom Bank
It’s easy to create your own custom sound banks by simply “dragging and dropping” the 
presets or samples you want onto the Emulator X icon in the tree.

� To Create a New Custom Bank

1. Select New from the File menu. This creates a new empty bank. (You can also merge 
presets or samples into an existing bank if you wish.)

2. Select the System Tab. The Desktop icon will appear in the tree.

3. Locate the presets you wish to include in your new bank. These will be located in 
the “E-MU Systems” folder located in “Program Files” The included CD-ROMs 
contain several other great banks of sounds. Run the installer application on the 
library CDs to install these banks on your hard disk.

4. When you have found a preset you want to include, simply click (left mouse 
button) and drag the preset over the Emulator X icon at the top of the tree. The 
cursor changes to a plus sign as you pass over the icon. Release the mouse button 
and a pop-up progress bar will inform you that the preset is being loaded.

5. Continue to add presets to your new bank.

6. Save the bank when you are satisfied.

� Alternate Method using the Librarian to find Presets

1. Select the Library Tab instead of the System Tab in step 3 above.

2. If you haven’t done so already, Update the Library.

3. Choose presets from the Library, then drag and drop them on top of the Emulator X 
icon at the top of the tree.

Load a New Bank
E Note: Emulator 4 
banks are accessed and 
loaded from the System 
Tab, rather than from the  
File menu.

Load up a new bank in preparation for the next few examples. Load the Proteus 
Composer bank located in your Emulator X folder.

1. Select Open from the File menu, then locate Proteus Composer and click Open.
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Opening a Preset
A preset is a complete keyboard setup for one MIDI Channel. Think of a preset as one 
complete sound, which usually contains multiple voices and samples.

1. Click on the Preset Folder in the Tree to show all the presets in the bank.

2. Click the Show Details button. The details of the presets are now shown. The sort 
buttons allow you to sort the presets by name. ID number, bank/program number, 
or category. Click on the button again to sort in reverse order.

3. Clicking on the plus sign (+) next to the Preset folder or double-clicking on the 
folder itself opens the folder and displays the bank’s presets in the tree.

4. Clicking on the plus sign (+) next to one of the preset icons displays the sub-
modules of the preset: Voices & Presets, Links, Voice Processing.

E Please refer to chapter 
“2 - Emulator 
Architecture” on page 15 
for complete 
explanations of the sub-
modules.

Click 
Here
To Show All

Double-click 
on a preset 
icon to go to 
Preset Global 

Double-click 
to open the 
Folder.

Sort Buttons

Show Details 

Submodule Function

Voices & Zones Assign voices and multisamples to the keyboard, which can be switched or 
crossfaded by key position, velocity or controller setting.

Links Multiple presets can be layered, switched or crossfaded across the keyboard,

Voice Processing Synthesizer voice parameters including filters, LFOs, envelopes and cords.
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5. Open the preset “And Voice” by clicking on the plus (+) sign next to the folder. 

6. Next, click on the “Voices & Zones” icon. The Key Window appears. The blue bars 
show that the two multisamples in this preset are mapped across the entire 
keyboard.

7. Click on the Mix/Tune tab at the top of the window.

8. There are two multisampled voices in this preset. Adjust the volume slider for each 
of the voices as you play. Now try playing with the pan position and transpose. 
Before you leave this window, turn up the volume controls on both voices.

� Exploring the Key and Velocity Windows

1. Click the Key Win tab again.

2. Click and drag the ends of the blue bars so they look something like the screen 
shown above. The settings don’t have to be exact.

3. Play the keyboard from the lowest key to the highest. Voice 1 plays at the low end of 
the keyboard and voice 2 plays on the high keys.

4. To return both voices to their original positions, select Edit, Undo from the toolbar. 
Select Undo again until both voices are assigned to the entire keyboard.

Velocity Switching and Crossfading

5. Click on the Vel Win tab. The following window appears:
 

6. This screen controls the voices using key velocity or how hard the keys are played. 
Set the bars something like the screen above. 

Step 8. Ctrl-Click here.
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7. Play the keyboard anywhere, but begin playing softly and gradually play harder. 
Notice that the choir (voice 2) plays with lower key velocity and switches to piano 
(voice 1) when you play hard. You’ve just created a velocity cross-switch.

8. Ctrl-click the end point of the bar in voice 1 and drag it to the left. The color 
intensity of the bar fades. The fade in color is analogous to volume. the darker the 
color, the louder the volume for a certain velocity.

9. Drag the fade points of the two voices so they look something like the window 
shown below.

10. Play the keyboard anywhere, but begin playing softly and gradually play harder. 
Notice that the choir plays with lower key velocity and fades into piano as you play 
harder. You’ve just created a velocity crossfade.

� Add a Voice

1. Select Preset, New Voice from the toolbar. A new, empty voice appears below voice 
two.

2. The label area of the new voice is blank. Click on the selection box to the right of the 
empty label area to bring up the entire list of samples in the bank.

3. Select sample 0350 SectionStringC3 by double-clicking on it. You’ve just assigned a 
sample to the voice you created.

4. Play the keyboard and now you have orchestral strings as well.

� Delete the Voice

1. Select the voice you just created by clicking once on the sample name or number to 
the left of the name. The number turns red.

2. Select Preset, Delete Voice from the toolbar. The voice has now been deleted.

Much More…
Now you’ve had a small taste of what you can do with the Voices and Zones section. 
Read chapter 5 to learn more about the Preset Editor. See page 47.
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Examine a Voice
Each voice has its own synthesizer section (called Voice Processing) to process the raw 
samples. You can process each voice separately or select all voices to be processed in the 
same way.

1. Go to the Tree and click on preset P0015 Dyna-heim. Play the keyboard. You 
should be able to hear the preset.

2. Open the preset by clicking on the plus (+) sign, then click on the Voice Processing 

icon.  The Voice Processing page shown below appears.
 

E Note: See Groups on  
page 54 for detailed 
information on how to 
select groups of voices.

3. Near the top of the screen near the keyboard you’ll see the Group Selector. Set this 
to All, to select all voices in the preset.

4. Feel free to explore the synthesizer section. The filter section is probably a good 
place to begin. Change the filter type, then adjust the frequency and Q controls as 
you play the keyboard. Note that the filter response display changes as you change 
the filter settings.

Cords
The reason synthesizers are able to generate such complex sounds is because most if not 
all of their processes can be placed under automatic control. Here’s an example.

5. Tired of turning the filter frequency by hand? Let’s program one of the LFOs to do it. 
Choose Cord #8 and set the left selection box to LFO 1 ~.

Step 3.
Select All

Step 5
Set to LFO 1 ~

Step 6
Set to Filter Frequency
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6. You’ve just connected one end of a Cord. Like all cords, you’ve got to connect both 
ends for it to do anything. Connect the other end of the cord to Filter Frequency.

7. Each Cord has its own attenuator which controls “how much” signal goes through 
the cord. Turn the knob in the center of the cord all the way to the right (+100%).

8. Now set the filter frequency knob about 1/3 of the way up and play a note on the 
keyboard. You should hear the filter being turned up and down automatically. 

9. Change filter types and adjust the filter frequency if you don’t hear the filter being 
modulated.

10.  Adjust the Frequency of LFO 1.

11. Change the Shape of LFO 1. (You’ll have to re-key to hear the new waveform.)

Modulating Cords
In the Emulator X even the Cords themselves can be controlled by other modulation 
sources or controls. Let’s use your keyboard’s mod wheel to control the amount of LFO 
to filter modulation.

12. Cord 0 already has the Mod Wheel assigned as an input. Set the output of Cord 0 to 
go to Cord 8 Amount.

13. Turn up the amount of Cord 0 to 100%.

14. Set the amount of Cord 8 to 0% (off). (You’re going to turn it up with the mod wheel.)

15. Now play a note and move the Mod Wheel of your keyboard up. (Most keyboards 
have two wheels or controllers. One bends pitch and the other is the modulation wheel.)

Experiment

16. Try setting the output of Cord 11 to Pitch. Now try changing the LFO Shape. Now 
it’s much easier to hear the different LFO wave shapes.

Wipe the Slate
The preset might be a little messed up after your experiments. It’s good to know that as 
long as you don’t Save it, none of the original data is destroyed. If you want to get back 
to the original preset, simply load the bank again.

You can also Undo any changes you made by repeatedly clicking the back arrow button 
(=).
E-MU Systems 31



3 - Getting Started
Examine the Samples
Examine the Samples
Samples are the digital recordings which are the basis of an Emulator X sound. As you’ve 
seen, samples can be layered and switched or treated by the Voice Processing functions 
to create entirely new sounds, but the actual samples can also be modified and sculpted.

A single preset may use over a hundred samples and a bank may contain thousands of 
individual samples. Let’s take a look.

1. Click on the plus sign (+) next to the Samples folder to open the folder and display 
the samples in the bank. (If the Preset folder is already open, you can click on the 
minus sign (-) next to the folder to close it and clean up the tree.)

2. Click on any sample to display its waveform.

3. The transport controls are just above the waveform display. Click on the Play 
button  to listen to the sample.

4. Press the Stop button  to stop playing.

5. Click on the larger magnifying glass of the Horizontal Zoom buttons. The time-base 
of the waveform is magnified allowing you to see more detail. Continue clicking 
and eventually you’ll reach maximum magnification. The individual sample 
measurements are shown here as dots. If the sample rate is 44.1 kHz, then there will 
be 44,100 of these dots per second of sound.

6. Click repeatedly on the smaller magnifying glass and the horizontal magnification 
decreases.

7. The Vertical Zoom buttons allow you to zoom in or out on the vertical axis. Neither 
the vertical or horizontal zoom buttons change the wave in any way. They’re just 
display controls.

Horizontal Zoom Vertical Zoom
32 Emulator X Operation Manual



3 - Getting Started
Examine the Samples
Using DSP
There are a number of DSP or digital signal processing functions that you can perform 
on the raw samples. Samples can be spliced together, merged, time-stretched, reversed 
and on and on. 

Unlike Voices & Zones or Voice Processing functions, the DSP tools actually change the 
recorded sample data. This means that you should be careful whenever you use these 
functions so that you won’t accidentally overwrite the valuable recordings. It’s usually a 
good idea to save the bank (Save As) before doing any DSP operations.

That said, let’s break the rule right away and change a couple of samples.

Time Compression/Expansion

1. Select sample Riff Trip Gb. Press Play on the transport controls to check it out.

2. Suppose you wanted to change the tempo to fit into your song. The time 
compression/expansion DSP tool can do this for you. Select Time Compress from 
the DSP toolbar.  The following dialog box appears.

E Note: The original 
tempo shown may not 
reflect the actual tempo 
of the sample. You have 
to set this value manually 
in order to have the new 
tempo accurately 
calculated.

3. Change the ratio. Ratios below 100% compress or shorten the time. Ratios above 
100% expand or lengthen the time. Note that the tempo and length fields change to 
show the new length and tempo.

4. Press OK to change the time scaling. Press Play again and note the change in tempo 
of the sample.

Loop Play

5. Turn on Loop Play  on the Transport toolbar. Now the sample will continue to 
loop until you press Stop.

Reverse

6. Select Reverse from the toolbar.  The sample is immediately reversed.

7. Press Play and hear the sample played backwards.

Copy and Paste

8. Select the entire sample by pressing the Select All button  on the DSP toolbar.

9. Choose Copy from the Edit menu. The sample is placed on the clipboard.

10. Click anywhere on the waveform display to deselect the sample, then position the 
cursor at the very end of the sample by pressing the Loop End button in the 
transport controls. The flashing cursor line is now positioned at the end of the 
sample.
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11. Choose Paste from the Edit menu. The following dialog box appears.

12. Insert mode is already selected and it’s the mode we want. The clipboard contents 
will be inserted at the cursor location, extending the length of the sample. Press OK.

13. Now position the mouse pointer at the very end of the sample. Press the shift key 
down and click the left mouse button. The section of wave you just pasted is 
selected.

 

Pitch Shift

14. Select Pitch Shift from the DSP toolbar. The following dialog box appears.

Step 13. 
Position 
pointer here.
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15. Set the Tuning interval. 100 cents equals one semitone. Try a setting of 700 cents or 
a perfect fifth.

16. Select Constant Time. This setting changes the pitch but will leave the rhythm 
constant. Don’t change the algorithm. See page 110 for more information about the 
pitch change options.

17. Press OK to change the pitch.

18. Click on the Loop Start button in the Transport Controls to set the cursor to the 
beginning of the sample and press Play.

Experiment!
E All the DSP tools utilize 
32-bit precision.

Please feel free to try out all the other DSP processes. Be sure to read the Sample Edit 
chapter (page 95) to learn all about these powerful tools, but you should actually try 
them out as you read.

Remember that nothing is made permanent until you save the bank, so experiment as 
much as you like.

Samples can also be exported as WAVE or AIFF files using the Export function in the 
Sample Edit menu. This allows you to use other sound processors in your computer. 
Externally processed samples can be re-imported using the Import option in the File 
menu.

Save and Save As
When you choose “Save As” from the file menu, the entire bank—presets, voices and 
samples—are re-written to the hard disk. This method, although somewhat wasteful of 
memory, ensures that all your samples remain bound with your bank.

When you choose Save, (instead of Save As) only the edited presets, voices and samples 
will be written, saving time and memory.
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The Librarian
As your sample library grows so does the problem of managing all your banks, presets 
and samples. As you’ve probably already discovered, a single bank can contain literally 
thousands of individual samples.

The Library is accessed by clicking the Library tab at the bottom of the Tree. To use the 
librarian, you first “Update” from the File menu. This creates a searchable database of all 
your samples, presets, banks and audio files which can be quickly searched. Audio files 
can be either WAVE or AIFF.

You can select which drives you wish to add to the catalog or manually “Add Locations” 
to narrow down the selection range to speed the update process. The Add Location 
button also allows you to specify network drives to catalog. Only the selected targets are 
overwritten with new data when the update process is performed. Unselected targets 
remain as they were. The “Clear Library” button erases the entire library so you can start 
from scratch.

f Cool Tip: Categorize 
multiple Presets:
1. Go to the Tree
2. Double-click Presets 
folder.
3. Select multiple presets.
4. Right-click and choose 
category. 
5. Select category.

� Using the Librarian

Catalog your Disks

1. Select Update from the File menu. A popup dialog box appears asking you to select 
the disks you wish to catalog.

2. Select any disk drives that contains the banks, presets and samples that were 
included when you installed the Emulator X application. Using the Add Location 
button, you can select network drives to add to the Library catalog. The Add 
Location button also allows you to select specific folders or locations for cataloging.

3. Click the Update button to begin cataloging. The display will read: “Updating”. This 
process may take a minute or two depending on how many files need to be 
cataloged.

Find your Files

4. Select the Library tab at the bottom of the Tree. All Emulator X Banks, Presets, or 
Samples can now be accessed here.

Update
Updates the Library with the selected items, leaving non-
checked targets intact.

Clear Library Erases Library database.

Add Location
Allows you to manually select targets to speed update time or 
select network drives to catalog.
36 Emulator X Operation Manual



3 - Getting Started
The Librarian
Tip:  You can add 
Category tags to 
your own presets 
and samples by 
Right-clicking on 
them.

5. Select a Category of presets from the list. Presets 
have a three-letter prefix denoting the type of 
sound. (bs = bass, kb = keyboard, etc.) Select 
Any to select all cataloged files.

6. Browse through the Bank, Preset, and Sample 
folders to find the sounds you want.

Load your Files

7. To add a file to the bank, Left-click and Drag 
the desired object in the Library over the 
Emulator X icon at the top of the tree and 
release the mouse button. The file is added to 
the bank. Or… Select the object you want from 
the Library and Right-click. Then select Merge 
to merge the object into the current bank.
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4 - Multisetup / Global Controls

The Multisetup
The Multisetup is the top level of the Emulator hierarchy and is the place where you 
choose and assign presets to each of the MIDI channels.

A multisetup assigns a preset, volume, pan position and output routing to each of the 
32 MIDI channels. Multisetups can be saved and recalled for use with a particular song 
or sequence so that all the MIDI channels play the proper preset.

� To Select the Current Multisetup:

1. Click on the Emulator X icon at the top of the Tree. The current multisetup appears.

The Current MIDI Channel
The lower section of this window displays parameters associated with the currently 
selected MIDI channel. Change the current channel by clicking anywhere on the desired 
channel strip. The red indicator displays the currently selected channel number. The 
lower portion of the display changes to show the settings of the currently selected MIDI 
channel.
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� To Select a Preset from the Tree:

1. Set the Current Channel to the one you’re using by clicking on the channel number 
in the Multisetup window.

2. Choose the preset you want in the tree and Right-Click on its preset icon.

3. Choose Select on Current Channel. The preset is now selected for that channel.

4. You can also select the preset for the current channel by double-clicking it from the 
tree.

MIDI Channel
Each channel only responds to MIDI data on its particular channel. Use the keyboard at 
the bottom of the window to audition presets on the currently selected channel. Select 
the current channel by clicking anywhere on the desired channel strip. The red indicator 
displays the currently selected channel number.

Preset Assignment
Assign presets to MIDI channels by clicking on the selector button to the right of the 
preset field. A pop-up dialog box appears with the list of presets in the bank. Select a 
preset, then click OK to select.

MIDI Chan 
Select 

Preset 
Assignment

Chan. 1-16

Channel 
Pan

Output 
Assignment

Aux Send 
Enable

MIDI Continuous 
Controllers

MIDI
Activity

User Definable 
Labels

Preroll
RAM Used

CPU & Disk 
Meters

No. of Samples
Playing

Current 
Channel

Channel 
Volume

Chan. 17-32
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Channel Volume
This control sets the relative volume of the MIDI channel. This is equivalent to MIDI 
controller #7 (channel volume) and changes made over MIDI will be shown here.

Channel Pan
This control sets the stereo position of the MIDI channel. This is equivalent to MIDI 
controller #10 (channel pan) and changes made over MIDI will be shown here.

Output Assignment
This control sets the main stereo output assignment for the MIDI channel. 100% of the 
stereo output signal is sent to the selected output bus.

The number of stereo channels available depends on the number of stereo channels 
your sound card provides. For example, if a sound card provides 8 ASIO stereo outs, one 
of 8 physical outputs will be available for each MIDI channel.

ASIO input strips in PatchMix DSP will be listed by the channel’s scribble strip name.  
Add ASIO input strips in PatchMix DSP to increase the number of available outputs.  
The EX session templates in PatchMix DSP are designed to be used with the Emulator X. 

Aux Send Enables
When pressed (red), these buttons allow the Aux Routings selected in the voices to be 
used. This allows you to hear the preset with or without effects.

Global Controls

Master Volume Control & VU Meter
This is the master volume control for the Emulator X. This slider controls the output 
volume of all MIDI channels.The range of this control can be adjusted using the 
Headroom/Boost control in the preferences dialog box. See page 9.

The VU meter indicates the overall output level of the Emulator X on ASIO outputs 1&2. 
It serves as a handy indicator to show clipping or to troubleshoot audio output 
problems.

Tempo Control
This control and associated display sets the master tempo when the Emulator is chosen 
as the tempo source. Emulator X contains a global master clock which is used for 
Tempo-based Envelopes, Tempo-based LFOs, and clock modulation.“External Tempo 
Source” in the MIDI Preferences dialog must be Off for this control to operate.
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When “External Tempo Source” in the preferences dialog box is On, and an external 
MIDI device or application is generating MIDI clock, the Emulator X tempo will lock to 
the MIDI clock tempo.

Aux Outputs
These three output assignments assign the Aux Routings selected in the voices to pairs of 
ASIO channels or to DirectSound. Every Voice (page 19) has three effects sends with 
programmable amounts. The three effect sends from all voices are summed into these 
three Aux Outputs where they are assigned to an ASIO pair. The Aux ASIO streams can 
be routed to the PatchMix DSP mixer or to other software devices running on your 
computer. Please refer to the diagram on page 44.

Emulator Sessions in PatchMix DSP
The Emulator factory banks have been designed to be used with special Sessions in the 
E-MU Digital Audio System. These Sessions connect the Aux Outputs to PatchMix DSP 
mixer input strips containing the proper effects. The PatchMix DSP screen on the 
following page shows the Main and Aux Output connections from Emulator X. 

IMPORTANT
The act of creating PatchMix DSP ASIO mixer strips makes them available 
for Emulator X or any other application. You must create the ASIO mixer 
strips before Emulator X or any other application will see them.

� To Open the Emulator Sessions in PatchMix DSP

1. Open PatchMix DSP by clicking on the icon and select New Session.

2. Select EX or EX Studio. 

3. Select Percussion EQ EX Studio for use with the percussion banks on Disk 3. Select 
Percussion EQ EX for all other banks.

Main & Aux 
Sends

(Voice Processing)

Main & Aux
Returns

(Multisetup)
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Master Tune
Master Tune adjusts the overall tuning of all presets so you an tune Emulator X to other 
instruments. The master tuning range is ±1 semitone in one cent steps (1/100th of a 
semitone). A master tune setting of 0¢ indicates that the Emulator X is precisely tuned 
to concert pitch (A=440 Hz).

Master Transpose
The master transpose parameter transposes the key of all presets in semitone intervals. 
The transpose range is ±12 semitones (1 octave).

Limiter
When playing the Emulator X you may sometimes hear digital clipping. This clipping 
occurs in the digital hardware and is not caused by the Emulator X, which uses high 
resolution floating point processing and has tremendous internal headroom.

f Increase the release 
time if you hear obvious 
volume changes 
(pumping). Reduce the 
release time for 
percussive playing.

To avoid the clipping, you could always lower the volume controls, but there’s a better 
way. The Limiter monitors the signal ahead of the output stage and automatically turns 
down the volume before clipping can occur.

� To Use the Limiter

1. Press the Enable button, illuminating the label.

2. Set the Release knob to about 30% to start. Release controls how fast the limiter 
turns the volume back up after reducing it to avoid the clipping peaks.

Main
Output Aux 1 Aux 2 Aux 3

EX Studio Session
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Aux Output Diagram

MULTISETUP

All Voices in the Bank

Output
Assign

Preset on Ch. 2

Preset on Ch. 1

Preset on Ch. 3

Preset on Ch. 32

Main

Aux 1

Aux 2

Aux 3

Voice Edit

Samples AmpZ-Plane
Filter

Main

Aux 1
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Aux 3

Voice Edit

Samples AmpZ-Plane
Filter
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Main

ASIO 1/2

ASIO 3/4

ASIO 1/2

ASIO 31/32

Aux 1
ASIO 5/6

Aux 2
ASIO 7/8

Aux 3
ASIO 15/16

Aux Outputs

Channel
Outputs

The Main Output of the voice is directed to the main output for the MIDI Channel. The 
Aux 1-3 amounts are summed and sent out the ASIO pair as selected in the Multisetup 

page. The Send enable button turns on the Aux Sends for that MIDI Channel.
44 Emulator X Operation Manual



4 - Multisetup / Global Controls
Global Controls
Filter Override
The filter type of the first voice in the preset (on the currently selected channel) is shown 
in this display. If you change the filter type in this field, ALL the voices in the preset will 
change to the filter type you select. When the display reads, “- Not Set -” the filters 
programmed in each voice will be used.

MIDI Controllers & Scribble Strips
Sixteen realtime MIDI Controllers are available to control the preset on the currently 
selected channel. These controllers are connected to MIDI sources as assigned in the 
Preferences dialog box (page 12) and changes made over MIDI will be reflected here.

The scribble strip names and the initial settings of the controller knobs are user 
programmable in the Preset Globals window. See page 48.

Mini Keyboard
The mini keyboard is used to audition presets and settings without changing the 
channel of your MIDI keyboard. The keyboard plays the currently selected MIDI 
channel. Select the current channel by clicking anywhere on the desired channel strip.

Preroll RAM Used
This display shows how much of your computer’s RAM is being used by pre-roll sound 
data. The amount of Pre-roll RAM can be adjusted in the preferences dialog box. When 
Sample Streaming is disabled this number shows the total RAM usage. See page 6.

CPU Meter
This display shows how much of your computer CPU power is being used by the 
Emulator X.

Number of Samples Playing
This display shows you how many samples are currently being played. The maximum 
number of samples that can be played depends on a variety of factors such as: HD 
speed, RAM memory speed and CPU speed. See “Audio Setup” on page 8 for more 
information about performance.

Current Channel
This displays the currently selected MIDI channel. Change the current channel by 
clicking anywhere on the desired channel strip.

Filter OverrideMIDI Realtime Controllers & Scribble Strips

Preroll RAM CPU Meter Number of Samples Current Channel

Mini Keyboard
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Working with Multisetups
A Multisetup is a “snapshot” of the current Emulator X settings. Multisetups store the 
preset, volume, pan position, and output bus routings for 32 MIDI channels along with 
the Global Tempo and the three Aux Send destinations.

� To Save the Current Multisetup

1. Set up all the multisetup parameters the way you want them.

2. Select Save from the Multisetup window on the toolbar.

3. Choose a name and number for the multisetup. Changing the number allows you 
to place the Multisetup anywhere you want in the list.

4. Press OK to save.

� To Restore a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Left-click on the desired multisetup icon in the tree and drag it over the Emulator X 
icon above the tree. This multisetup will be restored.

3. Alternate Method - Right-click over the Multisetup icon in the Tree and choose 
Load.

� To Rename a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Right-click on the desired multisetup icon in the tree, then select Rename from the 
pop-up dialog.

3. Type in a new name for the multisetup.

� To Delete a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Right-click on the desired multisetup icon in the tree, then select Delete from the 
pop-up dialog.

3. The Multisetup will be deleted.

� To Duplicate a Multisetup

1. Open the multisetup folder in the Tree. Any multisetups contained in the bank will 
be listed below the folder.

2. Right-click on the desired multisetup icon in the tree, then select Duplicate from 
the pop-up dialog window.

3. The Multisetup will be duplicated renamed “Copy of…XX” and placed in the first 
empty Multisetup location.

� To Rearrange the Order of Multisetups

1. Click once on the multisetup folder in the tree. The list of multisetups appears.

2. Select Details View from the view options in the toolbar and change the ID number.
If you try to save a Multisetup with a number that is already used, a popup dialog box 
will appear asking you if you want to use the next available ID number or enter a new 
ID.
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The Preset Editor allows you to edit presets and their key maps. Samples can be arranged 
into single-sample or multi-sample voices with synthesizer processing applied. Then 
these complete voices can then be arranged anywhere on the keyboard.

The Preset Editor contains three sections. The first section, Voices & Zones, is used for 
arranging voices and samples on the keyboard and editing global preset parameters.

The Links section makes it easy to build new presets by combining other finished 
presets. Multiple presets can be crossfaded or cross-switched according to key position, 
key velocity, or by the position of MIDI continuous controllers.

The third section, Voice Processing, is used to perform more detailed editing of voices 
such as envelope shaping of amplitude and filters as well as modulation parameters. 
This is the synthesizer section of Emulator X containing E-MU’s legendary Z-plane filters 
and powerful matrix modulation.

� To Edit a Preset:

1. Select the Sampler tab from the Tree. The contents 
of the current Emulator X bank appears in the Tree.

2. Double-click on the Preset folder from the tree (or 
click once on the (+) symbol). The preset folder 
expands to display the presets contained within.

3. Click on one of the Preset icons in the Presets 
folder to view the Preset Globals window.

4. Double-click on the desired preset icon from the 
tree (or click once on the (+) symbol). The preset icon 
expands to display the subsections: Voices and 
Zones, Links, and Voice Processing levels.

5. Select the desired section: Voices & Zones, Links, or 
Voice Processing by clicking on the associated icon.

� To Select a Preset from the Tree:

1. Set the Current Channel to the one you’re using by 
clicking on the channel number in the Multisetup 
screen.

2. Choose the preset you want in the tree and Right-
Click on its preset icon.

3. Choose Select on Current Channel. The preset is 
now selected for that channel.
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These parameters affect the entire preset and are saved with the bank.

Transpose & Volume
Transpose works by shifting the keyboard position. The actual samples are not retuned. 
In other words, if you have the same sound on each key, such as a piano, the piano will 
change key when you transpose. On the other hand, if you have a different drum 
assigned to each key, changing transpose will shift the position of the drums on the 
keyboard.

The volume control allows you to adjust the volume for the entire preset. This control is 
variable from -96 dB (off) to +10 dB.

Initial Controllers A-P
f Changing the initial 
controller settings is an 
easy way to customize a 
preset. Simply change the 
knobs and save the bank.

These set the initial value of MIDI controllers A-P for the preset. As soon as a MIDI 
controller is moved, it jumps immediately from this initial setting to the new setting of 
the control. The controllers A-P are assigned to MIDI continuous controller numbers in 
the Preferences dialog box.

Controllers A-P can be adjusted via MIDI or by turning the controller knob in the Multi-
setup.

The Label fields to the left of the initial controller knobs are user definable. These labels 
or “Scribble Strips” also appear in the Multisetup screen to show the function of the 
realtime controller knobs.

See “MIDI Channels & Real-time Controls” on page 142 for additional information 
about Controllers A-P.
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Tuning Tables
In addition to the standard equally divided octave tuning, Emulator X contains twelve 
factory programmed tuning tables. The Keyboard Tuning parameter selects which 
tuning is used by the current preset.

The factory keyboard tuning tables are described in the following table.

The Just C Tuning Tables
Well Tempered and Just were standard keyboard tunings up until the 20th-century when 
the current “equal tempered” scale became prevalent. In an equal tempered scale, the 
octave is equally divided into 12 parts. In Just or Well Tempered scales, the 12 notes are 
separately tuned to produce pure chords. However, in Just tunings you are limited to 
playing certain chords and if you play the wrong chord it may sound terrible!

Tuning tables can be changed as you play using a program change (create several presets 
with the same sound and different tuning tables) or using a continuous controller (link 
2 presets and crossfade between them using a controller).

The Just C2, Just C min, Just C3 Tuning Tables
Fully explaining the mysteries of just intonation is beyond the scope of this manual, but 
the subject is covered exhaustively in Hermann Helmholtz’s On the Sensations of Tone, 
available at most libraries and bookstores.

Tuning Tables Description

Equal Temperament Standard Western tuning 
12 equally spaced notes per octave.

Just C Just intonation. Based on small interval ratios. Sweet and 
pure, non-beating intervals.

Vallotti Valotti & Young non-equal temperament. Similar to 12 tone 
equal temperament. Each key has a different 
character for a given scale.

19-Tone 19 tone equal temperament. 19 notes per octave. 
Difficult to play, but works well with a sequencer.

Gamelan 5 tone Slendro and 7 tone Pelog. (Javanese.) Pelog are 
white keys, Slendro are black keys. Exotic tunings of 
Gamelan flavor.

Just C2 Allows you to play the following chords in the key of C: C, E, 
F, G, A, B, C#m, D#m, Em, F#m, G#m, Am, Bm

Just C-minor Allows you to play the following chords in the key of C: C, E, 
F, G, A, B, Em, Am, Bm, C#m, D#m, G#m

Just C3 Allows you to play the following chords in the key of C: C, D, 
F, Bb, C#m, Dm, Em, F#m, G#m, Am

Werkmeister III A “well” temperament developed in the 17th century. 
Although you can play in all keys, each key sounds slightly 
different.

Kirnberger Another well temperament developed by Johann 
Philipp Kirnberger where no pitch is more than 12 cents off 
from equal temperament.

Scarlatti A variant of Meantone tuning which was used from the 15th 
to 18th centuries.

Repeating Octave Middle C octave is repeated up and down the keyboard. 
Link with a preset in equal temperament to form unusual 
inversions up and down the keyboard.
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The four just intonation tables are called Just C2, Just C3, and Just C Minor. Try playing 
in the key of C/Cm using each table. You’ll quickly discover both the wonders and the 
frustrations of just intonation! In Just C, for example, you’ll find that the chords C, Em, 
F, G, and Am sound beautiful. If you hold one of these chords, you’ll hear no “beating”. 
After playing for a few minutes, switch back to Equal Temperament for a rude 
awakening!

At this point you might wonder why anyone would use Equal Temperament to begin 
with. For the answer to that question, play a D, Dmi, or Bb chord!.The intervallic ratios 
that make the C & G chords sound so pure make the D chord sound horribly out of 
tune. That's why we had to include Just C3. In this tuning, D, Dmi and Bb sound in 
tune, but the G chord will sound wrong.

Each of the 4 tables allows you to play a different group of common chords in just 
intonation. Sadly, there is no single 12 note tuning that will allow all of the common 
chords to be in tune, and of course that's why they invented the equal temperament 
tuning system that we use today.

Just C
Play these chords: C, E, F, G, A, Cm, C#m, Em, F#m, Gm, Am

Just C2
Play these chords: C, E, F, G, A, B, C#m, D#m, Em, G#m, Am, Bm

Just C minor

Play these chords: C, Db, D, Eb, G, Ab, Cm, Em, Fm, Gm

Just C3
Play these chords: C, D, F, Bb, C#m, Dm, Em, F#m, G#m, Am

Preset Modulators
The Preset Modulators are special class of modulation sources in that they originate at 
the Preset Level, but their output is used in the Voice PatchCords. There are three types 
of preset modulation sources.

Channel Lag 1 & 2 Rate
Like the Layer Lag processors (described on page 90) the Channel Lag slows down 
rapid changes in the input signal. The output “lags” behind the input at a pre-
programmed rate.

Unlike the layer level lag processors, the Channel Lags 1 & 2 take effect as soon as the 
preset is selected. In contrast, the Voice level lag processors begin acting only after a 
keyboard key has been depressed. The Channel Lag also has a Lag Amount input which 
controls the lag time. Positive lag amounts increase the lag time. A MIDI controller 
(front panel knob) is commonly used to control lag amount.

The Channel Lags could be used to slowly increase or decrease the speed of an 
LFO which in turn controls some other effect, perhaps left/right panning, pitch, 

Preset Modulator Typical Uses

Channel Lags 1 & 2 “Leslie” speaker effects. Switch slowly increases/decreases LFO speed.

Poly Ramp (Timer) Controlling key-up layer volume based on the time a key is held.

Channel Ramp Ramps on First Note only. “Hammond” style organ percussion.
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or the filter. When a MIDI footswitch is used as the input, the lag acts to slow 
down the instantaneous change of the switch. The slowly changing output value 
can then be routed using a patchcord to crossfade between voices or change the 
speed of an LFO.

Poly Key Timer
This processor starts a timer which begins counting down whenever a key is 
pressed and stops when the key is released. The value of this timer can be used on 
any voices assigned to the key after the key release. The Poly Key Timer is a 
special modulation source controlled by the key and not the voice.

Poly Key Timer can be used to control the volume of a Release Layer in order to reduce 
its volume the longer a key is held. This control is commonly used on grand piano 
presets to lower the pedal damper volume the longer the keys are held.

Channel
Lag

Lag Amount
(+ value = longer)

ex. footswitch

Release
Layer
Voice

Poly Release
Trigger

Preset Global

Amp

Amp Vol

Poly Key
Timer

Note-On - Poly Key Timer begins counting down.
Note-Off - Poly Key Timer stops counting and outputs value.

Release layer 
voice becomes 
softer the 
longer the key 
is held.
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Channel Ramp
This processor generates a single negative going slope whenever the first key is 
depressed on the MIDI channel. This preset level processor was originally 
designed to simulate the percussion key click on Hammond organs, but you may 
find other uses.

The Channel Ramp instantly resets when all notes have been released and the 
next first key on the MIDI channel is pressed. The value of the ramp rate sets the 
increment. Large values produce fast ramps and small values produce slow ramps. 

To use the Channel Ramp as a first-note decay envelope, patch the Channel Ramp out to 
Amp Volume and set the Amp Envelope for a fast attack and 100% sustain and short 
release.

Preset PatchCords
Preset PatchCords give you real-time control of the Preset Modulators. There are 12 
Preset PatchCords per preset with a source, a destination and an amount control. The 
amount can be set from -100 to +100.

Modulation Sources Modulation Destinations

Off Off

Pitch Wheel Channel Lag 1 In

Mod Wheel (Modulation Wheel) Preset Lag 1 Rate

Pressure (Channel Pressure) Channel Lag 2 In

Pedal Preset Lag 2 Rate

MIDI Volume (Controller 7) Channel Ramp

MIDI Pan (Controller 10) Poly Ramp Rate

Expression (Controller 11)

MIDI A-P

Footswitch 1

Flip-Flop Footswitch 1 (F’switch 1 FF)

Footswitch 2

Flip-Flop Footswitch 2 (F’switch 2 FF)

Thumbswitch

Flip-Flop Thumbswitch (T’switch FF)

DC Offset

Channel Ramp

de
cr

ea
se

1st Note
Played

time
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Voices & Sample Zones

Mix/Tune Tab
Volume, pan, transpose, coarse tuning and fine tuning can be adjusted separately for 
each voice. See page 70 to understand the difference between transpose and coarse tune. 
You can also set the group number from this page.

The Mix/Tune parameters are the same controls displayed in the Voice Editor (page 70 & 
82) and changes made to either page will appear in both places.

Voice Selection
A voice can be selected by clicking anywhere on the voice strip. Selection is shown by a 
red box around the voice strip.

1. Select the first voice in the “Voices & Zones” screen (red number).

2. Hold the Shift key to select contiguous voices. Hold the Control key to select non-
contiguous voices. Press Control-A to select all voices.

Note about multiple voice editing: If you open several voices for editing which have 
different voice parameter settings, the parameters in the different voices will remain as 
they were until you change them. That is, if you have three voices selected and you 
change the filter cutoff, all three voices will jump to the new cutoff setting, but all the 
other parameters will remain as they were.

Samples & Multisamples
The samples contained in the voice are displayed and can be edited. If the voice contains 
more than one sample, the word, “Multisample” will displayed in the sample field. All 
the samples in a multisample share the same set of synthesizer parameters. However, 
the volume, fine tune and pan parameters can be adjusted separately for each sample in 
a multisample.

� To View & Edit the Samples in a Multisample

1. Click on the down arrow  to display the individual samples and key ranges which 
comprise the multisample.

2. Click the arrow  to collapse the multisample.
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The multisample key range sets the overall key range limit for the samples in the multi-
sample. In the diagram above, the top sample will not played, because its key range is 
outside the limit of the Multisample key range.

Groups
Voices can be categorized into Groups as a way to organize and select similar voices, say 
a layer of piano voices and a layer of string voices, into unified entities.

You can create a temporary group if you want to edit several voices. Grouping the voices 
and then selecting the group is faster and more dependable than manually selecting 
each voice when editing.

� To Place a Voice into a Group

1. Tag each voice you want to be in the group with the same group number. This can 
be done in the “Voices and Sample Zones” window or from the “Voice Editor” 
window.

2. Whenever you select that group number in the Voice Editor screen, all voices with 
that group number will be selected. You can define up to 32 groups, but a voice can 
only be in one group at a time.

� To Select All Voices for Editing

� To Select a Group of Voices for Editing

Simply select the desired group number from the Voice Processing page. Once you have 
selected a group, you will be editing all the voices in this group.

• From the “Voices & Sample Zones” window, press Control-A.

• From the “Synth Editor” window, select “All” in the Group box.

Multisample Key Range Individual Sample Key Ranges

Multisamples allow you to place multiple samples under the same set of synthesizer voice 
parameters. 

Expand/Collapse Multisample
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Key Window Page

When a sample is recorded, it is automatically placed in a voice and assigned a keyboard 
range specified in the “Auto-Placement” parameters in the “Acquire” or Import 
Samples” options in the File menu. The Key Range Window allows you to edit these 
assignments and place the voices and samples wherever you want.

A voice containing only one sample takes the name of the sample. If a voice contains 
more than one sample, it is called a “Multisample” and the samples it contains are listed 
below it. The screen above shows two single sample voices. Voice 1 plays on the lower 
half of the keyboard and voice 2 plays on the upper half.

The Original Key determines the pitch of the sample. The original key need not be 
located between the high and low key ranges. Samples normally have the original key as 
part of the sample name. Imported samples with embedded original key information 
can be auto-mapped the correct location. See page 154.

The key position is edited by placing the cursor over the desired parameter and then 
playing the MIDI keyboard or adjusting the value using the keyboard. You can also 
simply drag the blue bar to the desired position with the mouse.

Voices and samples can be crossfaded according to key position by adjusting the low 
and high fade parameters. The fade is adjusted in “number of keys” and is graphically 
represented by a gradual decrease in the color intensity of the bars.

� To Manipulate the Bars:

• To Set the Length of the Bar: Left-click and drag from either endpoint.

• To Create a Fade: Left-click and drag inward while holding the Ctrl key.

� To Switch Voices According to Position
Assigning voices (samples or multisamples) adjacent to each other is the simplest and 
most common application of the Key Window. The voices in the screen below are each 
assigned a one octave range.

Key Position
Low & High Key, Crossfades

Original Key Graphic Display 
of Voice Position

Selector 
Button

Sample Name

Scroll 
Bar

The voice will gradually fade-out in volume below B2 as you play down the keyboard.

B2
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Key Window Page
Another way of visualizing this assignment is shown below.

f Samples can be 
arranged in a 
multisample voice in 
exactly the same way 
that voices are arranged 
on the keyboard. They 
can be arranged side by 
side on the keyboard or 
stacked on top of each 
other to create layered 
sounds, all within a single 
voice.

� To Layer Voices and Samples
The ranges of two or more voices may overlap, and all voices assigned to a key will 
sound.

Another way of visualizing this assignment is shown below.

VOICE 1 VOICE 2 VOICE 3 VOICE 4

VOICE 1 VOICE 2 VOICE 3 VOICE 4
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E You may want to 
assign voices in different 
layers to different groups. 
This allows you to select 
all of the voices in each 
layer just by selecting the 
group number. You can 
edit the group number of 
a voice in any of the 
Voice screens.

� To Positionally Crossfade
This technique can help mask the point at which two sounds meet of can be used for 
crossfading sound effects. The fade parameters allow the volume of the voice or sample 
to be faded out as a function of key position. In the screen shown below, voices 1 and 2 
are being positionally crossfaded over a range of five notes.

As the voice boundaries are crossed playing up the keyboard, the lower voice gradually 
fades out as the upper voice fades in.

Velocity Window Tab
The Velocity Window allows you to control the volume of a voice by the key velocity. 
Using this function, you can crossfade or cross-switch between voices by key velocity. 
Suppose you had several samples (voices) of the same piano note, one played soft, the 
next played medium hard, and the third played hard. Using this function, you could set 
the velocity at which each of the voices would sound, thus recreating the response of the 
actual instrument.

VOICE 1 VOICE 2 VOICE 3 VOICE 4

Velocity Range
Low & High Velo, Crossfades Graphic Display of Velocity 

Switch/Fade
Selector 

Button/Indicators

Sample Name

Scroll 
Bar
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� To Velocity Switch Voices:

1. In order to velocity switch voices, they must first be assigned to the same key range. 
In the Key Window, set the high and low key range of the voices so that they 
completely overlap.

2. Select the Velocity Window tab shown above. By default both voices will be assigned 
to the full 0-127 velocity range.

3. Set the velocity range so that each voice has its own velocity range.

(In the example screen above, a key velocity of 1-35 will play voice 1, a key velocity of 36-80 
will play voice 2, and a key velocity of 81 or above will play voice 3.)

� To Velocity Crossfade Voices:

1. In order to velocity crossfade voices, they must first be assigned to the same ky 
range. In the Key Window, set the high and low key range of the voices so that they 
completely overlap.

2. Select the Velocity Window tab shown above. By default both voices will be assigned 
to the full 0-127 velocity range.

3. Set the Fade parameter for each voice so that as one voice faces out the other fades 
in.

4. Play the keyboard and fine tune the crossfade points for the desired response.

Realtime Window Tab
The Realtime Window allows you to control the volume of a voice using a real-time 
controller such as a modulation wheel, a pedal, an LFO or an envelope generator. It 
works in a manner very similar to the velocity window except that a realtime controller 
is used to control the volume instead of key velocity.

Realtime Range
Low & High Range, Crossfades

Graphic Display of 
Realtime Switch/Fade

Sample Name

Scroll 
Bar

Selector Buttons 
& Indicators
58 Emulator X Operation Manual



5 - Preset Editor
Key Window Page
� To Realtime Crossfade Two Voices:

� Warning: Make sure 
you understand how to 
select Voices and assign 
Cords before attempting 
to perform realtime 
crossfades.

1. In order to realtime crossfade voices, they must first be assigned to the same key 
range. In the Key Window, set the high and low key range of the voices so that they 
completely overlap.

Set up the Voices

2. Select the Realtime Window tab shown above. By default both voices will be 
assigned to the full 0-127 range.

3. Set the Fade parameter for each voice so that as one voice faces out the other fades 
in. Voice 1 will be at full volume until the realtime controller reaches a value of 16. 
It will then begin fading out. Voice 2 will begin fading in immediately and be at full 
volume from 100 to 127.

Assign the Realtime Controller

4. Select one of the voices you want to crossfade by clicking anywhere on the strip. A 
red box forms around the voice to show that it’s selected.

5. Now hold the Crtl key and select the next voice you wish to crossfade by clicking on 
it. Both voices should be surrounded by red boxes.

6. With both voices selected, select Open Voices (Crtl+Enter) from the Preset menu. 
The Voice Editor screen appears. Verify that the two voices are selected in the “Voice 
Selector” section of the window.

7. Assign a realtime controller to control the crossfade. Select Amp Crossfade as the 
destination. Select a modulation source that goes from 0-127 such as Aux 
Envelope+, LFO+ or MIDI A-P. Set the Cord Amount to +127.

8. You should now be hearing the realtime crossfade when you play a key. You may 
have to go back to the Realtime Crossfade page to adjust and fine tune the crossfade 
points. These settings will vary with the sounds that are being crossfaded.

� To Randomly Cross-switch or Crossfade Between Voices:

In certain situations, such as setting up drum kits, you may want to randomly switch 
between several voices. Crossfade Random is a modulation source specifically designed 
to handle this situation. Unlike the other random sources, Crossfade Random generates 
one random number for all voices that are assigned to the same key.

1. In order to realtime crossfade or cross-switch voices, they must first be assigned to 
the same key range. In the Key Window, set the high and low key range of the voices 
so that they completely overlap.

Set up the Voices

2. Select the Realtime Window tab.

3. Set up a basic cross switch in the Realtime Window as shown below. For this 
example, we’ll use two voices. This will cause voice 1 to sound whenever the random 
value is in the range of 0-63 and voice 2 to sound whenever the random value is in 
the range of 64-127.
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Assign the Realtime Controller

f Tip: Random Cross-
Switch can be used in 
combination with 
Velocity Switching to play 
random voices when you 
play softly and a known 
voice when you play 
hard.

4. Select the first voice by clicking anywhere on the strip. A red box forms around the 
voice to show that it’s selected.

5. Hold the Ctrl key and select the next voice by clicking on it. Both voices should be 
surrounded by red boxes.

6. With both voices selected, select Open Voices (Crtl+Enter) from the Preset menu. 
The Voice Editor screen appears. Verify that the two voices are selected in the “Voice 
Selector” section of the window.

7. Assign Crossfade Random as modulation source in the Cords section. Select Amp 
Crossfade as the destination. Set the Cord Amount to +127.

8. Voices 1 and 2 will now be randomly selected whenever you press a key.

Continuous Controller Window Tabs
The CC Windows (1-5) offer additional voice switching and crossfading possibilities 
using MIDI Continuous Controller messages. Unlike the Realtime window, the CC 
crossfades and cross-switches occur only at Note-on time. They cannot be continu-
ously swept during the note. These controls are designed to be used to switch and fade 
voices during your performance. You can use the CC windows to switch between drum 
sets, or bring in accent samples.

The CC assignments are easy to use because you can complete the entire patch from this 
window. The list of control sources is accessed by clicking on the button to the right 
of the Assignment screen. The following control sources available: Mod Wheel, Pressure, 
Pedal, MIDI A-P, Footswitch 1 & 2, Flip-Flop Footswitch 1 & 2, Thumbswitch and Flip-
Flop Thumbswitch.

� To Cross-switch Two Voices:

1. In order to cross-switch voices, they must first be assigned to the same key range. In 
the Key Window, set the high and low key range of the voices so that they 
completely overlap.

2. Set up a basic cross switch in one of the CC Windows as shown above. For this 
example, we’ll use two voices. This will cause voice 1 to sound whenever the CC 
value is in the range of 0-63 and voice 2 to sound whenever the CC value is in the 
range of 64-127.

List of Control Sources
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3. Select one of the controllers from the list. Do this for each voice you wish to switch. 
In the example above, voice 1 will sound whenever the Mod Wheel is less than 
halfway up. Voice 2 will sound whenever the Mod Wheel is more than halfway up.

Voice & Sample Zone Utilities
These utilities are invaluable when creating and modifying Emulator X voices. The voice 
and Sample Zone Utilities are located under the Preset menu.

Voice Utilities

Open Voices
This function opens the voice editor for the currently selected voice(s).

Open Sample 
This function opens the sample editor for the currently selected sample.

New Voice
This function allows you to add a new empty voice to the preset. You’ll use this function 
when building new presets from scratch or to add a voice to an existing preset.

Delete Voices
This function deletes the selected voice, but does not erase the samples.

Duplicate Voices
This function makes a copy of the voice, but does not copy the samples.

Combine Voices
This function takes all selected voices and combines them into one multisampled voice. 
The synthesizer level programming of the first voice is used for the new voice. Any 
synthesizer level programming associated with the other voices is lost.

Expand Voice
This function takes apart the selected multisampled voice and makes an individual 
voice for each sample. The voice processing information of the “parent” voice is dupli-
cated for each newly created voice.

Voice 1 Voice 2 Voice 3 Voice 4

Sample 01

Sample 02

Sample 03

Sample 04

Voice 01

COMBINE

Before -

After -
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Sample Zone Utilities
A Sample Zone is the keyboard mapping of the samples used in a voice. Use these 
utilities when editing multisample voices.

New Sample Zone
This function creates a new sample zone in the currently selected voice. If this operation 
is performed on a single sample voice, the voice is transformed into a multisample.

Delete Sample Zones
This function deletes the currently selected sample zones from the voice.

Duplicate Sample Zones
This function makes a copy of the currently selected sample zones, but does not copy 
the samples.

Voice 1 Voice 2 Voice 3 Voice 4

Sample 01

Sample 02

Sample 03

Sample 04

Voice 01
EXPAND

Before -

After -
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Edit Menu Utilities - Cut, Copy & Paste
E Voices cannot be 
pasted onto the desktop 
or outside of a bank.

You can use the standard cut, copy & paste utilities when working with voices and 
sample zones. Single or multiple voices can be selected, then moved or rearranged 
within the bank or between banks. This makes it easy to create or modify custom presets 
and banks.

� To Copy and Paste Voice(s)

1. Select the voice(s) you wish to copy. (Hold Shift to select contiguous voices.)

2. Select Copy from the Edit menu.

3. Open a new preset if you want to paste between voices.

4. Select the Voices and Samples page.

5. Select Paste from the Edit menu. The following dialog box appears.

6. You have the option of pasting the voice(s) before the currently selected voice, after 
the currently selected voice or starting at a specified voice number. This feature 
allows you to rearrange your voices any way you want.

7. Press OK to paste the voice or Cancel to cancel the operation.
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Links
Links call up additional presets in the bank as a quick and easy way to create layering or 
keyboard splits. Linked presets are not altered by being linked to another preset, they 
are simply played.

One way to create new presets is to simply link several other presets to an empty preset. 
Each linked preset can be customized with its own keyboard range, velocity range, 
continuous controller assignments, volume, pan position, and tuning.

� To Access the Link Windows:
f Tip: You can also 
create a new Link by 
simply dragging and 
dropping a preset onto 
the preset field in the Link 
page.

1. Select the Sampler Tab in the Tree.

2. Open the Presets folder by clicking on the (-) sign next to the folder.

3. Select a Preset or Create a New Preset (Presets > New Preset).

4. Open the Preset by clicking on the (-) sign next to the preset icon.

5. You’ll see three sub-icons beneath the Preset icon. Click on the Links icon. The 
Links window opens.

6. Select Links > New to add a new link.

7. The Mix/Tune window appears. Click the tabs across the top of the window to select 
the various Link windows.

Preset #1

Preset #2

Layering Two Presets Using Links

Key Range

Key Range

Key Range
Preset #1

Preset #2

Creating a Split Keyboard with Links
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These three controls are accessed from the main menu.

� To Create a Huge Stacked Preset the Easy Way:

1. Load any bank of presets.

2. From the Sampler Tab of the Tree, click on the Presets folder.

3. Select Preset > New Preset to create a new blank preset. “Blank Preset” will appear 
in the Tree. (Look at the bottom of the list.)

4. Rename your new preset and double-click on the plus sign to open it. The Voices & 
Zones, Links and Voice Processing branches appear.

5. Click on the Links icon. The Link window appears.

6. Select Links > New Link to create a new blank link.

7. Click on the Preset button to the right of the preset field. A pop-up menu appears. 

8. Select a preset.

9. Repeat steps 6 and 7 to add additional presets until the desired thickness is 
achieved.

Mix/Tune Window
This window allows you to set the volume, pan position, transpose and fine tuning for 
the linked preset.

New Creates a new link.

Delete Deletes the selected link(s).

Duplicate Duplicates the selected link(s).

• Volume Adjusts the volume of the linked preset.

• Pan Sets the stereo pan position of the linked preset.

• Transpose Transposes the linked preset by shifting the keyboard position. (See page 70.)

• Fine Tune Allows you to detune the linked preset by ±100 cents. (1 semitone)
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Key Window
The key window works just like the key window in the Voices and Zones section 
(page 53) and allows you to set the keyboard range for each linked preset.

Velocity Window
The velocity window works just like the velocity window in the Voices and Zones section 
(page 53) and allows you to set the velocity range for each linked preset. In the example 
below the presets are set to crossfade from Link 1 to 2 as the key velocity is increased.

CC Window
The CC or continuous controller window works just like the CC window in the Voices 
and Zones section (page 60) and allows you to set the range for each linked preset using 
continuous controllers. In the example below the presets are set to switch from Link 1 to 
2 as the Mod Wheel is turned past 63. The CC values are locked in at note-on time. 

Key Position
Low & High Key, Crossfades

Graphic Display 
Keyboard Range

Selector 
Button

Linked Preset

Velocity Range
Low & High Velo, Crossfades

Graphic Display of 
Velocity Range

Selector
Button

Linked Presets

CC Range
Low & High Range, Crossfades

Graphic Display of 
Controller Range

Selector
Button

Linked Presets

Continuous 
Controller 

Assignments
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Simplified Emulator X Signal Path
6 - Voice Editor / Synthesizer Level

Voice Processing contains the traditional synthesizer controls such as envelope shaping 
of amplitude and filters as well as modulation parameters. When multiple voices are 
selected, parameter changes affect all selected voices (i.e. setting the filter cutoff to 50, 
sets it to 50 on all selected voices). The voice processing parameters are accessed by 
clicking on the Voice Processing icon in the Tree

� To Select Multiple Voices:
f See Groups on 
page 54.

• Assign voices to Groups in the Voices and Zones page, then select the group.
• Select the desired voices from the Voices and Zones page.
• Drag the range bar below the little keyboard to select a range of voices.

f IntelliEdit is enabled in 
the MIDI Preferences 
dialog box. See page 10.

• Hold Crtl+Alt and play your MIDI keyboard to select voices (with IntelliEdit on).
• Press Ctrl-A to select all voices from the voice processing page.

Simplified Emulator X Signal Path
A single Emulator X voice is diagrammed below. The audio path includes one or more 
samples, a dynamically controlled filter, and a dynamically controlled amplifier with a 
panning network. Modulation parameters operate simultaneously on all samples 
contained in a voice. PatchCords with built-in amount controls connect modulation 
sources (LFOs envelopes, knobs, etc.) to modulation destinations (sample pitch, filter, amp 
volume, etc.). Memorize this voice architecture diagram to better understand the 
Emulator X and make programming much easier.
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Overview of the Voice Editor

The voice editor window displays all the synthesizer controls and PatchCord routings 
for the selected voice(s). Each module, surrounded by the blue borders, contains an 
independent synthesizer function.

Templates
For each different module in the voice editor, you can save a library of your favorite 
settings. These Templates make it easy to create your own customized voices and presets. 
Templates are saved with the Emulator X application so they’re always available for use. 
Here’s how they work:

� To Create a Template

1. Set the controls as desired for a 
particular module.

2. Right-click with the mouse anywhere 
inside the module border. A pop-up 
dialog box appears.

3. Select Save as Template or press “S” 
while the popup dialog box is visible. 
The following popup dialog box 
appears.

4. Type in a name for your Template and 
click OK. The Template is saved with 
the editor program, ready to use when 
you open another bank.
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� To Recall a Template

1. Right-click with the mouse anywhere inside the module border. A pop-up dialog 
box appears.

2. Select Template or press “T” while the popup dialog box is visible. The following 
popup dialog box appears.

3. Select the Template you want and click OK.

� To Rename or Delete a Template

1. Select the desired template from the Template Management dialog box.

2. Click Delete to permanently remove the Template.

3. Click Rename, then type in the new name to rename the Template.
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Oscillator

Pitch Bend Range
These two sliders allow you to set the amount of pitch bend up or down when a MIDI 
pitch wheel message is received. Pitch wheel messages are automatically routed to pitch 
unless these controls are set to zero.

Tuning Controls

Transpose
This function allows you to transpose the key of the selected voice(s) in semitone 
intervals by shifting the keyboard position relative to middle C. The transpose range is 
-36 to +36 semitones. You will normally use the transpose function to tune a voice to its 
keyboard location, or simply to transpose the voice.

This is the same Transpose control displayed on the Mix/Tune tab of Voices & Zones 
(page 53) and changes made to either page will appear in both places.

Coarse Tuning
This function allows you to change the tuning of the voice in semitone intervals. The 
coarse tuning range is -72 to +24 semitones. Unlike the transpose function, coarse 
tuning stretches the pitch of the individual samples assigned to a key and may change 
the timbre of a voice.

This is the same Coarse Tuning control displayed on the Mix/Tune tab of Voices & Zones 
(page 53) and changes made to either page will appear in both places.

Fine Tuning
This function allows you to change the tuning of the voice in 1/100 cent intervals (100 
cents = 1 semitone). The fine tuning range is ± 1 semitone. Fine tuning can be used to 
slightly detune a voice, creating a “fatter” sound when it is combined with another 
voice.

This is the same Fine Tuning control displayed on the Mix/Tune tab of Voices & Zones 
(page 53) and changes made to either page will appear in both places.

Fixed Pitch Mode
This function turns keyboard transposition On or Off for the voice. With Fixed Pitch 
On, the keyboard will not control the pitch of the voice. This is a useful function for 
drones or “chiffs”, which you may not want to track the keyboard.

f Use Transpose 
when you want the 
voice's timbre to 
remain constant. 

f Use Coarse 
Tuning when you 
want to change the 
timbre of the voice.

f Use the Coarse 
Tuning control to 
change the tuning of 
voices containing 
multiple drums.
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Chorus Amount
Chorus “thickens” the sound by doubling the sound in stereo and 
then detuning it. Chorus uses twice as many voices and twice as 
much of your CPU power when the Amount is set above zero.

Chorus amount and ITD can be modulated in the Cords section, although ITD can only 
be changed at the time of the key depression. When Chorus is on, a mono voice will use 
twice as many channels.

“Off“ is different than “0” for chorus amount. With mono samples, chorus On effec-
tively turns a mono sample into a stereo sample with detuned L & R sides, with Chorus 
Amount being the detune amount. With chorus Off, no amount of modulation will 
turn the chorus on. With chorus On, modulation can drive the chorus (detune) amount 
to a minimum of 0, but not Off.

Tips for Using Chorus

Glide Rate & Curve
Glide is a smooth gliding between notes instead 
of the normal instantaneous change in pitch 
when a new key is pressed. The glide rate deter-
mines the time it takes to glide to the new pitch. 
The larger the value, the slower the glide rate. The 
rate is adjustable from 0 to 32.738 seconds. Zero 
seconds equals Off. A glide curve setting of 0 
equals linear. Higher values make the curve more 
exponential. Glide is polyphonic, but can be 
monophonic when in Solo mode.

Amount
The amount of detuning and is variable from 
Off to 100%.

Stereo Width
Controls the stereo spread. 0% reduces the 
chorus to mono and 100% gives the most 
stereo separation.

Inter-Aural Time 
Delay (ITD)

Adjusts the delay of the left and right sounds. 
Positive values start the right channel early 
and the left late.

Set chorus amount to 1% and use chorus width as a pan control which does not span the 
entire L/R spread.

Set the chorus width to 0% and adjust the ITD to create a through-zero flange effect. With 
100% width, a panning-chorus effect is obtained.

To avoid L/R pitch drift, use “~” type of modulation in the cords selection box.

Set the Chorus Width to 0% and adjust the ITD to create a through-zero flange effect. With 
100% width, a panning chorus effect is obtained.

Modulate the ITD to create “Hass-Effect” panning, (i.e. apparent location shift using slight delays 
in the L-R channels.)

For a detuned analog oscillator sound, set stereo width to 100%. Route a free running LFO (~) 
to chorus position with amount set to about 25%.
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Oscillator
Key Controls

Delay
Delay varies the time between the arrival of a 
MIDI Note-On message and the onset of a 
note. The delay time is adjustable from 0 to 
10,000 milliseconds (0-10 seconds). Delay can 
be used to create echo effects or to thicken the 
sound when using layered voices.

Sample Offset
This function allows you to set where the 

voice's sample begins playing when you hit a key. A setting of 0 plays a sample from the 
beginning, higher values move the sample start point toward the end of the sound.

Sample Start 
Offset
72 Emulator X Operation Manual



6 - Voice Editor / Synthesizer Level
Amplifier, Filter & Auxiliary Envelopes
Amplifier, Filter & Auxiliary Envelopes
Emulator X contains three envelope generators per voice. The Amplifier Envelope is 
“hard-wired” to control the DCA (volume) and cannot go below the zero baseline (0-
100). The Filter and Auxiliary Envelope generators are general purpose envelopes which 
must be patched to a destination using a PatchCord. The levels of the Filter and 
Auxiliary Envelopes can be programmed between the value range of -100 to +100.

Adjusting the Envelopes
There are four ways to adjust the envelope parameters:

The time values are calculated using time and the vertical distance to the next point. 

Adjust the Time/Level knobs.

Grab one of the points on the Envelope Display and drag the envelope.

Position the cursor in the Time or Level numeric fields and type in a time value.

Position the cursor in the Time numeric field and type in the exact time.

At
k1

Atk2 D
cy1

Dcy2
Rls1

Rls2

Key
Down

Key
Released

Sustain

time

level

Holds here
until key release

Level Controls

Time ControlsTime / BPM Select

Amp / Filter / Aux
Selector Buttons

Envelope
Repeat
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Time-based and BPM Envelopes
Envelope times can be time-based or BPM-based. Time-based envelopes have an 
absolute time setting, such as 1 second. BPM-based envelope times are divided down 
from the Master Tempo setting on the Multisetup page. The Master Tempo scales the 
time of the BPM-based envelope segments.

BPM times are displayed in musical time intervals where possible. For example, if you 
set the attack time to be 1/16, the attack time will last exactly one sixteenth-note at the 
master tempo.

BPM Envelopes
E Note: The master 
tempo can be set 
internally using the 
tempo control in the 
Multisetup window, or 
controlled from an 
external MIDI clock. 
Internal/External clock 
selection is located in the 
Preferences dialog box.

BPM envelopes are controlled by the Master Tempo (located in the Multisetup window). 
The Master Tempo rate scales the time of the BPM envelope segments. The Master 
Tempo can also be derived from an external MIDI clock to synchronize the envelope 
times with external sequencer or arpeggiator tempo changes. See note->.

Envelope Repeat
The Envelope Generators can also be made to repeat. When the envelope repeat 
function is On, the Attack (1&2) and Decay (1&2) stages will continue to repeat as long 
as the key is held. As soon as the key is released, the envelope continues through its 
normal Release stages (1 & 2).

E Only the Filter and 
Auxiliary Envelopes have 
the repeating feature.

The diagram above show how the looping envelopes work. When the key is pressed the 
envelope goes through its regular Attack 1, Attack 2, Decay 1 and Decay 2 stages. In non-
looping mode, the envelope would hold at the end of the Decay 2 stage until the key 
was released. In looping mode however, it jumps back to the Attack 1 stage and repeats 
the first four stages. It continues to loop through these four stages until the key is 
released where it immediately jumps to the Release 1 stage.

= Initial Setting

= Increase Master Tempo

= Decrease Master Tempo

BPM Envelopes
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The chart below lists all the displayed musical note divisions when the envelope is set to 
BPM. The “Master Tempo Clock Pulses” column shows the exact number of clocks used 
by each note division based on the MIDI standard of 24 pules per quarter note. The 
envelope segments will last for the exact note division shown. You can also set envelope 
times between the standard note divisions. These are displayed as integer numbers.

BPM Tempo Rates
(based on Master Tempo) Displayed Note Division Master Tempo Clock 

Pulses

hex whole note (quad long) 16/1 1536

dotted octal whole note 8/1d 1152

hex whole note triplet 16/17 1024

octal whole note  (double long) 8/1 768

dotted quad whole note 4/1d 576

octal whole note triplet 8/1t 512

quad whole note (long) 4/1 384

dotted double whole note 2/1d 288

quad whole note triplet 4/1t 256

double whole note (breve) 2/1 192

dotted whole note 1/1d 144

double whole note triplet 2/1t 128

whole note 1/1 96

dotted half note 1/2d 72

whole note triplet 1/1t 64

half note 1/2 48

dotted quarter note 1/4d 36

half note triplet 1/2t 32

quarter note 1/4 24

dotted 8th note 1/8d 18

quarter note triplet 1/4t 16

8th note 1/8 12

dotted 16th note 1/16d 9

8th note triplet 1/8t 8

16th note 1/16 6

dotted 32nd note 1/32d 4.5

16th note triplet 1/16t 4

32nd note 1/32 3

dotted 64nd note 1/64d 2.25

32nd note triplet 1/32t 2

64th note 1/64 1.5
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Filter Controls

You can choose from 53 different filter types or choose “No Filter”, which bypasses the 
filter section.

Most of the filters have two parameters: Frequency (or Morph) and Resonance (Q, Gain, 
Body Size). These two parameters can be continuously varied during the note (choose 
realtime resonance).

The frequency response curve of the filter is accurately shown in the display as you 
change the initial filter settings. Frequency is shown on the horizontal axis, with 
amplitude on the vertical axis.

High values of Q or resonance, amplify frequencies near the cutoff or center frequency. 
In a swept EQ filter, gain controls the amount of boost or cut. In a phaser or flanger, 
resonance determines the depth of the effect. In the vocal filters, body size determines 
the apparent size of the mouth cavity.

You will notice an increase in voice count when the filters are bypassed as the filters steal 
cycles from your computer’s CPU. 12th order filters use more CPU and therefore 
decrease the maximum voice count.

Filter Descriptions

Filter Name Order Type Description

2-pole Lowpass 02 LPF Typical OB type low-pass filter with a shallow 
12 dB/octave slope.

4-pole Lowpass 04 LPF 4-pole low-pass filter, the standard filter on 
classic analog synths. 24 dB/octave rolloff.

6-pole Lowpass 06 LPF 6-pole low-pass filter which has a steeper slope 
than a 4-pole low-pass filter. 36 dB/octave 
rolloff!

2-pole Highpass 02 HPF 2-pole high-pass filter. 12 dB/octave slope.

4-pole 
Highpass

04 HPF Classic 4-pole high-pass filter. Cutoff sweep 
progressively cuts 4th Order High-pass.

2-pole 
Bandpass

02 BPF Band-pass filter with 6 dB/octave rolloff on 
either side of the passband and Q control.

4-pole 
Bandpass

04 BPF Band-pass filter with 12 dB/octave rolloff on 
either side of the passband and Q control.

Filter Types

BPF Band-pass filter

EQ+ EQ boost filter

EQ- EQ cut filter

FLG Flanger filter

HPF High-pass filter

LPF Low-pass filter

PHA Phaser filter

PROG Programmable

REZ Highly Resonant

SFX Special Effect

VOW Vowel / formant

WOW Wah-Wah pedal
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Contrary 
Band pass

06 BPF A novel band-pass filter where the frequency 
peaks and dips midway in the frequency range.

SweptEQ 
1 octave

06 EQ+ Parametric filter with 24 dB of boost or cut and 
a one octave bandwidth. 

Swept EQ
2->1 octave

06 EQ+ Parametric filter with 24 dB of boost or cut. The 
bandwidth of the filter is two octaves wide at 
the low end of the audio spectrum, gradually 
changing to one octave wide at the upper end. 

Swept EQ 
3->1octave

06 EQ+ Parametric filter with 24 dB of boost or cut. The 
bandwidth of the filter is three octaves wide at 
the low end of the audio spectrum, gradually 
changing to one octave wide at the upper end. 

Phaser 1 06 PHA Recreates a comb filter effect typical of phase 
shifters. Frequency moves position of notches. 
Q varies the depth of the notches.

Phaser 2  06 PHA Comb filter with slightly different notch 
frequency moving the frequency of notches. 
Q varies the depth of the notches.

FlangerLite 06 FLG Contains three notches. Frequency moves fre-
quency and spacing of notches. 
Q increases flanging depth.

Vocal 
Aah-Ay-Eeh

06 VOW Vowel formant filter which sweeps from “Ah” 
sound, through “Ay” sound to “Ee” sound at 
maximum frequency setting. Q varies the 
apparent size of the mouth cavity.

Vocal Ooh-Aah 06 VOW Vowel formant filter which sweeps from “Oo” 
sound, through “Oh” sound to “Ah” sound at 
maximum frequency setting. Q varies the 
apparent size of mouth cavity.

Dual EQ Morph 06 PROG Please refer to the detailed description on page 79.

Dual EQ + 
Lowpass Morph

06 PROG Please refer to the detailed description on page 81.

Dual EQ Morph + 
Expression

06 PROG Please refer to the detailed description on page 80.

Peak/Shelf Morph 06 PROG Please refer to the detailed description on page 81.

Ace of Bass 12 EQ+ Bass-boost to bass-cut morph

MegaSweepz 12 LPF “Loud” LPF with a hard Q. Tweeters beware!

EarlyRizer 12 LPF Classic analog sweeping with hot Q and 
Low-end.

Millennium 12 LPF Aggressive low-pass filter. Q gives you a variety 
of spiky tonal peaks.

MeatyGizmo 12 REZ Filter inverts at mid-Q. 

KlubKlassik 12 LPF Responsive low-pass filter sweep with a wide 
spectrum of Q sounds 

BassBox-303 12 LPF Pumped up lows with TB-like squelchy Q 
factor. 

FuzziFace 12 DST Nasty clipped distortion. Q functions as 
mid-frequency tone control.

DeadRinger 12 REZ Permanent “Ringy” Q response. 
Many Q variations.

Filter Name Order Type Description
E-MU Systems 77



6 - Voice Editor / Synthesizer Level
Amplifier, Filter & Auxiliary Envelopes
TB-OrNot-TB 12 EQ+ Great Bassline “Processor.”

Ooh-To-Eee 12 VOW Oooh to Eeee formant morph. 

BolandBass 12 EQ+ Constant bass boost with mid-tone Q control.

MultiQVox        12 VOW Multi-Formant, Map Q To velocity.

TalkingHedz      12 VOW “Oui” morphing filter. Q adds peaks.

ZoomPeaks 12 REZ High resonance nasal filter.

DJAlkaline 12 EQ+ Band accentuating filter, Q shifts “ring” 
frequency.

BassTracer 12 EQ+ Low Q boosts bass. Try sawtooth or square 
waveform with Q set to 115.

RogueHertz 12 EQ+ Bass with mid-range boost and smooth Q. 
Sweep cutoff with Q at 127.

RazorBlades 12 EQ- Cuts a series of frequency bands. 
Q selects different bands.

RadioCraze 12 EQ-  Band limited for a cheap radio-like EQ

Eeh-To-Aah 12 VOW “E” to “Ah” formant movement. Q accentuates 
“peakiness.”

UbuOrator 12 VOW Aah-Uuh vowel with no Q. Raise Q for throaty 
vocals.

DeepBouche 12 VOW French vowels! “Ou-Est” vowel at low Q.

FreakShifta 12 PHA Phasey movement. Try major 6 interval and 
maximum Q.

CruzPusher 12 PHA Accentuates harmonics at high Q. Try with a 
sawtooth LFO.

AngelzHairz 12 FLG Smooth sweep flanger. Good with vox waves. 
e.g. I094, Q =60 

DreamWeava 12 FLG Directional Flanger. Poles shift down at low Q 
and up at high Q.

AcidRavage 12 REZ Great analog Q response. Wide tonal range. Try 
with a sawtooth LFO.

BassOMatic 12 REZ Low boost for basslines. Q goes to distortion at 
the maximum level.

LucifersQ 12 REZ Violent mid Q filter! Take care with Q values 
40-90. 

ToothComb 12 REZ Highly resonant harmonic peaks shift in 
unison. Try mid Q.

EarBender  12 WAH Midway between wah & vowel. Strong 
mid-boost. Nasty at high Q settings.

KlangKling 12 SFX Ringing Flange filter. Q “tunes” the ring 
frequency. 

Filter Name Order Type Description
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Programmable Morphing Filters
There are four user-programmable morphing filters which have the ability to change 
their response over time. Now you can design your own custom filters that morph 
between filter types. Take the time to learn about these powerful filters because they are 
extremely useful and sound great.

The frequency response graphs are especially helpful to understand the action of these 
complex filters since the control functions are slightly different for each filter.

Dual EQ Morph

This is a programmable 2-frame Morphing filter with two EQ sections. As the Morph 
value is increased, the filter interpolates from the low to high settings. The Gain of each 
section remains constant during the Morph, but can be scaled at note-on time by 
controlling the Initial Gain parameter.

This filter can be used to create your own vocal formant filters.
(Try the settings shown and modulate with the + filter envelope or +LFO.)

Frequency
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Low EQ 2

Dual EQ &
2EQ Morph

Filters

As the Morph value is increased, the filter interpolates from the Low to High Frequency settings.
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2EQ Morph + Expression

This filter also has two EQ sections and a lowpass filter with independent control over 
the lowpass filter frequency (Expression). This allows you to use velocity (for example) 
to control expressive timbre via the lowpass filter, while the Morph parameter is 
modulated for another effect. As the Morph value is increased, the filter interpolates 
from the low to high settings. The gain parameter for each EQ section stays constant 
during the morph.

E Morph = Filt. Freq.
Express’n = Filt. Res.
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2EQ + Lowpass Morph

This unusual filter has two EQ sections and a lowpass filter whose Fc is also controlled 
by the Morph parameter. The Lowpass filter is completely open at a setting of 255. As 
the Morph value is increased, the filter interpolates from the low to high settings and the 
lowpass filter allows more high frequencies to pass. The Q of the lowpass filter has an 
initial setting and can be also modulated realtime using the Filter Resonance parameter. 
The gain parameter for each EQ section stays constant during the morph.

Peak/Shelf Morph

This 2-frame morphing filter offers independent control over frequency, shelving and 
peak for each of the two filter “frames”. The Peak parameter can also be modulated in 
realtime by controlling the Filter Resonance parameter.

When the Shelf parameter is negative, the filter will have a low shelving response. When 
the Shelf parameter is positive, the filter will assume a high shelving response. With 
Shelf at zero, the filter assumes a peak filter response.

Note that the three controls of the two morphing frames are grouped in this filter and 
all three controls are morphed.

E FC/Morph = Filt. Freq.
LPF Q = Filt. Res.

E Morph = Filt. Freq.
Peak = Filt. Resonance
E-MU Systems 81



6 - Voice Editor / Synthesizer Level
Amplifier Controls
Amplifier Controls

These parameters set the overall volume and pan settings, as well as the output channels 
for the selected voice(s).

Volume
Sets the initial volume of the voice from -96 dB (off) to +10 dB. This is the same volume 
control as shown on the Mix/Tune tab of Voices & Zones (page 53).

Lower the volume of the Amplifier when modulating Amp Volume. (You won’t hear any 
modulation if the volume is already turned all the way up.)

The default setting is 0 dB which allows a bit of headroom so that other modulators can 
be added in without clipping. Use this volume control to balance the voice output 
against others. If you hear clipping, reduce volume setting.

Pan
Sets the initial stereo pan position of the voice. Subsequent modulation is added to or 
subtracted from this value. This is the same pan control as shown on the Mix/Tune tab 
of Voices & Zones (page 53).

Amp Envelope Dynamic Range
Sets the maximum amount of attenuation from the amplifier envelope generator. 
Variable from -96 dB to -48 dB. With longer attack times, reducing the envelope depth 
(towards -48 dB) may provide a more natural-sounding volume envelope.

Response
Selects between the “Classic” amplitude response and “Emulator X” response. Choose 
Classic response if you’re authoring for hardware Emulators and Emulator X response if 
you’re creating sounds for the Emulator X.
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Voice Effect Sends
Each voice has one Main Output level control and three Aux Send level controls. The 
Main outputs from all voices in the preset are summed into the channel’s main stereo 
output. All the Aux Sends 1-3 from all voices and channels are summed into stereo Aux 
Outputs 1-3, located on the Multisetup page. See page 41.

Each channel’s Main Output and the sum of all Aux 1-3 Outputs are assigned to Direct-
Sound or ASIO stereo channels in the Multisetup page. Channels are available to your 
audio output device or other computer applications such as plug-in effects.

The Aux Enable button to the right of each channel main output allows you to turn the 
Aux Sends on or off for that channel so you can hear the channel with or without effects.

The Voice Effect Send levels can also be controlled using the voice modulation cords. 
See “Send Aux 1-3” on page 86.

Main & Aux 
Sends

(Voice Processing)

Main & Aux
Returns

(Multisetup)

Aux Enable
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Modulation Cords
Each voice contains 36 Cords which are used to route modulation sources to destina-
tions and control the amount of modulation. There are only three permanently 
connected modulation connections: amp envelope-to-amplifier, pitch wheel-to-pitch, 
and key-to-pitch. All other modulation routings must be connected with a Cord.

Modulation Sources

Source Description

Crossfade Random Generates the same random value for all voices in a preset. This 
source is intended to be used for crossfading voices.

Key (+, ~) Key Tracking - This value increases as you play up the keyboard.

Velocity (+, ~, -) Key Velocity - This value increases as the key is played harder.

Release Velocity This value increases the slower you release the key

Gate This value goes to full value as long as a key is depressed.

Pitch Wheel MIDI data from your keyboard’s pitch bender.

Cord 
Sources

Cord
Destinations

Modulation Amounts

Cord Page Select Buttons

Modulation
Source

LFO 1

Destination
Amount +/-

Amp
Volume

- +

Tremolo is created by routing an LFO to the Amp Volume using a Cord.
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Mod Wheel MIDI data from your keyboard’s modulation wheel or lever.

Pressure Aftertouch MIDI data (channel pressure)

Pedal Footpedal MIDI data (normally controller #4)

MIDI A - P 16 assignable MIDI continuous controllers See page 12.

Footswitch 1 & 2 MIDI footswitch data (normally controllers 64 & 65)

F-F Footswitch 1&2 MIDI footswitch inputs which latch on or off with each press.

MIDI Volume MIDI Continuous Controller data on channel #7

MIDI Pan MIDI Continuous Controller data on channel #10

Key Glide A smoothly changing control source based on the Glide Rate and the 
interval between the last two notes played.

Amp Envelope Amplifier Envelope Generator (+, ~, -) See page 87.

Filter Envelope Filter Envelope Generator (+, ~, -) See page 87.

Aux Envelope Auxiliary Envelope Generator (+, ~, -) See page 87.

LFO 1 & 2 (+, ~) Low Frequency Oscillators 1 & 2

White Noise A continuously varying random control source for effects

Pink Noise A lower frequency random control source.

KRandom 1 & 2 These sources generate different random values for each voice. The 
values are chosen at key-on time and remain constant.

Lag 0 & 1 in Lag Processors can also be used as summing amps. See page 90.

Lag Processor 1&2 Lag processors slow down rapid changes. See page 90.

Channel Lags 1&2 Lag processors that operate at the channel level. See page 50.

Channel Ramp Slope generator that is triggered by the first key pressed. See page 52.

Poly Key Timer Outputs a value based on the time a key is held down. See page 51.

Clock Divisors MIDI clock is divided to the specified value and used as a
modulation source. See page 132.

DC Offset A fixed value that can be scaled by the Cord to offset a value. 

Summing Amp The Summing Amp is useful for mixing several modulation signals so 
they can be controlled from a single Cord amount. See page 135.

Switch The switch outputs full value (100) when the input is greater than 0. 
(This value can be scaled by a Cord.) See page 135.

Absolute Value This processor inverts negative values and leaves positive values 
untouched so that only positive values are output. See page 135.

Diode This processor allows only positive values to pass.
Negative values are blocked. See page 135.

Flip-Flop The output of this processor alternates between full value and zero 
each time the input goes positive from zero or a negative value. If an 
LFO were connected to the input, the output would be a square 
wave of half the input frequency. See page 135.

Quantizer Smoothly changing signals are transformed into discrete steps. The 
value of the input Cord determines the number of steps. The value of 
the output Cord determines the size of the steps. See page 135.
(Hint: Gain 4x can increase number of steps or step size.) 

Gain 4x This processor amplifies the modulation input by a factor of 4.

Modulation Sources

Source Description
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Modulation Destinations

Destination Description

Key Sustain Holds the envelope generators at the sustain point as long as this 
value is above zero.

Fine Pitch Fine pitch modulation with a maximum range of 1 semitone.

Pitch Full range pitch modulation.

Glide Controls the portamento (glide) time.

Chorus Amount Controls the amount of voice chorus (doubling).

Chorus Position ITD Controls the Inter-aural Time Delay of voice chorus. See page 90.

Sample Start Controls the sample start offset point. See page 72.

Sample Loop Controls the sample loop length. See page 90.

Sample Retrigger A negative-going, zero-crossing value retriggers the sample from the 
sample start.

Filter Frequency Controls the frequency (or morph) of the filter.

Realtime Resonance Realtime control of filter resonance (Q, gain, body size).

‘Filter Resonance Filter resonance is set at note-on time only.

Amp Volume Controls the volume of the voice.

Amp Pan Controls the left/right positioning of the voice.

Amp Crossfade Controls the RT crossfade of voices so programmed. See page 90.

Send Main Controls the level of the voice sent to the Main output.

Send Aux 1-3 Controls the level of the voice sent to the Aux Send 1, 2 or 3 outputs.

Amp Envelope Rates Positive values decrease the rates of all amp envelope stages.

Amp Env. Attack Positive values decrease the attack rate of the amp envelope.

Amp Env. Decay Positive values decrease the decay rate of the amp envelope.

Amp Env. Release Positive values decrease the release rate of the amp envelope.

Filter Envelope Rates Positive values decrease the rates of all filter envelope stages.

Filt Env Atk, Dcy, Rel Same as for Amplifier. See above.

Filter Env. Trigger A positive-going, zero-crossing value retriggers the envelope. 

Aux. Envelope Rates Positive values decrease the rates of all Aux. envelope stages.

Aux Env Atk, Dcy, Rel Same as for Amplifier. See above.

Aux Env. Trigger A positive-going, zero-crossing value retriggers the envelope. 

LFO Rate (1 & 2) Positive values increase the LFO rate.

LFO Trigger (1 & 2) A negative-going, zero-crossing value resets the LFO to zero.

Lag Processor (0&1) Inputs for Lag Processors 0 & 1. See page 90.

Summing Amp Input to the Summing Amp. See page 135.

Switch Input to the Switch processor. See page 135.

Absolute Value Input to the Absolute Value processor. See page 135.

Diode Input to the Diode processor. See page 135.

Flip-Flop Input to the Flip-Flop processor. See page 135.

Quantizer Input to the Quantizer. See page 135.

Gain 4x Input to the 4x Amplifier. See page 135.

Cord 1 - 36 Amount Controls the amount of PatchCords 1-36.
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Modulation Source Polarity
On a few of the modulation sources you’ll see the following suffixes: +, ~,<. These 
designate the polarity of the modulation source. A plus (+) means that the source goes 
from zero to maximum value. The (~) symbol indicates that the source is bidirectional. 
In the case of an LFO, the LFO would go both positive and negative, centering on the 
zero line. The (<) symbol indicates that the source only subtracts from the initial value 
of a destination. This type of control is designed to be used for velocity-to-volume 
control where you want to keep as much headroom as possible. The following chart 
shows the three types of polarity.

Summing Nodes
All the modulation inputs on Emulator X are summing nodes. This means that you can 
connect as many modulation sources as you want to an input (such as Pitch or AmpVol). 
Modulation sources are simply added algebraically — connecting two knobs one set to -
100 and the other set to +100 yields a net value of zero.

PatchCord Lore

• Real-time events happen first on lower numbered Cords, so it is usually a good 
idea to put important functions on lower numbered cords and to place compo-
nents of complex modulations patches in the proper order in the Cords section. 

• Negative Cord amounts invert envelopes and LFO waveforms.

• To invert the effect of a controller knob, set its Cord to -100 and add DC with a 
Cord value of +100.

+
~

+ modulation ADDS to the
    initial value. (Normal)

< modulation SUBTRACTS
    from the initial value

~ centers around Zero.
    (Use for LFOs, Filt. Freq.)

Control
Value

Control Value Applied

0 12763

0 12763

-63 +640

-127 0-63
<
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LFO 1 & 2
A Low Frequency Oscillator or LFO is 
simply a wave which repeats at a slow rate. 
LFOs are used to add animation to a sound. 
Emulator X has two multi-wave LFOs for 
each voice, with 17 different waveforms 
which are diagrammed below.

By examining the diagram of the LFO 
waveforms, you can see how the LFO will 
affect a modulation destination. Suppose 
we are modulating the pitch of an 
instrument. The sine wave looks smooth, 
and will smoothly change the pitch. The 
square wave changes abruptly, and will 
abruptly change the pitch from one pitch to 
another.

Note: References to musical intervals in the pattern LFO shapes are with the LFO routed 
to pitch and a PatchCord amount of +38.

Delay
Sets the amount of time between playing a key and the onset of modulation. This can be 
used to simulate an effect often used by acoustic instrument players, where the vibrato is 
brought in only after the initial note pitch has been established. The delay range is 
adjustable from 0 seconds to 20 seconds.

Shape
Sets the LFO waveshape which determines the effect of the LFO. There are 16 LFO 
waveforms and a random, sample & hold type of wave which outputs random levels at 
the LFO rate.

Tr iangle

Square

Sine 1,2 S ine 1,3,5

SineSawtooth

33% Pulse

12% Pulse
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Variation
Sets the amount of random variation on an LFO each time a key is pressed, which is 
useful for ensemble effects, where each note played has a slightly different modulation 
rate. The higher the number, the greater the note to note variation in the LFO rate.

Sync
Key Sync or Free Running. With key sync selected, the LFO wave starts at the beginning 
of its cycle at each key depression. With Key Sync off, the LFO wave begins at a random 
point in its cycle on each key depression.

BPM
E The master tempo can 
be set internally using the 
tempo control in the 
Multisetup window, or 
controlled from an 
external MIDI clock. 
Internal/External clock 
selection is located in the 
Preferences dialog box.

The BPM button allows the  LFO rate to be controlled by the Master Tempo (located in 
the Multisetup window).  The Master Tempo can also be derived from an external MIDI 
clock to synchronize the envelope times with external sequencer or arpeggiator tempo 
changes. The chart below lists all the displayed musical note divisions when the LFO is 
set to BPM. The “Master Tempo Clock Pulses” column shows the exact number of clocks 
used by each note division based on the MIDI standard of 24 pules per quarter note. 
The LFO cycle will last for the exact note division shown. 

BPM Tempo Rates
(based on Master Tempo) Displayed Note Division Master Tempo Clock 

Pulses

octal whole note  (double long) 8/1 768

dotted quad whole note 4/1d 576

octal whole note triplet 8/1t 512

quad whole note (long) 4/1 384

dotted double whole note 2/1d 288

quad whole note triplet 4/1t 256

double whole note (breve) 2/1 192

dotted whole note 1/1d 144

double whole note triplet 2/1t 128

whole note 1/1 96

dotted half note 1/2d 72

whole note triplet 1/1t 64

half note 1/2 48

dotted quarter note 1/4d 36

half note triplet 1/2t 32

quarter note 1/4 24

dotted 8th note 1/8d 18

quarter note triplet 1/4t 16

8th note 1/8 12

dotted 16th note 1/16d 9

8th note triplet 1/8t 8

16th note 1/16 6

dotted 32nd note 1/32d 4.5

16th note triplet 1/16t 4

32nd note 1/32 3
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Modulation Cords
LFO Tricks & Tips:

Lag Processors 1 & 2
Lag processors can be inserted in a modulation patch to inhibit 
rapid changes in the modulation source or cause it to lag behind 
the input. The amount (rate) of lag is adjustable from 0 to 10. A 
setting of O will cause the least amount of lag. 10 is the slowest lag.
     

The Lag Processors can also be used as 2 additional 
summing amps. Summing amps are used to add several 
modulation sources together so the output can be controlled 
by a single Cord Amount. The output of Lag0in and Lag1 
modulation sources are equal to the sum of any cords 
connected to the Lag in destinations. The summing node is 
located before the lag processor as shown in the diagram.

Sample Loop Modulation
Although there is no initial control, the sample loop position can be modulated using a 
Cord. See “Modulation Destinations” on page 86. The loop length remains constant as 
the loop is modulated. This feature can be used to implement pulse width modulation, 
and other wavetable scanning synthesis techniques.

The Random LFO wave is truly random and is different for each voice and layer. 

The Pattern (Pat) waveforms will sound the same on different layers and voices.

When the PatchCord amount for an LFO is a negative value, the LFO shape will be inverted. 
(A rising sawtooth turns into falling sawtooth.)

Sine + Noise is very useful for simulating trumpet and flute vibrato.

When routing Hemi-quaver to Pitch… 
+38 = major scale                           -38 = phrygian scale
+76 = whole tone scale                (+38) + (+76) = diminished scale (two cords)
odd amount = S+H sound.

Try combining the Pattern LFOs, or controlling the amount of one with another, or combining 
them with the clock divisors.

Lag
Processor

Foot
Switch

LFO

Cord Cord
Lag Slows

Rapid Change
of FootswitchSwitch

Instantly On

LFO Gradually
Speeds Up

Lag processors are used to slow down and smooth rapid changes in 
control signals. In the example above, the instantaneous switch change 
becomes a smooth transition.

Lag

Sum Node

Lag 0 in

Lag 0
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Modulation Cords
Assign Group
This function allows you to assign a certain number of output channels to each voice. By 
assigning all voices in the preset to assign groups, important parts can be protected from 
being “stolen” by more recently played keys. Or, a voice such as an open high hat can be 
assigned to a mono channel so it will be cancelled by a closed high hat. Voices will 
rotate within their assigned bin of channels not interfering with other bins. Poly All is 
the default mode.

The modes are as follows.

Poly All
Notes are played polyphonically with dynamic channel assignment, using 
all 128 channels.

Poly 16 A-B
Two bins of 16 channels each. Notes are played polyphonically with 
dynamic channel assignment, using no more than 16 channels.

Poly 8 A-D
Four bins of 8 channels each. Notes are played polyphonically with 
dynamic channel assignment, but using no more than 8 channels.

Poly 4 A-D
Four bins of 4 channels each. Notes are played polyphonically with 
dynamic channel assignment, but using no more than 4 channels.

Poly 2 A-D
Four bins of 2 channels each. Notes are played polyphonically with 
dynamic channel assignment, but using no more than 2 channels.

Mono A-I
Nine monophonic channels. Any voices assigned to the same letter inter-
rupt each other, but does not affect other voices.

S E

S E

By modulating the loop over a single cycle of a square wave, it can be “pulse 
width modulated.” Other, more complex waveshapes can also modulated in 
this way.
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Modulation Cords
Keyboard Modes
The Keyboard mode control how the voice will be triggered from the keyboard. Poly 
Normal mode is the default mode which allows you to play chords.

The eight different solo modes provide the playing action of a monophonic 
instrument—only one note can be played at a time. Monophonic wind, brass and string 
instruments often sound more realistic with a single note playing. Synthesizer lead lines 
also require solo mode. There are solo modes provided which can be used with 
monophonic synthesizer sounds or to create other performance effects.

The Release modes only triggers a voice when the key is released. Many acoustic instru-
ments, such as a harpsichord, generate sounds when a key is released. To use this 
feature, create a special “Release Voice” and turn one of these modes on for that voice. 

Poly Normal Standard polyphonic mode. Any number of notes can be played.

Multiple Trigger
Last note priority. No key-up action. Retriggers envelopes and samples 
when a key is pressed.

Melody (last)

Last note priority. No key-up action.
First solo note: Envelopes start at Attack segment from zero. Samples 
start at the beginning.
If previous note is releasing: Envelopes start at Attack segment, but 
from current level. Samples start at the beginning.
When playing “Legato”: Envelopes continue from current segment 
and level. Samples start at the loop or the beginning if unlooped.

Melody (low)
Same as Melody (last), but with low-note priority. Newly played keys 
which are higher than the lowest solo key held will not sound.

Melody (high)
Same as Melody (last), but with high-note priority. Newly played keys 
which are lower than the highest solo key held will not sound.

Synth (last)
Similar to Melody (last) with key-up action. When currently sounding solo 
key is released while still holding other keys, the highest held solo key 
sounds in a Legato fashion (envelopes not retriggered).

Synth (low)
Same as Synth (last), but with low note priority. When the currently 
sounding solo key is released when other keys are still held, the lowest 
held solo key will sound in a Legato fashion. (MiniMoog).

Synth (high)
Same as Synth (last), but with high-note priority. When the currently 
sounding solo key is released when other keys are still held, the highest 
held solo key will sound in a Legato fashion.

Fingered Glide
Same as Synth (last), except that Glide is disabled when playing Staccato, 
enabled when playing Legato.

Poly Release Trig 
Release Vel

Polyphonic action, but the voice triggers only when the key is released. 
The key velocity is determined by how fast the key is released.

Poly Release Trig 
Note-on Vel

Polyphonic action, but the voice triggers only when the key is released. 
The key velocity is determined by how fast the key is pressed

Solo Release Trig 
Release Vel

Monophonic action, but the voice triggers only when the key is released. 
The key velocity is determined by how fast the key is released

Solo Release Trig 
Note-on Vel

Monophonic action, but the voice triggers only when the key is released. 
The key velocity is determined by how fast the key is pressed
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Modulation Cords
Latch Mode
� Caution: Using Latch 
Modes together with the 
Solo Modes may cause 
unpredictable results.

When Latch mode is On, pressing a key once will latch the key on. Pressing the key 
again will unlatch the key. This mode was originally designed for doing sound effects 
work, but you can probably find many other uses for it, such as latching sampled 
grooves. Any voices assigned to the same key as a latched voice will also latch.
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7 - Editing a Sample
Sample Editor Window
7 - Editing a Sample

Sample Editor Window
The Sample Editor allows you to modify the actual sample data in order to perform 
functions such as: sample looping, sample truncation and splicing, equalization, time 
compression, sample rate conversion and many others. In the Sample Editor module we 
are working with the most basic element of the Emulator hierarchy, the sample. It is 
important to note that every one of these functions except basic looping modifies the 
sample data. 

Even though you can undo these operations, it’s a good idea to make a copy of the 
sample before modifying the original if you want to keep an original version of the 
sample.

� To Get to the Sample Editor Window:

• Click on any sample in the tree to view that sample in the Sample Editor window. 
A stereo sample is shown above.

• Double-click on any sample in the “Voices and Sample Zones” window.

• You can also select samples by double-clicking on the sample name in the voice 
editor, or by selecting a sample and choosing “Open Sample” from the Preset 
window.

Selection Area Loop Markers
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7 - Editing a Sample
Zoom Tools
� To Select an Area of the Sample for Editing:

1. Click anywhere on the sample display to place the cursor.

2. Click and drag the cursor to select an area of the sample for processing.

3. Or... press and hold the shift key after placing the cursor, then click again on the 
waveform to select the area between the two mouse clicks.

Zoom Tools

Zoom In (Horizontal)
Magnifies the horizontal scaling to show more detail in the waveform. You can also use 
the Zoom controls in the lower right corner of the waveform display to increase or 
decrease horizontal resolution.

Zoom Out (Horizontal)
Reduces the horizontal scaling to show less detail but more of the entire waveform.

Zoom In (Vertical)
Magnifies the displayed height of the waveform to show more detail.

Zoom Out (Vertical)
Reduces the displayed height of the waveform.

Zoom To Selection
Automatically scales the display so that the selected area is visible.

Zoom To All
Automatically scales the display so that the entire waveform is visible.

Exporting & Importing Samples
The Export function allows samples in the bank to be exported as .wav or .aiff files. 
Samples can be imported using the import option in the File menu (page 153). You can 
also simply drop a Wave or AIFF file over the Emulator X icon.

� To Export a Sample

� To Import a Sample

• Right-click any sample in the Tree or List views.

• Select a sample, then select Export from the Sample Edit menu.

• Select Import Samples from the File menu.

• Drop a  .wave or .aiff file over the Emulator X icon.

Zoom In
(Horizontal)

Zoom Out
(Horizontal)

Zoom In
(Vertical)

Zoom Out
(Vertical)

Zoom
to All

Zoom to 
Selection
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7 - Editing a Sample
Changing the Display Units
Changing the Display Units
Right-click in the vertical or horizontal units area of the waveform display and a popup 
selection box appears allowing you to select different units of measurement.

Vertical Units

Horizontal Units

Transport/Loop Controls

Play
The sample plays from the cursor location and continues to play between the loop 
markers. This button latches on until the Stop button or Space bar is pressed. Press and 
hold the space bar to play the sample from the keyboard.

Play from Start
The sound plays from the start of the sample regardless of the cursor position.

Stop
Stops playback immediately. Press the Space bar to stop the sample from the keyboard.

Loop Play
Plays the sample repeatedly between the cursor line and the end of the sample when the 
Play button is pressed. See “How to Loop a Sample” on page 116.

• Percent Units are expressed in percentages with 100% equal to 
full code and 0% as the baseline.

• Decimal Units are expressed in decimal form with 1.0 equal to full 
code and 0 as the baseline.

• dB Units are expressed in decibels (headroom) with 0.0 
equal to full code and infinite as the baseline.

• Samples Units are expressed in samples beginning from the start 
of the sample.

• Seconds Units are expressed in seconds beginning from the start 
of the sample.

• Loop Start Sets the Loop Start point to the current mouse position.

• Loop End Sets the Loop End point to the current mouse position.

Play

Play 
from Start

Stop

Loop 
Play 

Go to 
Sample Start

Go to 
Sample End

Go to 
Loop Start

Go to 
Loop End

Go to Beginning 
of Selection

Go to End 
of Selection
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7 - Editing a Sample
Transport/Loop Controls
Go to Sample Start
Positions the cursor at the start of the sample.

Go to Sample End
Positions the cursor at the end of the sample.

Go to Loop Start 
Positions the cursor at the loop start point.

Go to Loop End
Positions the cursor at the loop end position.

Move Start to Previous Zero
Moves the Loop Start Marker toward the beginning of the sample to the next zero-
crossing point.

Move Start to Next Zero
Moves the Loop Start Marker toward the end of the sample to the next zero-crossing 
point.

Move End to Previous Zero
Moves the Loop End Marker toward the beginning of the sample to the next zero-
crossing point.

Move End to Previous/Next Zero
Moves the Loop End Marker toward the end of the sample to the next zero-crossing 
point.

Autocorrelate Loop
The computer analyzes the waveform around the loop points you have specified and 
moves the start point to find a section of the wave that closely matches the section 
around the end point. Auto correlation can be use again and again, with the computer 
moving the analysis window slightly each time to zero in on the perfect loop.

For more information, see “How to Loop a Sample” on page 116.
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7 - Editing a Sample
Cut, Copy, Paste & Delete
Cut, Copy, Paste & Delete
Imagine a printout of a sample. Now imagine that you have a pair of scissors 
capable of cutting a piece out of that sample (or a copy of that piece if you don’t 
want to affect the original), as well as a clipboard to neatly hold the cut or copied 
piece. Now imagine that you can either perfectly insert the clipboard contents at 
any given point in any sample, or mix the clipboard contents in with any 
sample, starting at any designated point. The Emulator X can do all this, and all 
electronically. Auto Correlation and Crossfade functions are also provided for 
seamless transitions between the cut, copied, and pasted parts.

Undo and Redo
During all sample edit operations, the sample being processed will automatically 
be backed up and stored on the hard disk. If you do not like the results of the 
processing, you can call up the Undo function, and restore the original sample. 
(Ah, if only life itself were so simple.) Best of all, the processed sample will now 
be backed up. Thus, if you decide you liked the processed version better after all, 
you can actually undo the undo. (Redo.) There are 100 levels of Undo.

Typical Applications
Typical cut/copy/paste applications would be to splice the beginning of one 
sample to the end of another, or to mix two samples together to conserve 
memory. (Do this by copying an entire sample, then pasting it at the beginning of the 
second sample using the mix option.) You can splice an attack transient on to a 
synthesizer waveform loop. Another possibility is, flanging and chorusing. Paste 
(mix) a sample to itself, offset from the beginning by a few hundred samples or so 
to thicken up the sound.

CLIPBOARD DATA. The clipboard will retain
data until replaced by other data to be
copied, cut, or backed up. This occurs with
several operations where you want to be able
to undo an action that doesn't work. 
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Cut, Copy, Paste & Delete
Cut Section
The Cut function removes a section of a sample, and stores the cut portion in a 
special part of memory called the clipboard. Portions of a sample can be cut, 
copied, and pasted to other samples or placed into a new sample. Cut can also be 
used to simply remove a section of the waveform.

� To Cut a Section:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

f Press the Play button 
to hear the sample as you 
adjust the selection area.

2. Magnify the waveform as desired using the Zoom button below the display. Press 
the “Go To Start” or “Go To End” buttons to quickly jump to the beginning or the 
end of the sample.

3. Select the section of the sample you wish to cut. See page 96.

4. Select Cut from the Edit menu or Toolbar. The selected section will be removed 
from the sample and placed onto the clipboard.

5. Use the Undo function (Ctrl+Z) in the Edit menu to if you don’t like the results of 
the cut.

Copy Section
The Copy function allows you to duplicate a section of a sample, and store that 
duplicate in a special part of memory called the clipboard.

Result of Cut
Cut Region is

Placed on Clipboard

Copy
Start

Copy
End

Length of Sample

Copied Region is placed
on the Clipboard
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7 - Editing a Sample
Cut, Copy, Paste & Delete
� To Copy a Section:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

f Press the Play button 
to hear the sample as you 
adjust the selection area.

2. Magnify the waveform using the Zoom button below the display. Press the “Go To 
Start” or “Go To End” buttons to quickly jump to the beginning or the end of the 
sample.

3. Select the section of the sample you wish to copy. See page 96.

4. Select Copy from the Edit menu or Toolbar. The selected section will be duplicated 
and placed onto the clipboard.

5. Use the Undo function (Ctrl+Z) in the Edit menu to undo the copy process.

Paste Section
Paste takes the clipboard contents and either inserts them in a sample at a 
specified point, or mixes them with a sample starting at a specified point.

� To Paste a Section:
f Select Zero Crossings 
in the waveform by using 
the Control keys. See 
page 98 for details.

1. Magnify the waveform as needed using the Zoom function.

2. Place the cursor at the point where you want to paste the clipboard contents.

3. Select Paste from the Edit menu or Toolbar. The following dialog box appears.

Paste Offset

Destination Sample

The sample on the clipboard is pasted
into the break in the destination sample…

…or crossfaded in and out of the break in the destination sample.

Crossfade
Size

Mode: Insert
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7 - Editing a Sample
Cut, Copy, Paste & Delete
4. Choose the paste mode— Insert, Equal Power Mix or Linear Mix.

• Insert opens up a space in the sample into which the clipboard contents fit.

• Equal Power Mix and Linear Mix combine the clipboard contents with existing 
samples, starting at the point selected in step three. Normally, you will always use 
Equal Power. Use Linear Mix when the signals are very similar or when Equal 
Power causes a gain in amplitude.

5. If you choose Linear or Equal Power Mix, the Mix slider becomes active, giving you 
the option to select the level of the clipboard contents to be mixed. Select the 
crossfade length and type.

 Please refer to the following diagrams.

Cursor Location

This section will
be replaced

0.00 Sec. Crossfade

Paste Offset

Result

Destination Sample

Mode: Mix                             Source Amount: 100%

After the start point, a section of the destination is replaced with the clipboard 
contents.
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7 - Editing a Sample
Cut, Copy, Paste & Delete
6. Select OK to perform the Paste or Cancel to cancel the operation.

7. Use the Undo function (Ctrl+Z) in the Edit menu if you’re not happy with the 
results of the paste operation.

Crossfade Size

Mode: Crossfade Mix             Source Amount: 100%

The clipboard contents will be gradually mixed into the destination sample 
and will replace the destination when the fade reaches 100%.

Crossfade Size

Mode: Crossfade Mix               Source Amount: 50%

The clipboard contents will be gradually mixed into the destination sample 
and reach a maximum of 50-50 mix.
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Sample Edit Tools
Sample Edit Tools
The sample edit toolbar displays the most commonly used sample editing tools. These 
tools can also be accessed from the Sample menu under “Edit”. Select an area of the 
sample for processing using the mouse, then select the process you wish to perform.

Truncate
f  Truncate any silence 
off the beginning of your 
samples to avoid slow key 
response.

Truncation shortens a sample by keeping the selected area of the sample and 
trimming off the beginning and/or end. Truncation is most often used to remove 
unneeded portions of a sample, but it can also be used to change instrument character-
istics such as removing the attack from a plucked string note or isolating a particular 
section.

� To Truncate a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display. Press the “Go To 
Start” or “Go To End” buttons to quickly jump to the beginning or the end of the 
sample.

3. Select the area of the waveform you want to keep.

4. Press the Truncate button. Everything but the selected area will be discarded.

5. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Fade
Fade allows you to change the gain in a smooth curve lets you create an artificial decay 
on percussion samples where the original decay is absent, create an artificial fast attack 
(such as bowed violin with a slow attack), or clean up background noise when editing 
dialog.

� To Fade a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to fade. Press the Play button to hear the 
sample as you adjust the selection area.

4. Press the Fade button. The following dialog box appears.

Truncate
Normalize

Reverse

Swap L-R

Bit
Reduction

Fade Adjust 
Gain

DC Filter
Convert 

Mono-Stereo
Time 

Compress

Select
Loop

Select
All

Pitch 
Shift

Sample Rate 
Convert

Autocorrelate 
Loop

Loop
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Sample Edit Tools
5. The volume will fade between the selected (start & end) gain/attenuation amounts 
following the selected curve shape. Set the start and end amounts and curve.

6. If the sample is stereo you have the option to fade the right side only, left side only 
or both.

7. Select OK to perform the fade or Cancel to cancel the operation.

8. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Normalize
Normalize checks for the loudest peak in the selected section of the sample and raises 
the overall level of the section so that the loudest peak is at full level (0dB). 

Stereo samples are normalized so that the gain is increased equally for both channels 
until one channel’s highest peak reaches 100%. If you wish to normalize each side of a 
stereo sample separately, use the normalize option in the Adjust Gain tool.

� To Normalize a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will normalize the entire sample. In this case you don’t have to select a 
specific area.

Selecting a specific region of the sample to normalize is not recommended as this can create 
a sudden thump or pop at the selection point from the sudden gain increase.

3. Press the Normalize button. The amplitude of the sample will be increased to the 
optimum level.

4. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Exp 2Exp 3

Exp 1

Linear
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Attenuation Curves

Gain Curves
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Adjust Gain
Use this function raise or lower the level of the selected section of the sample from -96 
dB to +96 dB. There is also an option to normalize the section.

With a stereo file, you can choose to normalize each channel separately. This method 
boosts the volume differently on each channel without preserving the volume balance 
between the left and right channels.

� To Adjust the Gain of a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will adjust the gain of the entire sample. In this case you don’t have to 
select a specific area.

Selecting a specific region of the sample to gain change can create a sudden thump or pop at 
the selection point caused by the sudden gain increase or decrease. Use the Fade tool to grad-
ually change the gain of a sample section.

3. Press the Adjust Gain button. The following dialog box appears.

4. Select the amount of gain increase or decrease for the sample.

5. If the sample is stereo you have the option to change the gain of  the right side only, 
left side only or both. If you wish to Normalize the sample, check the normalize 
box. If the sample is stereo you have to option to normalize each channel separately.

6.  Select OK to perform the Gain Change or Cancel to cancel the operation.

7. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

DC Filter
The DSP function removes the DC component from a sample, centering the waveform 
around the zero axis.

� To DC Filter a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will DC filter the entire sample. In this case you don’t have to select a 
specific area.

Selecting a specific region of the sample to DC Filter is not recommended as this can create a 
sudden thump or pop at the selection point from the sudden change in the waveform.

3. Press the DC Filter button. The sample will be centered around the zero axis.

4. Use the Undo function in the Edit menu if you aren’t happy with the results.
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Reverse
Reverse flips the selected portion of the sample so it plays backwards.

� To Reverse a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display.

f Press the Play button 
to hear the sample as you 
adjust the selection area.

3. Select the area of the waveform you want to reverse.

4. If the sample is stereo you will be given the option to reverse the right side only, left 
side only or both.

5. Press the Reverse button. The selected section of the sample will be reversed.

6. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

Swap L-R Channels
Swaps sides of a stereo sample or moves a mono sample to the other side.

� To Swap the Left and Right Channels:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Usually, you will select the entire sample. In this case you don’t have to select a 
specific area. 

Selecting a specific region of the sample to Swap can create a sudden thump or pop at the 
selection point from a sudden gain increase or decrease.

3. Press the Swap L-R button. The left and right channels will be swapped.

4. Use the Undo function (Ctrl+Z) in the Edit menu if you are not happy with the 
results.

0 0

+ +

- -

DC Offset Present DC Offset Removed
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Bit Reduction
This DSP tool takes your pristine samples and transforms them into any bit resolution 
you select. Ever wonder what a 2-bit sample sounds like? Find out using the bit reducer. 
Bit values above eight will generally result in increased noise without much other 
audible difference.

After Bit Reduction, a sample will be stored as a 16-bit linear sample. This allows the 
tool to be used to convert 24-bit samples to 16-bits, with a resulting 1/2 reduction in 
disk storage (24-bit samples are stored on disk using 32-bits).

� To Reduce the Number of Bits in a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to Bit Reduce. Press the Play button to 
hear the sample as you adjust the selection area.

4. Press the Bit Reduction button. The following dialog box appears.

5. Select the number of bits you want.

6. Select OK to perform the Bit Reduction or Cancel to cancel the operation.

7. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results.

Time Compression
This DSP function allows you to change the length of a sample without changing the 
pitch. This can be extremely useful for fitting samples to the beat of a song or fitting 
dialog into a spot. Samples can be compressed or expanded in length from 50% to 
200% in steps of 1/10th of one percent. Stereo samples maintain phase accuracy when 
time compressed or expanded.

Large time compression ratios can produce undesirable artifacts in the sample. Stick 
with small ratios on critical audio parts. The artifacts produced by this processor can be 
used to create weird special effects. Try stretching-compressing-stretching-compressing, 
etc. if you want to really mess up a sample.

The tempo calculator makes it easy to change the tempo of sampled grooves.
Simply set the original tempo to the tempo of your groove, then adjust the ratio until 
the new tempo matches the desired tempo.

• Time Compression Ratios - 200%  =  Double the Length
  50%  =  Halve the Length

� To Time Compress a Sample:

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.
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2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to Time Compress. Press the Play button 
to hear the sample as you adjust the selection area.

4. Press the Time Compress button. The following dialog box appears.

5. Select the Time Compression/Expansion ratio. The calculator shows the original 
length and tempo as well as the new length and tempo after processing.

6. Choose the processing algorithm using the table below as a guide.

7. Select OK to perform the Time Compression/Expansion or Cancel to cancel the 
operation.

8. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results. You may have to try a couple of algorithms before you get the best quality.

The following table lists the algorithm choices.

deep Predominant deep bass (to 14 Hz)

bass Predominant bass (to 20 Hz)

mid-1 Average source material

mid-2 Average source material (high-mids)

high Source material with high frequencies 

tight Maintains time accuracy - Drum loops

broad Low bass energy but critical highs

broad-smooth Both high & low freq. - Smooth output

difficult Inharmonic or broadband material

noisy Non-pitched - Sound Effects, etc.

tight-smooth Rhythmic accuracy - Use small ratios

x-smooth Rhythmic accuracy - Use small ratios
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Pitch Change
Pitch Change offers three different ways to change the original pitch of a sample.

• Nudge Sample Rate - Changes the sample rate to vary the pitch. The higher the 
pitch, the lower the sample rate.

• Gosset-Smith Tuning - A high-quality, constant sample rate interpolation 
method.

• Constant Time - These algorithms change the pitch, without changing the length 
of the sample. Constant time pitch change may introduce unwanted artifacts into 
the sample, especially when large intervals are selected.

The maximum pitch change is ±1200 cents (100 cents = 1 semitone).

� To Change the Pitch of a Sample

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. Magnify the waveform using the Zoom button below the display if necessary.

3. Select the area of the waveform you want to Pitch Change. Press the Play button to 
hear the sample as you adjust the selection area.

4. Press the Pitch Change button. The following dialog box appears.

5. Select the Tuning change in cents.

6. Select the type of pitch change you want to perform: Nudge Sample Rate, Gosset-
Smith, or Constant Time. 

7. if you chose “Constant Time” pitch change, select one of the processing algorithms 
using the table below as a guide. 

8. Select OK to perform the Time Compression/Expansion or Cancel to cancel the 
operation.

9. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results. You may have to try a couple of algorithms before you get the best quality.
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The following table lists the algorithms for constant time pitch change.

Sample Rate Convert
Sample Rate Conversion digitally changes the sample rate from 8000 Hz to 100 kHz. 
Sample Rate Conversion can be used to match the sample rate for use in other applica-
tions or to decrease the memory size of a sample.

Sample Rate Conversion can also be used for exactly matching the sample rate to a 
multiple of the sound's frequency for perfect single cycle loops. Set the built-in sample 
calculator to the note you want to loop and it automatically calculates the number of 
samples in a single cycle loop. Next, adjust the sample rate until you get close to an 
integer value for the single cycle loop. Set the loop length to this value when you go to 
loop it.

� To Change the Sample Rate

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. You can only change the sample rate of the entire sample so there is no need to 
select a region.

3. Press the Sample Rate Convert button. The following dialog box appears.

4. Select the new sample rate. The sample’s new length is displayed.

deep Predominant deep bass (to 14 Hz)

bass Predominant bass (to 20 Hz)

mid-1 Average source material

mid-2 Average source material (high-mids)

high Source material with high frequencies 

tight Maintains time accuracy - Drum loops

broad Low bass energy but critical highs

broad-smooth Both high & low freq. - Smooth output

difficult Inharmonic or broadband material

noisy Non-pitched - Sound Effects, etc.

tight-smooth Rhythmic accuracy - Use small ratios

x-smooth Rhythmic accuracy - Use small ratios
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• If you want to create a single cycle loop, set the calculator’s Key field to match the 
pitch of the sample and adjust the new sample rate until you get an integer 
number. Use this value as the loop length when you loop the sample.

5. Select OK to perform Sample Rate Conversion or Cancel to cancel the operation.

6. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results.

Convert to Mono or Stereo
Converts a stereo sample to mono or a mono sample to stereo. Converting to stereo 
duplicates the sample on both sides and slightly detunes them.

� To Convert between Mono and Stereo

1. Click once on a sample icon in the Tree to select it for editing. The waveform 
display appears.

2. This function only operates on the entire sample so there is no need to select a 
region.

3. Press the Convert Mono-Stereo button. When converting mono to stereo, the 
sample is simply duplicated. When converting from stereo to mono, the following 
dialog box appears.

4. Adjust the mix of left and right signal in the new mono sample.

5. Select OK to perform the conversion or Cancel to cancel the operation.

6. Use the Undo function (Ctrl+Z) in the Edit menu if you aren’t happy with the 
results.
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Loop Processing
Looping is a technique that can extend a sound’s length indefinitely. It is based on the 
fact that many sounds start off with a complex attack transient, then settle down to a 
comparatively steady sound.

Listen carefully to a plucked guitar string. The first part of the sound consists of a 
complex mixture of pick noise and several harmonics; after awhile the string decays 
down to a pretty steady repetitive waveform. Since the latter part of the waveform is 
repetitive, you can mark off a loop of the repetitive section, and play that looped section 
for as long as the key is held down. After playing to the end of the loop, the sound 
jumps back to the beginning of the loop and play through the loop again. This process 
repeats until you release the key.

At
ta

ck

Su
sta

in

Loop
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Crossfade Looping
Crossfade Looping fades between the beginning and end of the loop so that as the end 
fades out, the beginning fades in. This virtually eliminates the clicks and pops that can 
occur with other types of looping. Sound data from around the loop start point is faded 
into the sound data around the loop end point so that the data at those loop points is 
identical.

The maximum allowable crossfade length is based on the distance from the start point 
of the sample. (Move the start point toward the end of the sample to allow a longer 
crossfade.) You can select linear crossfade or an equal power curve.

Truncate after Loop
Discards any information after the loop end point in order to conserve memory.

Loop Compression
The looped section of the sample can be compressed, which “evens out” any changes in 
amplitude. Changes in amplitude can cause “breathing” effects, thumping or clicks.

f Use larger crossfade 
loop sizes with complex 
sounds; shorter sizes 
when you simply want to 
mask a slight tick in the 
loop.

• Crossfade Size: (Crossfade Loop) This function smoothly crossfades between the 
waves on either side of the loop so that the waveform at the loop point is identical. 
Since Crossfade Looping alters the sound data, you may notice timbrel or amplitude 
variations. A size of 0.00 disables crossfade looping.

• Crossfade Type - Equal Power: This is a weighted crossfade that produces no 
apparent level shift, and is the commonly used mode.

• Crossfade Type - Linear: This provides a straight mathematical crossfade. Use 
linear mode with samples whose splice points are already close to optimum, 
such as a sample that has already been auto correlated.

Source Data faded in & out with this data

Loop Start Loop End

In the diagram above, a sine wave is crossfaded with silence to show the fade-in and 
fade-out. In an actual crossfade loop, both signals would be crossfaded together.

Amplitude Variations in Loop After Loop Compression
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Loop Settings
These controls allows you to turn looping On or Off, select whether the Loop in Release 
function is On or Off, or lock the loop length.

Loop Button
This button enables or disables looping. You’ll be happy to know that if you loop a 
sample and turn the loop off, the loop pointers remain exactly where you set them 
when the loop is turned back on (even after saving).

Loop in Release
With Loop in Release off, the sample stays in the loop as long as the key is held, and 
plays the sound data after the loop when the key is released. With Loop in Release on, 
the sample remains looping when the key is released.

Lock Button
The Lock button fixes the loop length at its current value. This is a handy feature when 
you have found the correct loop length and are looking for a better start point. The lock 
button is also very useful for creating groove loops and single cycle loops.

Select Loop
This tool automatically selects the region between the loop markers.

Select All
This tool automatically selects the entire sample.
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How to Loop a Sample
� Note: Some sounds 
truly cannot be 
seamlessly looped. 
Percussion sounds and 
ensembles are 
notoriously hard to loop. 

If you’re just learning, 
practice with an easy 
sound such as your voice 
saying “Ahh”.

Looping has gained a reputation for being something of a black art. In actuality, it's 
really not that difficult to loop most sounds, especially with all the looping tools 
provided by the Emulator X.

The Attack portion of the sound is the beginning portion of the waveform. The attack 
contains usually changing harmonics and is difficult to loop. To get a smooth sounding 
loop, move the loop start and end points into a portion of the wave where the sample 
looks and sounds repetitive and is steady in amplitude. Changes in amplitude between 
the loop start and end points will be heard as sharp clicks or pops. You don’t want this.

1. Select a sample from the Tree by double-clicking on the sample name or icon.  
The Sample Editor window appears. You can also select samples by double-clicking 
on the sample name in the voice editor, or by selecting a sample and choosing 
“Open Sample” from the Preset menu.

2. Press the Select Loop button to jump to any pre-exiting loop.

3. Magnify the waveform using the Zoom button to if necessary. Look for a region of 
the sample near the end where the wave looks repetitive.

Initial Settings

4. Place the Loop End marker near or at the end of the sample by dragging it into 
position. Position it at a zero crossing by holding the Right Control key and pressing 
the left or right arrow keys. (See page 98 for more information.)

f Looping is an art 
which takes a bit of 
practice to learn. Auto 
Correlate works best 
when you have already 
found a fairly good loop 
point by ear.

5. Use the Autocorrelate Loop (Ctrl + K) feature in the Sample Loop menu to get you 
into the ballpark.

Listen & Adjust the Start Point

6. Make sure Loop Play in the transport toolbar is turned off and select Play. The 
sample will play and continue playing within the loop boundaries.

7. While the sample is playing, slowly drag the Loop Start marker forward and back 
through the sample. Notice how the character and pitch of the sound changes. Try 
to match the pitch of the loop with the pitch of the sound. This will give you an idea 
of the proper loop length. Try to find a point where the loop sounds “smoother” 
with less “ticking”.

8. When you get just a soft “tick”, try holding the mouse over the increment and 
decrement buttons on the loop controls above the waveform display. This will move 
the loop one sample at a time.

9. Try Autocorrelation again. Autocorrelation only moves the Start point, so if it 
doesn’t find a good loop, move the Loop End point slightly and try it again.

Can’t find it?

10. Repeat step 7, moving the Loop End marker this time. Visually examine the end of 
the waveform and try to find an area that looks similar, then move the markers 
around in that area.
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� Crossfade Looping & Loop Compression
Use these tools when you have a loop that’s good, but not great. Since these tools work 
by changing the sample data, it’s best to use them only when necessary. Crossfade 
looping is a powerful tool in your arsenal, but like most things, it takes a bit of practice 
to master.

f Use a larger crossfade 
loop length with complex 
sounds and shorter 
lengths with when you 
just want to mask a slight 
tick in the loop.

1. With your loop points set as good as you can get them, select Loop Processing from 
the Sample Edit menu or from the toolbar. The following dialog box appears.

f  Move the start point 
toward the end of the 
sample to allow a longer 
crossfade.

2. The maximum allowable crossfade length is based on the distance from the start 
point of the sample. What length should you use? It all depends on the sound. 
Begin with a long crossfade and use the Undo function (Ctrl + Z) if you don’t like 
what you’re hearing. Choose Equal Power. Truncate after Loop — On.

3. If you get a nice timbrel crossfade but still have amplitude variations in the loop, 
turn Compress Loop On.

Zero Crossing
f The left arrow moves 
the loop marker toward 
the sample start.

The right arrow moves 
the marker toward the 
sample end.

The term zero crossing refers to the point at which the positive slope of a waveform 
passes through zero. When looping it’s sometimes useful to locate zero crossings in 
order to make glitch-free loops.

� To Move the Loop Markers to Zero Crossings

1. Hold the Left Ctrl key and press either the left or right Arrow keys to move the Loop 
Start Point. 

2. Hold the Right Ctrl key and press either the left or right Arrow keys to move the 
Loop End Point.
E-MU Systems 117



7 - Editing a Sample
Sample Edit Tools
118 Emulator X Operation Manual



8 - Controls
The Toolbars
8 - Controls

This chapter describes how to work the controls of the Emulator X. There are certain tips 
and tricks to learn in becoming a power user, and a good number of them are in this 
chapter.

The Toolbars
The toolbars are located just beneath the menu bar at the top of the window and one 
more at the very bottom of the window (the status toolbar). The toolbars provide handy 
single-click buttons for the most common operations. By holding the mouse pointer 
over the tool, a label will appear revealing the purpose of each tool.

The upper toolbars can be rearranged by simply clicking the Toolbar Handles (see 
below) and dragging them wherever you want.

The Status Toolbar is always located at the very bottom of the window and provides 
context sensitive information, such as the current MIDI channel, sample/preset name & 
number, as well as the number of samples currently playing.

Standard ToolsMenu Bar

Sample Zoom 
Tools

Sample Edit 
Tools

Toolbar 
Handles

CPU Usage

Basic
MIDI Channel

Sample Name
& Number

Number of
Samples Playing

Status Toolbar

Samples In RAM
Current Voice
& KYBD Range

Menu Toolbars
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Viewing and Hiding the Toolbars
Select Toolbars from the View menu to call up the Show/Hide Toolbar menu. Check the 
boxes of the toolbars you wish to view. “Flat Toolbars” changes the look of the toolbars.

Drag & Drop
You can use simple “Drag & Drop” operations for many Emulator X functions. For 
example, to a copy a vice to another preset, simply left-click on the voice icon, then drag 
it on top of another preset and release the mouse. To import WAVE or AIFF files, simply 
drop them onto the Emulator X icon. Page 173 provides a complete listing of the drag & 
drop functions.

Changing Settings

Entering Numeric Values
Numeric values are displayed in alphanumeric readouts with either an associated 
control knob or an up/down button adjoining the display. 

� Numeric values can be changed by:

� Move the Cursor from the Keyboard

� Select the Knob or Slider and then:

• Turning the knob (if there is one).

• Pressing the Up/Down keys when the cursor is over a field.

• Typing the desired value into the field.

• Press the Tab key to move the cursor to the next field.

• Press Shift+Tab to move the cursor to the previous field.

• Use the Left/Right keys to increment or decrement the value by 1.

• Use the Page Up & Page Down keys increment or decrement by 10.

• Use the Roller on a roller-type mouse to increment or decrement the value.

• Press the Home key to turn the control all the way down.

• Press the End key to turn the control all the way up.

• Press the 5 key in the numeric keypad to center the control.
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Adjusting Key Ranges & Fades
The Key map windows contain alphanumeric fields displaying the key ranges of samples 
and voices.

� Editing the Key Range using the Graphic Display:

� Editing the Key Range via the Alphanumeric Fields:

First place the cursor inside the alphanumeric field and then:

Selecting Voices using your MIDI Keyboard
Before you begin: Make sure “IntelliEdit,” in the MIDI Preferences, is set to the same 
MIDI port as your keyboard.

Press Ctrl+Alt +MIDI Key to select voices from the Voice Processing page. You'll see a 
MIDI icon appear in the status bar at the bottom of the window. 

The first note played selects all voices that overlap that key. The second note played, if it 
is different, selects all voices that overlap the range between the two notes played. 

If the same key is pressed repeatedly, and if there are multiple voices assigned to that 
note, the selection will cycle through the voices whose ranges overlap that key. 

You can see the selected range of keys displayed below the keyboard at the top of the 
Voice Processing window.

Voice Processing Graphic Keyboard Operation
The Voice Processing window has a small keyboard at the top. Clicking the keyboard 
will play the clicked note. The range bar below the keyboard shows the range of all 
selected voices. You can change the voice selection by simply dragging the ends of the 
bar.

• Click and drag the end points of the graphic display to set the high and low key range.

• Hold Ctrl, then click and drag the end points to move the fade range.

• Type in the desired value.

• Use the +/- keys to increment or decrement the value.

• Use the roller on a roller-type mouse to increment or decrement the value.

• Press and hold Ctrl, and press Alt. A small MIDI connector symbol appears at the bottom of 
the window.  Play your MIDI keyboard to set the key position.

Click & Drag
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Adjusting Envelopes
Envelope rates and levels can be adjusted using the knobs, numeric entry, or by simply 
dragging the break points to the desired positions. See also, “Amplifier, Filter & Auxiliary 
Envelopes” on page 73.

BPM Mode & Tempo
BPM mode allows the envelope times to follow the internal/MIDI clock rate. The master 
tempo is adjusted and displayed in the Multisetup page (page 41). This allows the 
synthesizer to adapt to the tempo of your music.

The tempo automatically syncs to an external MIDI clock if it is present in the system. If 
you have an external MIDI device generating MIDI clock, or if another application is 
generating MIDI clock, the tempo will automatically lock to the MIDI clock tempo. If 
nothing else in the system is generating MIDI clock, the internal clock will be used.

Cut, Copy & Paste
You can use cut, copy and paste commands for most Emulator X functions.

Page Uses

Sample Page • Cut, Copy and Paste samples between banks. 
• Rearrange the order of Samples in the list.

Voices & Zones • Cut, Copy and Paste voices between banks.
• Rearrange the order of voices in the list. 

Voice Processing • Cut, Copy and Paste synth module settings (such as envelopes, LFO, 
Cords) between voices in the bank. You can also copy Amp envelope 
settings to the Filter envelope, for example.
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Large Icons List

Small Icons DetailsShow Bank/Prog No.

Hide Object 
Numbers

Show Object 
Numbers Help

Toolbar View 
Selection
E-MU Systems 123



8 - Controls
View Menu
Main Display View
When in the Sample, Preset or Multisetup Tree, clicking on the sample or preset folder 
shows all the samples or presets in the bank in the large window. The View Menu 
provides several display options for samples, presets and multisetups. The view options 
are listed below:

Tree View
The Sample, Preset or Multisetup Tree items can also be viewed in several ways. The 
View Menu provides several display options for the tree. The view options are listed 
below:

Large Icons Displays large icons useful for smaller banks

Small Icons Displays small icons (shown above) useful for large banks

List Displays Presets and Samples in a list view format (in numerical order)

Details
Displays the ID Number, Bank-Program Number, and Category. Clicking on 
the Category button at the top of each column sorts the list by that category.

Show/Hide Object Numbers
Displays or hides the object number for the Sample, 
Preset or Multisetup.

Show Bank & Program Numbers Presets can be displayed in the tree with Object 
numbers (P003) or with Bank and Program numbers 
(002:003).

Category Buttons
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Cursor Keys
You can move quickly through the Tree using the Left-Right-Up-Down Cursor Keys. 
 

With the Presets folder selected as in the example above, pressing the right cursor will 
open the presets folder.

Pressing the Right Cursor key again opens the Preset.

The Left Cursor reverses the actions. The Up-Down Cursors move up and down within 
the list. The Enter key opens the item.

Find Items
When the cursor is positioned in a list such as the tree, you can locate specific presets or 
samples by simply typing the name. Typing the first letter of a name finds the first preset 
or sample beginning with that letter. Repeatedly typing the same letter finds the next 
item beginning with that letter, and so on.

When “Show Object Numbers” is selected, you can type the preset or sample number 
(preceded by the letter P or S) to locate items by number.

Refresh (F5)

Multisetups

My Song

Presets

Samples
Opens

Selected
Item

Closes
Selected

Item

Moves Down
in List

Moves Up
in List

Presets

Piano
Strings
Orches
Acoustic
Oohs
Clav

Opens
Selected
Folder

Presets

Piano
Voices and Zones

Links

Voice Processing

Strings
Orches
Acoustic
Oohs
Clav

Opens
the

Preset
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Sometimes the display does not reflect the state of the synthesizer or vice-versa. Pressing 
F5 or selecting Refresh from the View menu manually synchronizes the display and 
synth.

Context Sensitive Menus
The right mouse button brings up context-sensitive menus in many areas of the 
Emulator X. Simply right-click over the field or area to bring up the menu for that 
function. Please refer to page 171 for a complete listing of context-sensitive menus.

Undo/Redo
Almost every action you do with the Emulator X can be undone. You can undo up to 
100 actions. Select Undo or Redo from the Edit menu or press Ctrl+Z (Undo) or Ctrl+Y 
(Redo) from the keyboard.
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9 - Synthesizer Basics

This chapter contains background information on the various programming aspects of 
synthesizers.

If you are new to synthesizers and electronic music, you may need more background 
information than this manual provides. There are many books dedicated to synthesizer 
basics and MIDI available through your local music dealer. Magazines such as Keyboard 
and Electronic Musician, available at most newsstands, contain current information on 
the subject, as well as valuable programming tips. The internet is a also a rich source of 
information on this subject. Seek and you shall find.

Your initial involvement with the Emulator X will most likely consist of using the 
existing banks and presets. While our factory banks and presets are very good, there are 
probably some things you would like to change, perhaps the LFO speed, the filter 
setting, or the attack time. Eventually, you’ll want to make your own custom presets 
using complex modulation routings.

Editing Presets
It’s easy to create new presets by modifying existing presets. This is really the best way of 
getting acquainted with the Emulator X. If you don't like the results, simply reload the 
preset or bank and you'll be back to the original sound. Changes are not made 
permanent until you SAVE a bank. Therefore, you can experiment all you want with 
presets, voices and samples without worrying about losing a sound.

We encourage you to actually try out the different functions as you read about them. 
Hearing what a control actually does will remove a lot of the mystery associated with it.

The Emulator X contains an extensive modulation implementation using two multi-
wave LFO’s (Low Frequency Oscillators), three envelope generators, and the ability to 
respond to multiple MIDI performance controllers. You can simultaneously route any 
combination of these control sources to multiple destinations.

Modulation
Modulation means to dynamically change a parameter, whether it be the volume 
(amplitude modulation), the pitch (frequency modulation), or whatever. Turning the 
volume control on your home stereo rapidly back and forth would be an example of 
amplitude modulation. To modulate something we need a modulation source and a 
modulation destination. The source is your hand turning the knob, and the destination 
is the volume control. If we had a device that would automatically turn the volume 
control, we would also call that device a modulation source.
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Turning the volume control back and forth on your home stereo is an example of Amplitude 
Modulation.

The Emulator is designed so that for each of the variable parameters, such as the 
volume, there is an initial setting which can be changed by a modulation source. 
Therefore in the case of volume, we have an initial volume and we can change or 
modulate that volume with a modulation source. Positive modulation Adds to the initial 
amount. Negative modulation Subtracts from the initial amount.

Modulation Sources
The main modulation sources are Envelope Generators, Performance Controllers and 
Low Frequency Oscillators. In the previous example, an envelope generator could be 
routed to automatically turn the volume control as programmed by the envelope, or, a 
low frequency oscillator could be routed to turn the volume control up and down in a 
repeating fashion. The main mod sources are listed below.

Keyboard Key
Which key is pressed.

Key Velocity
How fast the key is pressed.

Release Velocity
How fast the key is released.

Gate
High if the key is pressed, low when the key is released.

Key Glide
A smoothly changing control source based on the Glide Rate and the interval between 
the last two notes played.

Pitch and Mod Wheels
Keyboard pitch bend and modulation wheels.

Keyboard Pressure (mono aftertouch)
Key Pressure applied after the key is initially pressed.

Pedal
A continuously variable pedal controller connected to your MIDI keyboard.

Volume
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Miscellaneous Controllers A -P
Any type of MIDI continuous controller data from your keyboard or other controller. 
MIDI continuous controller numbers are programmed in the Preferences dialog box 
(See page 12).

Low Frequency Oscillators (2 per voice)
Generate moving, repeating waves used to add interest and animation to the sound.

Envelope Generators (3 per voice)
Generate a programmable “contour” which changes over time when a key is pressed.

Noise & Random Generators
Generate spectrums of noise and random signals to be used for modulation.

T-switch and Footswitches
Change a parameter when a MIDI switch is pressed. MIDI footswitch numbers are 
programmed in the Preferences dialog box (See page 12).

Modulation Cords
You use a Cord to connect a modulation Source to a Destination. (Patchcord – a 
holdover from the days when modules of an analog synthesizer were connected 
together with physical cords. Nowadays, we still need a way to connect modules 
together, but the cords are in software.)

You can connect the modulation sources in almost any possible way to the modulation 
destinations. You can even modulate other modulators. Each cord also has an amount 
parameter which determines “how much” modulation is applied to the destination. The 
modulation amount can be positive or negative and will either add or subtract from the 
initial value.

To use a modulation cord, you must connect a modulation Source to a modulation 
Destination. Think of modulation cords as if you are connecting an actual cord. You 
must connect both ends of the cord for the connection to be made. There are 36 general 
purpose cords per voice.

Modulation
Source

LFO 1

Destination
Amount +/-

Amp
Volume

- +
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Envelope Generators
An envelope can be described as a “contour” which can be used to shape the sound in 
some way over time. There are three envelope generators per voice and all of them are 
the rate/level type.

f The EOS envelope 
generators are just like 
standard ADSR’s, except 
that they have two 
segments for each stage. 

To create a standard 
ADSR curve, set the 
“2” levels the same as the 
“1” levels and set all the 
“2” rates to 0.

This is how the rate/level envelopes work: When a key is pressed, envelope starts from 
zero and moves toward the Attack 1 Level at the Attack 1 Rate. As soon as it reaches this 
first stage, it immediately begins the Attack 2 phase and moves toward the Attack 2 level 
at the Attack 2 rate. As long as the key is still held, the envelope continues on through 
the Decay 1 and Decay 2 stages. If the key is still held when the envelope reaches the end 
of Decay 2, it simply stops there waiting for you to release the key. When you release the 
key, the envelope continues through its Release 1 and Release 2 stages, stopping at the 
end of the Release 2 stage. The rate/level envelopes give maximum flexibility to program 
both complex and simple envelopes.

The Amplifier Envelope generator controls the volume of the voice over time and has 6 
stages: Attack 1, Attack 2, Decay 1, Decay 2, Release 1 and Release 2. The Filter Envelope 
generator controls the filter morph and also has 6 stages. Unlike the amplifier envelope, 
however, the filter envelope has the ability to go negative as well as positive. There is 
also an Auxiliary Envelope generator which is a general purpose envelope. The auxiliary 
envelope is identical to the filter envelope and can go negative as well as positive. The 
time of each stage can be adjusted to create myriad envelope shapes, which in turn 
shape the sound over time.

f By routing the 
Auxiliary Envelope to 
control the pitch (Cords) 
you can easily hear the 
shape of the envelopes 
you are creating.

The way the volume of a sound changes over time determines how we perceive that 
sound. For example, a bell struck with a hammer is instantly at full volume, then slowly 
dies away. A bowed violin sound fades in more slowly and dies away slowly. Using the 
Amplifier Envelope, you can simulate different types of instrument volume envelopes by 
programming them appropriately.

Retriggering
The Filter and Auxiliary envelopes can be retriggered by an LFO or any other 
modulation source such as clock divisor. Patch the desired modulation source (using a 
positive value) to Filter Env Trigger or Aux Env Trigger. Envelopes are triggered on a 
positive-going edge.
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Low Frequency Oscillators (LFOs)
A Low Frequency Oscillator or LFO is simply a wave which repeats at a slow rate. The 
Emulator has two multi-wave LFOs for each channel. The LFO waveforms are shown in 
the following illustration.

E Try combining the 
Pattern LFOs, or 
controlling the amount of 
one with another, or 
combining them with the 
clock divisors.

By examining the diagram of the LFO waveforms, you can see how the LFO will affect a 
modulation destination. Suppose we are modulating the pitch of an instrument. The 
sine wave looks smooth, and will smoothly change the pitch. The square wave changes 
abruptly, and will abruptly change the pitch from one pitch to another. The sawtooth 
wave smoothly decreases, then abruptly changes back up. The sound’s pitch will follow 
the same course. Controlling the pitch of an instrument is an easy way to hear the effects 
of the LFO waves.

Like the Auxiliary Envelope, the LFOs can be routed to control any realtime functions 
such as Pitch, Filter, Panning, or Volume. A common use for the LFO is to control the 
pitch of the sound (LFO -> Pitch). This effect is called vibrato and is an important 
performance parameter. Many presets use this routing with the modulation wheel 
controlling “how much” LFO modulation is applied. Another common effect, Tremolo, 
is created by controlling the volume of a sound with the LFO (LFO -> Volume).

Another use for the LFOs might be to add a slight bit of animation to the sound 
by routing the LFO to control the filter. In this example, the LFO amount would 
be set low, for a subtle effect.
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When the amount of an LFO is a negative value, the LFO shape will be inverted. For 
example, inverting the sawtooth wave produces a wave that smoothly increases, then 
instantly resets down. Since the inverted sawtooth wave is now negative, adding DC 
with a cord amount of +100 will make it positive again. See page 136 for information 
on how to use a DC Cord.

Random Sources
Random modulation sources can be used when you want the timbre of the sound to be 
“animated” in a random or non-consistent manner.

Key Random 1 & 2 generate different random values for each voice which are selected at 
key-on time and do not change during the note.

The White & Pink Noise Generators produce varying random values. Both white and 
pink noise sources are low frequency noise designed for control purposes. Either noise 
source can be filtered even more by passing it through a lag processor.

The Crossfade Random function generates the same random value for all voices in a 
preset. This source is designed to be used for crossfading voices, although you may find 
other uses.

Clock Modulation
The  clock can also be used as a modulation source. It can be used to trigger the Filter or 
Auxiliary envelope generators, trigger sample start, synchronize the LFOs, or used 
directly as a square wave modulation source. Envelopes are triggered on the positive 
going edge of the clock. LFOs are triggered on the negative going edge.

E Envelopes are 
triggered on the positive 
going edge of the clock. 
LFOs are triggered on the 
negative going edge of 
the clock.

The Clock source is available in six divisions (double whole note, whole note, half note, 
quarter note, eighth note, sixteenth note). The different rates can be used separately or 
in conjunction to create complex “synchro-sonic” rhythm patterns.

Using MIDI clocks, the internal clock can also be synchronized with an external MIDI 
device such as a drum machine or sequencer.

E The tempo of the 
master clock is set from 
the Multisetup page.

Clocks are routed exactly like the other modulations sources using the Cords. The Cord 
Amount MUST be positive (+) for the clock to pass. By modulating the Cord Amount, 
the divided clocks can be routed around using realtime controllers or other modulation 
sources.

Syncing an LFO to the Clock
When an LFO is triggered by a clock, the LFO wave resets to zero every time the clock 
wave goes low. To sync an LFO to the clock, patch a clock divisor to the LFO Trigger 
(Trg) in the Cords screen.

If the LFO rate is close to the clock rate, the LFO will synchronize with the clock. If the 
two rates are far apart, the waveform of the LFO will be mildly or radically altered (as 
shown below).
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LFO Trigger causes the LFO to reset each time the clock waveform goes low.

The possibilities of clock modulation and retrigger are numerous and varied. A 
repeating six segment curve of any shape can be created by triggering the Filter or 
Auxiliary Envelope generators with the clock. A few other possibilities are listed below.

• Turn different voice layers on and off using different clock divisors.

• Create a global triangle LFO by routing the Clock through a Lag Processor. 

• Switch between Auxiliary and Filter Envelope retriggering using a slider or footswitch.

• Retrigger LFOs or Envelopes using noise or other LFOs to create random or semi random 
effects.

• Modulating the rate of triggered LFOs will alter the LFO waveform.

• Route multiple clocks with different divisors to the same destination (such as pitch) to create 
complex patterns. (Hint: Adjust the Cord Amounts.)

Clock

LFO Wave

Triggered LFO

Quarter
Note

Eighth
Note

Added together in
equal amounts produces…

Quarter
Note

8th
Note

16th
Note Added together in
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Modulation Destinations
The Cords section of the Preset Edit module is where you connect sources to destina-
tions. Each cord has an amount control associated with it to control how much 
modulation is applied.

The Cords screen and the diagram above show how modulation sources are connected 
to destinations. The modulation sources can control any of the destinations in the voice.

Note-on modulation sources, such as key, velocity and gate output a single value at 
note-on time. Realtime modulation sources such as LFOs, envelope generators and 
modulation wheels can be varied continuously.

The possible modulation routings are completely flexible as shown in the diagram 
above. Multiple sources can control the same destination, or a single source can control 
multiple destinations.
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Modulation Processors
Modulation processors are devices which can modify modulation sources such as LFOs 
and envelope generators before they are applied to a destination. The modulation 
processors allow you to create patches and do tricks which would not be possible 
otherwise. The following modulation processors are currently implemented:

SumDC

Switch
(above zero)

4x
Gain

Absolute
Value

Flip-Flopx y x y

Diode

Lag
Processor

Quantizer

# of
Steps

Size of
Steps

Summing Amp 
Allows you to add several 
modulation sources so the 
output can be controlled 
by a single Cord Amount.

Switch 
Outputs a full value (100) 
level whenever the input 
is greater than zero.  

Lag Processors
Slow down rapid changes 
in the input signal. The 
output "lags" behind the 
input. Rate is adjustable. 

Absolute Value 
Inverts negative values 
and leaves positive values 
untouched. Outputs only 
positive values.  

Diode
Blocks negative values 
and allows positive values 
to pass untouched.

Quantizer
With the input Cord set to 
100% the output is limited 
to 16 discrete steps.  

4x Gain 
This processor multiplies 
the input value by a factor 
of four. Used to amplify 
modulation sources.

Flip-Flop
Alternates between full 
value (100) and 0 each 
time the input goes 
positive through zero.  
E-MU Systems 135



9 - Synthesizer Basics
Modulation Processors
Modulation Processor Examples
This example routes the Pink Noise generator through one of the Lag Processors in 
order to derive a smooth random function. A smooth random wave is useful in small 
amounts to add a degree of natural variation to timbre when routed to filter cutoff. 
Normal pink noise is low pass filtered audio frequency noise with a 3 dB/octave slope to 
give equal energy per octave. Our pink noise is actually more like very low frequency 
filtered (mauve?) noise, but it is perfect for use as a random control source.

The Quantizer can generate interesting whole-tone scales when envelope generators or 
LFOs are routed to the input. The quantizer turns a smoothly changing input signal into 
a series of steps. By routing the output of the quantizer to Pitch and adjusting the cord 
amounts, you can control both the number of steps and the pitch interval of each step.

The input cord amount controls how many steps are generated. A sawtooth wave 
(LFO+) feeding the input, and the cord amount set to 100% generates sixteen steps. The 
output cord amount controls the size (or interval) of the steps.

f Experiment with this 
patch by connecting 
other sources and 
destinations to the 
quantizer.

This patch generates an ascending arpeggio every time you press a key. The block 
diagram of the patch is shown below. The patch is very straightforward except for the 
DC offset which was added in to bring the pitch down into tune. (Sometimes you have 
to fix a problem, but using the mod processors there's usually a way around it to achieve 
the desired result.)

You can probably start to see some of the possibilities (and there are many). Whenever 
you find yourself wishing for some esoteric type of control, take a minute and think if 
there is a way to achieve the desired result using the modulation processors.
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Dynamic Filters
Following is a block diagram of the signal path.

A Low Pass filter is a powerful synthesizer filter which can dramatically alter the sound 
of a sample.

To understand how a filter works, we need to understand what makes a sound wave. A 
sine wave is the simplest form of sound wave. Any waveform except a sine wave can be 
Any waveform can be analyzed as a mixture of sine waves.

One way to represent complex waveforms is to use a chart with frequency on one axis 
and amplitude on the other. Each vertical line of the chart represents one sine wave at a 
specific amplitude and frequency.

What is a Filter? 
Most samples are complex waves containing many sine waves of various amplitudes and 
frequencies. A filter is a device which allows us to remove certain components of a 
sound depending on its frequency. For example, a Low Pass Filter lets the low frequencies 
pass and removes only the high frequencies.
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A filter that lets only the high frequencies pass is called a high-pass filter.

A filter that only lets a certain band of frequencies pass is called a band-pass filter.
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A Notch Filter is just the opposite of a bandpass filter and is used to eliminate a narrow 
band of frequencies.

Another control found on traditional filters is called Q or resonance. A lowpass filter 
with a high Q would emphasize the frequencies around the cutoff frequency. The 
following chart shows how different amounts of Q affect the low pass filter response. In 
terms of sound, frequencies around the cutoff tend to “ring” with high Q settings. If the 
filter is slowly swept back and forth, with a high Q, various overtones are “picked out” 
of the sound and amplified as the resonant peak sweeps over them. Bells and gongs are 
real world examples of sounds which have a high Q.

Another characteristic of a filter is the number of poles it contains. Traditional synthe-
sizer filters were usually either 2-pole or 4-pole filters. The Emulator has a selectable 2, 4 
or 6-pole low pass filter. The number of poles in a filter describes the steepness of its 
slope. The more poles, the steeper the filter's slope and the stronger the filtering action. 
The tone controls on your home stereo are probably one-pole or two-pole filters. 
Parametric equalizers are usually either two-pole or three-pole filters. In terms of vintage 
synthesizers, Moog and ARP synthesizers used 4-pole filters. Oberheim and E-mu 
synthesizers were famous for their 2-pole filter sound.

Using a filter, we now have a way to control the harmonic content of a sampled sound. 
As it turns out, even a simple low pass filter can simulate the response of many natural 
sounds.

For example, when a piano string is struck by its hammer, there are initially a lot of high 
frequencies present. If the same note is played softer, there will be fewer of the high 
frequencies generated by the string. We can simulate this effect by routing keyboard 
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velocity to control the low pass filter. The result is expressive, natural control over the 
sound.

If an envelope generator is used to control the cutoff frequency of a filter, the frequency 
content can be varied dynamically over the course of the note. This can add animation 
to the sound as well as simulate the response of many natural instruments.

Parametric Filters
A more complex type of filter is called a parametric filter or Swept EQ. A parametric filter 
allows control over three basic parameters of the filter. The three parameters are: 
Frequency, Bandwidth, and Gain. The Frequency parameter allows you to select a range 
of frequencies to be boosted or cut, the Bandwidth parameter allows you to select the 
width of the range, and the Gain parameter either boosts or cuts the frequencies within 
the selected band by a specified amount. Frequencies not included in the selected band 
are left unaltered. This is different from a band pass filter which attenuates (reduces) 
frequencies outside the selected band.

Another parameter sometimes used on a parametric filter is Shelving. Shelving simply 
widens the passband so that it extends to the limit of the upper or lower frequency 
range.

The parametric filter is quite flexible. Any range of frequencies can be either amplified or 
attenuated. Several parametric sections are often cascaded in order to create complex 
filter response curves.

If four parametric filter sections were cascaded, it would be possible to create the 
following complex filter response.
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Many natural instruments have complex resonances which are based on their sound-
board or tube size. The resonance shown above would be impossible to create using a 
normal synthesizer filter.

The Z-Plane Filter
A Z-plane filter is a filter which can change its function over time. In a Z-plane filter, we 
start with two complex filter types and interpolate between them using a single 
parameter. Refer to the diagram on the following page.

The Z-plane filter has the unique ability to change its function over time.

Filters A and B represent two different complex filters or “frames”. By changing a single 
parameter, the Morph, many complex filter parameters can now be changed simulta-
neously. Following along the Morph axis you can see that the filter response smoothly 
interpolates between the two filters. This is the essence of the Z-plane filter. Through the 
use of interpolation, many complex parameters are condensed down into one 
manageable entity.

Consider, as an example, the human vocal tract, which is a type of complex filter or 
resonator. There are dozens of different muscles controlling the shape of the vocal tract. 
When speaking, however, we don't think of the muscles, we just remember how it feels 
to form the vowels. A vowel is really a configuration of many muscles, but we consider it 
a single object. In changing from one vowel to another, we don't need to consider the 
frequencies of the resonant peaks! You remember the shape of your mouth for each 
sound and interpolate between them.

This Z-plane filter sweep can be controlled by an envelope generator, an LFO, 
modulation wheels or pedals, keyboard velocity, key pressure, etc. In fact, any of the 
modulation sources can control the Z-plane filter.
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MIDI Channels & Real-time Controls
The MIDI real-time controllers may seem confusing at first, but they are really very 
simple once you understand them. You probably already know that there are 16 MIDI 
channels per MIDI cable. Each MIDI channel uses three basic types of messages; note 
on/off, preset changes, and continuous controller messages.Your MIDI keyboard, in 
addition to telling Emulator X which note was played, can also send aftertouch real-
time control information, which simply means control occurring in real-time or “live.” 
(You may be using a MIDI device other than a keyboard, but for simplicity's sake we'll 
presume that you are using a keyboard.) Real-time control sources include such things 
as controller knobs, pitch wheels or touchstrips, modulation wheels, control pedals and 
aftertouch. These are used to add more expression or control.

The front panel control knobs send out real-time controller information on separate 
continuous controller numbers. There is a set of 95 continuous controller numbers for 
each MIDI channel. Some continuous controllers, such as modulation wheel, volume, 
and pan have standardized numbers. For example, volume is usually sent on 
continuous controller #7. The front panel control knobs are programmed to specific 
MIDI controls.

Any MIDI controller can be routed to any modulation destination. First, you have to 
know which controller numbers your keyboard transmits. Most modern MIDI 
keyboards let you select a controller number for each control on the keyboard. For 
example, it may let you select a number from 0-31 for the data slider. The realtime 
controller numbers that the keyboard transmits must match the numbers Emulator X is 
receiving, otherwise nothing will happen when you move the controls.

Suppose you wanted to send the four data sliders on your master keyboard. Emulator X 
can handle up to 16 MIDI controllers (A-P) of your choosing. “MIDI A-P” are simply 
names for the internal connections that link external MIDI continuous controllers to 
the Cords page. There are two parts to the connection. First, MIDI controller numbers 
are assigned to the letters A-P in the Controllers dialog box. Next, the letters A-P are 
connected to synthesizer control parameters in the PatchCord section of the Preset Edit 
window. The Cord Amount scales the amount of each controller by a positive or 
negative value.

Most factory presets have the MIDI A-P controls connected to standard synthesizer 
functions (labelled in the Multisetup page). By choosing any four of the 16 standard 
functions, the four sliders on your keyboard will work the same on every preset. The 
chart on the following page shows how this might work if your keyboard transmitted 
the slider settings on MIDI controllers 21-24.
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MIDI A-P are internal connections which carry MIDI continuous controller data. Assign a MIDI Con-
tinous Controller numbers to a letter A-P in the Preferences menu, then assign the same letter to a 
modulation destination in the Voice Editor page.

Control MIDI Controller # Routing Letter Standard Function

Slider 1 21 A Controls Filter Frequency

Slider 2 22 B Controls Filter Resonance

Slider 3 23 C Controls Filter Attack

Slider 4 24 D Controls Filter Decay
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MIDI Program Change Commands
The Emulator X receives MIDI Program Change commands on each of its 32 MIDI 
channels. MIDI programs changes select Emulator X presets. The “Receive Program 
Changes” button must be turned on (depressed) in the Preferences dialog box in order 
to receive program changes or bank select commands.

MIDI Bank Select Commands
The Emulator X accepts MIDI bank select commands using MIDI continuous controller 
numbers. Continuous Controller (CC) 0 is the MSB (most significant byte) and CC 32 
is the LSB (least significant byte). Normally you send both the MSB and LSB controllers 
to implement a bank change.

f Tip: Select “Show 
Bank and Program 
Numbers” in the toolbar 
to view program and 
bank numbers in the 
preset list.

Emulator X remembers the MSB and the LSB that were last sent (or last changed from 
the front panel). For example, if you have already set the Bank MSB to 04, you need only 
send the LSB to change banks within the bank.

The selected bank remains selected until you change it (either via MIDI or by changing 
the bank from the front panel). Standard MIDI Program Change commands select from 
128 presets within the selected bank.

Background: Bank Select Commands
When the original MIDI specification was developed, no commercially available synthe-
sizer had more than about 100 preset locations. At that time being able to select up to 
128 presets didn’t seem like much of a limitation. So it was that the original MIDI speci-
fication provided for the selection of up to 128 presets.

Musicians wanted more presets and so the MIDI specification was later amended to 
include Bank Select Commands. It was decided that Bank Select Commands would use 
Continuous Controllers 0 and 32 to allow the selection of up to 16,384 banks of 128 
presets (over two million presets).

Because Bank Selects are implemented using Continuous Controllers, the Bank Selec-
tions can be made per channel. (This is getting better and better.) For each MIDI channel, 
you can select any of 16,384 banks and then one of the 128 presets in the bank. Of 
course no synthesizer has 16,384 banks (yet), but hey, it’s nice to know it’s possible (for 
that really BIG project)
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10 - Sample to Preset

Acquire (Sampling)
Sampling has always been a bit of a chore to do because of all the housekeeping and 
organization involved. In the Emulator X, we’ve invented a host of automatic tools to 
make sampling easier than ever before.

The chop function automatically extracts individual samples from a section of audio 
containing multiple notes. At the sample recording session, you set up your audio 
recorder and have the musician play each note separated by a short period of silence. 
You can make verbal cues on the tape if you wish. Later, when you’re ready to input your 
samples, the periods of silence allow the Emulator to automatically separate the 
samples for processing.

Select Acquire Samples... from the File menu. The following screen appears.

Input Controls
Record Select this option if you want to sample audio from an ASIO or DirectSound input.

Load
This option allows you to load .wav or .aiff sample files to run them through the 
gating and sample placement options. Sample gating chooses samples which are 
separated by periods of silence.
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Recording Audio (Sampling)
Choose “Record” if you want to sample from an ASIO source within your computer. To 
sample from a PatchMIx DSP input, an ASIO Send must be inserted on the desired 
PatchMix strip. 

� To Setup PatchMix DSP for Sampling into the Emulator X:

Setup the PatchMix DSP Miixer

1. Open the PatchMix DSP mixer.

2. Add a mixer strip corresponding to the analog or digital input you are using. (i.e. If 
you have a microphone connected, add a mic/line strip.)

3. Insert an ASIO Insert Send into the mixer strip. You may also want to add a Peak 
Meter to make sure you’re getting a proper input level.

Emulator X Setup

4. Open the Acquire Sample dialog from the file menu on Emulator X.

5. Select Record from the input section in the upper right corner. The Record Audio 
dialog box (shown below) appears.

6. Click on the Select Input box. The open ASIO strip names will be shown. Select the 
PatchMix DSP input you are using.

7. You should see activity on the Emulator X record meters with audio on your input.

8. That’s it! 

The Emulator X only records in stereo. To record monophonic samples just use a single 
input and convert the stereo sample to mono using the Mono<->Stereo sample edit 
tool. See “Convert to Mono or Stereo” on page 112. 

� To Begin Sampling:

1. Choose Acquire from the File menu. The Acquire/Chop Samples screen appears.

2. Press the Record… button. The following dialog box appears.

Select Input Monitor Source while Recording
(to ASIO 1&2 or DirectSound)

Input Level 
Meters

Record 
Time

Record Stop Play

Keep
Sample

Discard
Sample

Total Available 
Recording Time 

Click to Clear 
Red Clip Bars

Input Level 
Attenuator
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Record Audio Controls

3. Select the Input that you wish to record. The displayed input selections are based 
on which ASIO channels are open when the Record Audio dialog was first opened. 

• If no inputs are listed, make sure E-MU ASIO is selcted in the Preferences dialog, 
and that the current PatchMix DSP Session contains at least one ASIO Send.

4. Set your input levels using PatchMix DSP. With audio coming in, watch your 
meters. Adjust the input level using PatchMix DSP or by adjusting the volume level 
of the source. The signal peaks should illuminate the yellow area of the meter. The 
red bar at the very top of the meter indicates clipping and will stay on after clipping 
is detected. Left-click on either red bar to clear the clip indicator.

5. Press the Record button to begin recording and supply audio. The Record Time 
display begins running and the Total Available Recording Time will begin to slowly  
decrease.

6. Press the Stop button (or hit the spacebar) when you’re finished recording.

7. Press OK to keep the sample or Cancel to discard the sample. (Pressing Record 
again without clicking OK also discards the previous sample.) 

8. After pressing OK, you’re ready to set up the automatic sampling features.

Level This control allows you to attenuate the input signal to avoid clipping.

Input
Choose the desired input source. An ASIO source must be open before an input 
will be listed here.

Monitor
When this button is depressed, you can monitor the input before, during and after 
the sampling process. The monitor outputs through ASIO 1&2 (or DirectSound if 
selected). Monitor will normally be left On.

Record Press to initiate recording. Recording continues until you press stop

Stop Stops recording or playback of the sample.

Play
Plays back the recorded sample from the beginning. 
(Pressing the Space Bar toggles between Play and Stop.)

OK Keeps the sample.

Cancel Discards the sample.

Meters Stereo input signal level. The top red bars stay on after clipping. Click to clear them.
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Gating the Samples
The sample gating feature is designed for separating a series of samples separated by 
silence (SSSS). You can record  or import one long sample containing many short 
samples and let the gating feature automatically separate them for you.

f Display Units
Right-click on the 
horizontal or vertical 
rulers to change the 
display units.

Horizontal units can 
be displayed in 
samples or seconds.

Vertical units can be 
displayed in percent, 
decimal, or dB.

Gate/Chop Controls

� To Gate & Chop Samples:
After recording or loading a section of audio, you’re ready to gate and chop.

f You can also adjust 
the Threshold Level 
settings by simply 
dragging the  markers. 
Hint: Zoom in first.

Setup Parameters
1. Set the threshold Level using the numeric display or by 

setting the threshold markers in the waverform display. 
This is setting affect the accuracy of the gating. For 
percussive samples like the ones shown above, set this 
setting at -40 dB or lower to start. Different signals 
require different settings.

2. Set the Level, Pre/Post and Hold settings to the settings 
shown at left as a starting point.

3. Press the Apply button. Gates now appear on the 
waveform display. You’ll also notice that numbered 
Region Names now appear in the Region List below the 
waveform display. We’ll get to these in a minute.

Level
Sets the level change that must occur before a gate is set. Adjust this control so that 
the gates conform to the signal. The gates should appear as in the diagram above.

Pre/Post
Sets the pre-sample and post-sample time. Increase this setting if the signal attacks 
and releases are being truncated.

Hold
Sets the minimum amount of time that must pass before another gate can be set. 
This control is useful to prevent too many gates from being set.

Apply Sets the gate start and end points according the current Gate/Chop settings

Sample Overview

Threshold 
Markers

Display Zoom 
Controls

Gates

Gating Display Current View Bar
(move to change view)
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f Tip: Select a Region 
and hit the Space Bar to 
play it.

4. The gates should conform to the individual samples, similar to the screen shown on 
page 148. If not, simply change the Gate/Chop controls and Apply again.You will 
be asked if you want to “Delete the Existing Regions.” Click Yes.

Setting the gates may take a little practice to master, but it’s really very simple. In any 
case you can always set the gates manually if you wish. Read on.

Region List Controls

• Decrease the Level setting (bigger negative number) if the regions are too large.

• Increase the Level setting (smaller negative number) if the regions are too small.

• Increase the Hold time if too many gates are being set.

Play - Plays the currently selected Region.

Play All - Plays the entire Sample (all the Regions)

Stop - Stops playing

Lock All Locks all Regions.

Lock None Unlocks all Regions

Select All Selects All Regions

Select None De-selects all Regions

Name Field Displays Region name, Type directly into this field or use “Set Names” button.

Original Key
Displays key number of region. Type directly into this field or use “Set Keys” 
button to generate key numbers using pitch detection.

Start Field Displays the Start point of the Region in samples.

End Field Displays the End point of the Region in samples.

Lock Icon Locked Regions are protected against modification. Click to lock or unlock.

Set Keys Generates key numbers based on pitch detection of the region.

Set Names…
Allows you to enter a name for any selected Regions and automatically add the 
original key to the name if desired.

Delete Removes the gates from the selected Regions and removes them from the list.

Play 
Selected
Region

Region List Display

Play 
Entire

Recording

Stop
Playing Region Controls

Region
Locks (off)

Region
Name Field

Original
Key Field

Start
Sample

End
Sample

Click on 
Headings 

to Sort
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Refining the Selection

5. Try out the horizontal and vertical zoom controls in the lower right corner of the 
waveform display. Zooming in on the wave makes it a lot easier to see exactly what 
you’re doing.

6. Click on one of the numbered region names in the text area. Click on the word 
“Region” itself, not on the padlocks to the left of the names. The waveform display 
now automatically zooms in to show a closeup view of the selected region.

7. Press the Play button

8. Adjust the Start and End points of the gates manually so that they conform to the 
start and end points of the waveform. Just left-click and drag, to move them. Feel 
free to use the zoom controls if you need a closer look.

Manual Settings

9. The gates settings in the display below have a few problems. The end points have 
been set too far out and there is an extra Region without a sample.

10. Click on each of the Region names one at a time. In the example above, Region 8 is 
not gating a sample and needs to be deleted. With the Region name slected, click 
the Delete button to discard the gate. Poof!

11. In the example above, the End points can simply be dragged inward toward the 
Start point to remove the silence at the end of the sample. Press the Play button (or 
hit the Space bar) to listen to the gated area.

Labeling the Regions

12. Press the Set Keys… button in the Edit Section. The Emulator X analyzes each 
sample and labels it with the correct pitch. These key numbers can be used later for 
placing the sample on the keyboard.

13. If you know the pitch of the region, you can manually name the regions by clicking 
over the field and typing in the key number. 
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14. Click on the Name field in the Region List section. The selected section of the 
waveform is highlighted as you click on the name.

15. The Set Names… button allows you to name any selected samples. Shift-click or 
Ctrl-click to select multiple samples for naming. Use the Select All button to  
choose all regions. You can also include the original key in the sample name to 
make placement or identification easier.

16. Press the headings in the labeling section to Sort each column. Press again to sort in 
reverse order.

17. You can Lock each region after you finish setting it up to prevent any accidental 
changes from being made. Click on the little lock icons to lock and unlock, or use 
the Lock All or Lock None buttons.

Saving your Samples

1. Once the gates and labels are set, you have several options. You can save the samples 
as WAVE or AIFF files, add them to the current bank or automatically create a new 
preset containing the samples.

2. Press the To Files… button to save the samples in WAVE or AIFF format. The 
following pop-up dialog box appears.

3. Choose a location for your samples, then select WAVE or AIFF and click OK to save 
or Cancel to cancel the operation.

4. Press the To Sampler… button to add the samples to the current bank. The 
following pop-up dialog box appears.
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5. The save to sampler controls allow you to set up the automatic DSP and placement 
operations which will normalize your samples, loop them and even create a new 
preset with the samples placed on the keyboard if you choose.

Save to Sampler Controls

These features are described in detail in the next section. Please go to page 154 for more 
information.

6. Click OK to perform the Sampler Options and Build the Preset (if enabled). If you 
chose not to build a preset, the samples will be added to the end of the sample list. 
If you did build a new preset, a new preset (with your chosen name) will also be 
added to the end of the preset list in the bank.

7. Open your new preset in the Voice Processing window and modify as desired to 
complete the preset.

8. Remember to SAVE THE BANK or all your work will lost.

Normalize
Boosts the gain of the samples to make them full-level. Please read “Sample 
Options” on page 154 for more information.

Auto-loop
This option allows you to choose the algorithm for setting the loop points of 
the imported samples. Please read “Sample Options” on page 154 for more 
information.

Build Preset
When checked, this option creates a new preset using your samples. Please 
read “Build Preset Options” on page 156 for more information.

Name This Build Preset option allows you to name your new preset.

Placement
This option lets you to specify how samples will be placed in your new preset. 
Please read “Build Preset Options” on page 156 for more information.

Stretch
These options let you control how the samples fill in the empty spaces on key-
board. Please read “Build Preset Options” on page 156 for more information.

Single Voice
If this box is checked, the samples will be placed inside a single Multisample 
voice. See “Multisample Voices” on page 20 for more information.
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Importing Other Sample Formats
Emulator X can import sample formats such as .wav and .aiff. The Emulator X will then 
automatically build a preset for you, truncating, looping and placing the samples on the 
keyboard. 

There are three ways to import samples:

• Select Import Samples from the File menu to call up the selection dialog box.

• Right-Click with the mouse over the Emulator X icon in the tree, then select 
“Import Samples” to call up the selection dialog box.

• Drag and Drop the sample files over the Emulator X icon in the tree.

� To Import Samples into the Emulator X

1. When you select “Import Samples”, the following dialog box appears.

2. Locate and select the desired sample files on your computer, then press Open. The 
following dialog box appears showing the samples you just selected.

Sort Buttons

Set Original Keys 
Options

Sample Options

Build Preset 
Options

Selected Samples

These update as 
Original Key 

options are set.
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There are three groups of controls on the right side of this window.

Set Original Keys
The original key of a sample determines its pitch on the keyboard so it’s import that it 
be correctly placed. This group of controls allows you to select an automatic placement 
method for the currently selected samples.

The Set Keys button allows you to immediately process a key setting algorithm for a set 
of samples. The Original Key field in the sample area changes to show the new original 
key. You can then choose another algorithm for other samples. This allows you to try 
out the algorithms and set each sample to the proper original key before importing.

Sample Options
These sample options are applied to all selected samples. 

The Normalize option allows you to specify how amplitude normalization should be 
applied to stereo samples.

E For additional 
information, see 
Normalize on page 105.

The Auto-Loop option allows you to choose the algorithm for setting the loop points of 
the imported samples. Auto Looping attempts to find the best loop point using auto-
correlation (See page 98). The auto-looping options are listed below.

Set Original Keys Options which determine the pitch of each sample.

Sample Options Automatic sample trimming and looping options.

Build Preset Options These options determine the keyboard placement of each 
sample.

Original Key Algorithms

Embedded Info Keys are set according to key data embedded within the sample files 
themselves, if any. 

File Name Keys are set by attempting to extract key names from the sample file names. 
(A#3, B2, etc.)

Pitch Detect Keys are set by algorithmically measuring the fundamental pitch of the 
sample file.

Auto Balance Keys are set by dividing the available key range equally among the selected 
sample files.

White Keys Keys are set on successive white keys beginning at the bottom of the 
available key range.

Chromatic Samples will be placed within the preset on successive keys, beginning 
with the lowest key in the 88-key keyboard range (A-1).

Absolute Each side of the stereo sample is individually normalized without regard to the 
other channel.

Relative Each side of the stereo sample normalized by the same gain factor, so that the 
two channels maintain their relative volume.

Off No normalization processing will be performed.
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� Warning: 
Crossfading permanently 
modifies the sample data. 
For additional 
information, see 
page 114.

Tips for using Auto Loop

Auto-loop Algorithms

Whole The loop points on each imported sample are set to enclose the entire 
sample.

1/2 The loop points on each imported sample are set to enclose the last half of 
the sample.

1/2 + Crossfade The loop points on each imported sample are set to enclose the last half of 
the sample, including an appended crossfade to the loop start.

1/3 The loop points enclose the last 1/3 of the sample.

1/3 + Crossfade The loop points enclose the last 1/3 of the sample, including an appended 
crossfade to the loop start.

1/4 The loop points enclose the last 1/4 of the sample.

1/4 + Crossfade The loop points enclose the last 1/4 of the sample, including an appended 
crossfade to the loop start.

1/8 The loop points enclose the last 1/8 of the sample.

1/8 + Crossfade The loop points enclose the last 1/8 of the sample, including an appended 
crossfade to the loop start.

• Use longer loops (1/2) and crossfade on harmonically complex samples such as piano and 
strings.

• Short loops work well on simpler waveforms such as brass, flutes, guitars, etc.

• Don’t choose crossfade if you plan to fine tune your sample loops later.
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Build Preset Options
These sample options allow you to specify if a new preset should be built using the 
imported samples. 

When Build Preset is checked, a preset is created during import using all of the 
imported samples. Samples will be ordered within this preset identically to their 
ordering in the sample file list. The preset will be automatically named according to the 
first imported sample.

If “Build Preset” is unchecked, a preset will not be created during import, and the 
imported samples will simply be added to the instrument’s sample pool. The other 
controls in this group will be disabled (greyed-out) if “Build Preset” is unchecked.

Multisample Check Box - You have the option to build multiple voices (with one 
sample each) or a single multisample voice. See “Multisample Voices” on page 20. 
Check the checkbox to build one multisample voice. 

The Placement option allows you to specify how samples will be placed in the 
constructed preset. (Note that this is a separate setting from the “Original Key” 
assignment. The former setting is a property of each sample and denotes where the 
sample may be placed so that it plays back at unity pitch. This setting relates to the 
actual per-sample assigned key range within a preset.) The Placement options are listed 
below.

The Stretch options let you control how the samples fill in the empty spaces on 
keyboard. If you’re only importing four samples, C1, C2, C3, and C4, you’ll probably 
want to stretch the voice range in order to fill in the missing keys. The Stretch options 
are listed below.

Sample Placement Algorithms

Original Key Samples will be placed within the preset according to their original key 
settings.

White Keys Samples will be placed within the preset on successive white keys, beginning 
with the lowest key in the 88-key keyboard range (A-1).

Chromatic Samples will be placed within the preset on successive keys, beginning with 
the lowest key in the 88-key keyboard range (A-1).

Up Only The assigned key range of each imported sample extends upward from the 
specified placement to the key immediately below the placement of the next 
imported sample. The key range of the last imported sample extends up to the 
highest note in the 88-key keyboard range (C7).

Voice 1 Voice 2 Voice 3 Voice 4

Sample
01

Sample
02

Sample
03

Sample
04

Up
Only
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Down Only The assigned key range of each imported sample extends downward from the 
specified placement to the key immediately above the placement of the 
previous imported sample. The key range of the first imported sample extends 
down to the lowest note in the 88-key keyboard range (A-1.)

Up & Down The assigned key range of each imported sample extends upward and down-
ward from the specified placement, such that the available key range between 
imported samples is split evenly between them. If there are an uneven number 
of keys between placements of adjacent samples, the contested key will be 
assigned to the upper key range. The key range of the first imported sample 
shall extend down to the lowest note in the 88-key keyboard range (A-1), and 
the key range of the last imported sample shall extend up to the highest note 
in the 88-key keyboard range (C7.)

         Off Each imported sample is only assigned to the placement key.

Voice 1 Voice 2 Voice 3 Voice 4

Sample
01

Sample
02

Sample
03

Sample
04

Down
Only

Voice 1 Voice 2 Voice 3

Sample
01

Sample
02

Sample
03

Up
& 

Down
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The Emulator X File Converter
The Emulator X Converter is a special application that enables you to convert most 
popular sampler formats into the Emulator X’s .exb file format, for use in your Emulator 
X. Any source media may be used, such as CD-ROM’s, fixed hard drives, ZipDisks, all 
removable media, magneto-optical drives, and all others. Exception: floppy media is not 
supported, however, see notes on possible workarounds.

Supported File Types
The Emulator X file Converter can convert the following types of files into Emulator X 
format:

• Akai S-1000/3000
• Akai S-5000
• Emu E3/ESi
• Emu Emax II
• Tascam GigaStudio
• SoundFont
• Emagic EXS-24 Mark I and Mark II
• Steinberg HALion I and II
• ACID .wav files

If you don’t have sounds for any of these products, you won’t need to use the File 
Converter. Keep the application installed in case you ever want to convert file formats.

Files to Convert Area
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� To Use the File Converter:

1. SoundFont GigaStudio, EXS, HALion, and S5000 files: 
Drag and drop files from your hard drive to the Files to Convert area.

EIII, ESi, S1000, and S3000 files: 
Press the “Add Button” below the Files to Convert area, then select the files from 
your CD-ROM or hard disk.

2. Select a Destination location (Browse).

3. Press Convert. The file Converter does the rest, preserving loop, sample and preset 
information. 

4. Files may be removed from the Files to Convert area by first selecting them and 
then clicking the Remove button.

• Overwrite Existing Files - Overwrites files with the same name in the Destination 
folder.

Background
The Emulator X Converter is the result of over eight years of painstaking conversion 
work, and piles of research on sampler behavior and performance. The conversions into 
the Emulator X will be of extremely high quality - so good that sometimes you won’t 
even notice that you are using the sounds in a different sampler!

The Emulator X Converter is able to convert single files, multiple files, and entire disks - 
and even more than one disk - simultaneously. Simply click the Add button, and a 
customized file browsing dialog will appear.

From this dialog, simply choose disks, folders, or files you want to convert. You can 
select single files by double-clicking on them, or by clicking on the dialogs Add button. 
You can select multiple-selected files, or folders/disks, by selecting them and clicking on 
the dialog’s Add button.

Remember that selecting a folder to translate includes not only all the files that are 
immediately within that folder, but all files within all the folders within that folder. In 
other words, it always recurses every relevant folder tree.

The above adds the objects you want to convert into the Converter Application’s object 
list. They are not converted yet - they are they for you to pool up until everything you 
want converted are entered in. You may add or delete from that list.

Also note that if you choose a folder of, say, EXS-24 files, they are entered into the 
Converter Application list individually. You can see the name of the file and the path 
that it exists in.

Source Format Information
The Emulator X Converter is able to browse any sort of disk, whether it is PC-formatted, 
Mac-formatted, or specially formatted for a specific sampler.

Below is helpful background on each source format, and some relevant details on how 
their special features are exported into the Emulator X.

Akai S-1000/3000
The Akai S-1000 was one of the first hardware samplers using the 16-bit format. The 
S-3000 came out a couple years afterward, offering expanded programming and 
expanded structures.

The Akai format is proprietary; you cannot view the contents of the disk using the 
standard file browsing mechanisms on a computer. There are files that can be written to 
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DOS that represent the Akai format; they use the .ak1 or the .ak3 file extension. The 
Emulator X Converter supports these.

The Akai format is made of these elements:

An Akai Volume is the equivalent of an Emulator X Bank. The Emulator X Converter can 
convert whole disks, Partitions, or Volumes. You cannot convert single Programs, which 
are roughly the equivalent of an Emu Preset.

The Akai S-1000/3000 can stack Programs; in other words, play two Programs at the 
same time, by setting each Program to the same “Program Number” and the same MIDI 
Channel in their parameters. The Emulator X Converter will automatically combine 
these into the same Emulator X Preset, to mimic exactly how the Akai treats these 
Programs.

The Akai S-1000/3000 use two separate samples to perform stereo operations, usually 
marked “-L” and “-R” in their names. The Emulator X Converter will generally combine 
samples that were meant to be stereoized; please see “Combining Dual-Mono Samples 
into Stereo Files” on page 166 for more specific information.

The Emulator X Converter expects that the samples files referenced by the Akai Programs 
within the Volumes will be in the same folder as the Program, just like the Akai itself 
behaves. The vast majority of the time they are. See “Locating Referenced Samples” on 
page 164 for more information.

Akai S-5000
The Akai S-5000 uses files stored on regular computer format disks, and uses files with 
the .akp extension for their Programs, and these reference .wav files to store their 
samples. These can be mono or stereo.

Each .akp file is the equivalent of a Emulator X Bank, although when you are converting 
whole folders, each folder will convert to a single Emulator X Bank, with each .akp file 
becoming a Preset within that Bank.

Akai .akp files and the .wav files they are connected to may be quite large, up to 512mb. 

The Emulator X Converter expects that the .wav files referenced by the .akp will be in the 
same folder as the .akp, just like the Akai itself behaves. See “Locating Referenced 
Samples” on page 164 for more information.

Emu E3/ESi
The Emu E3 Series by now is the most legendary sampler ever produced. In fact it’s so 
awesome that it’s scary to even convert its format to anything else.

The Emu E3 Series format, which includes the Emulator 3, the Emulator 3x, the ESi-32, 
ESi-4000, and ESi-2000, is proprietary; you cannot view the contents of the disk using 
the standard file browsing mechanisms on a computer. There are files that can be 
written to DOS that represent the Emu E3 format; they use the .e3, .e3x, or the .esi file 
extension. The Emulator X Converter supports these.

The Emulator X structure is similar if not exact to the E3’s; an E3 Bank is equivalent to 
an Emulator X Bank.

Partitions: Maximum 60mb in size, one or more them on a drive.

Volumes: Exist inside a Partition, these hold the Programs and Samples.
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Emu Emax II
The Emax II predates the Emulator 3 by a couple of centuries (years).

The Emax format was proprietary; you cannot view the contents of the disk using the 
standard file browsing mechanisms on a computer. The Emulator X structure is similar 
to the Emax; an Emax Bank is equivalent to an Emulator X Bank.

The Emulator X Converter supports Emax II CD’s and hard drives, and supports any 
Emax .em1 file created by the EMX floppy disk program.

You can convert an entire Emax disk or one or several Banks.

Tascam GigaStudio
The Nemesys Gigasampler was the first product that became GigaStudio. Its sampler 
software played endless waves (technology developed and licensed from Rockwell) 
directly from disk. Gigasampler does provide looping, and that is good. Gigasampler 
uses the DOS disk format, since it is a Windows computer program.

Nemesys then expanded their product line to include the Gigastudio, which is essen-
tially Gigasampler 2.0; It has an improved interface, added functionality, and greater 
polyphony. Gigasampler and GigaStudio are very similar - we will refer to them as Giga.

The basic Instrument unit on Giga is the Instrument, or .gig file. A gig file can hold up to 
128 Instruments; they hold the parameters and the wavedata to be played. An 
Instrument holds a maximum 4 (GigaStudio maximum 8) keymaps, arranged in a 
horizontal mapping system called Regions (same as a Keygroup on Akai samplers, 
except they do not overlap). You can have a Region for every key on the keyboard, and a 
Region can specify up to 4 (8 for GigaStudio) samples (called Layers). Stereo interleaved 
samples are supported (they take up two Layers, of course), but a Region cannot hold 
both Stereo and Mono samples. You can also specify up to 32 velocity splits (wow), but 
this is lessened the more Layers you use. The envelopes are semi-regular PADSR's.

Giga also supports Performance files (.prf in Giga 1.0, .gsp in Giga 2.0), which are essen-
tially macros that load Instruments into the different MIDI channels. The Emulator X 
Converter supports the Giga 1.0 .prf format, as well as 2.0 .gsp GigaStudio files.

There are quite a few commercial Giga libraries that use a special compression 
algorithm; these files won't permit .wav extraction, and make the file smaller in size by 
about 20%. These .wav files aren't looped.

One very interesting thing about Gigasampler is that the file format had a copy-
protection feature on it. A sound-development company would be able to produce files 
that cannot be loaded unless a code is entered; after that, the sound resides in that 
computer while being authorized by that code. This could've helped protect the 
company from having pirated samples floating around. Interestingly, GigaStudio does 
not retain this protection, although it gives you some hard time dialogs that post 
warnings.

SoundFont
Introduced in 1993, the SoundFont sample-based synthesis format has become a 
standard with the proliferation of the Creative Technology sound cards. SoundFont 
technology is a sample format that was invented by E-MU for the purpose of creating a 
flexible wavetable synthesis solution for Creative Labs. E-MU added their expertise and 
created a solution that would be embraced for consumer and professional applications.

SoundFonts are .wav file samples that have been transformed by a SoundFont editor, 
such as Vienna, into MIDI-controllable instruments. They're also referred to as .sf2 files, 
162 Emulator X Operation Manual



11 - Appendix
The Emulator X File Converter
patches or programs, and are generally put together in groups known as SoundFont 
Banks, which can contain definitions of up to 128 instruments and one drum set..

Emagic EXS-24 Mark I and Mark II
The Emagic EXS-24 is the internal sampler that is available for Emagic’s popular Logic 
DAW. It also comes in a VST flavor called the EXSP-24 that can be used within or outside 
of Logic.

EXS-24 files can exist on PC- or Mac-formatted disks. The Emulator X Converter can 
access and convert both types, as it can view both PC and Mac drives.

The Mark I and Mark II use the same file format; the Mark II just has more features. The 
EXS-24 uses the .exs file extension, although, especially in the case of Mac files, it is not 
necessary to have the file extension. The Emulator X Converter will only see EXS-24 files 
on PC-formatted disks if they have the .exs extension; on Mac disks, they either can have 
the .exs extension or have the EXS-24 Creator code and file-type.

An EXS-24 file does not hold the samples; they are referenced and can be in the form of 
AIFF, WAVE, Sound Designer 1 or 2, or Mac System 7 files.

The EXS-24 is very popular; however, it’s programming ability is somewhat limited, 
which makes it fairly easy to convert into the Emulator X’s superior framework. 
However, there are certain features that need special addressing in Emulator X. Please 
see “Keyswitching & Other Non-Emulator X Features” on page 164 for more infor-
mation.

The EXS-24, like the Emulator X, uses streaming-like technology to load and play large 
sets of samples. The Emulator X Converter will convert any amount and size of samples, 
and the Emulator X is powerful enough to play any size.

An EXS-24 file is the equivalent of a Emulator X Bank, although when you are 
converting whole folders, each folder will convert to a single Emulator X Bank, with 
each EXS-24 file becoming a Preset within that Bank.

The EXS-24 files stores the locations of its referenced samples within its files. The 
samples do not necessarily have to be in the same folder as the EXS-24. The Emulator X 
Converter expects that the samples files referenced by the EXS-24 file will be where it 
says they will be, just like the EXS-24 itself behaves. See “Locating Referenced Samples” 
on page 164 for more information.

Steinberg HALion I and II
The Steinberg HALion is a popular VST based software sampler. HALion files can 
possibly exist on PC- or Mac-formatted disks. The Emulator X Converter can access and 
convert both types, as it can view both PC and Mac drives.

Both HALion I and II use the same file format; II just has more features. HALion files use 
the .fxp file extension, although, especially in the case of Mac files, it is not necessary to 
have the file extension. The Emulator X Converter will only see HALion files on PC-
formatted disks if they have the .fxp extension; on Mac disks, they either can have the 
.fxp extension or by file-typed with the HALion Creator code and file-type.

It is important to note that the .fxp extension is commonly used by other VST-related 
files. The Emulator X Converter only shows the .fxp files that are verified internally as 
being HALion-compatible ones.

A HALion file does not hold the samples; they are referenced and can be in the form of 
AIFF, WAVE, Sound Designer 1 or 2, or Mac System 7 files.

HALion has extensive programming capabilities, including a large modulation matrix. 
The Emulator X’s larger CORD capabilities are more than enough to handle the load; 
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however, there are certain features that need special addressing in Emulator X. Please see 
“Keyswitching & Other Non-Emulator X Features” on page 164 for more information.

HALion, like the Emulator X, uses streaming-like technology to load and play large sets 
of samples. The Emulator X Converter will convert any amount and size of samples, and 
the Emulator X is powerful enough to play any size.

A HALion file is the equivalent of a Emulator X Bank, although when you are converting 
whole folders, each folder will convert to a single Emulator X Bank, with each HALion 
file becoming a Preset within that Bank.

HALion files stores the locations of its referenced samples within its files; please see 
“Locating Referenced Samples” on page 164 for more information on how the Emulator 
X Converter handles these.

ACID .wav files
ACID files are similar in concept to Recycle files; they are usually WAVE files with an 
extra chunk that defines two or more slice points within that sample data. They still use 
the common .wav file extension like any other WAVE files does.

The Emulator X Converter simply takes the "ACIDized" WAVE file and splits the data 
into two or more Emulator X samples, and maps the references in a new Emulator X 
Bank. Since the ACID file does not define key note info, the Emulator X Converter 
simply maps them starting at key C2.

Notes…

Keyswitching & Other Non-Emulator X Features
GigaStudio, EXS-24, and HALion have some particular features that the Emulator X 
Converter attempts to recreate in some innovative ways. Below is a list of the major 
ones.

Key Switching: This is a newly-found feature where the user hits a non-sounding key on 
the music keyboard, and that tells the sampler to change sample references to point to 
(usually) a different set of samples. The Emulator X does not support this, so the 
Emulator X Converter splits each keyswitching section into separate Presets, followed 
the phrase “KSW x” (where x is the split number),

Controller Switching: This is just like the above, only the references are changed upon 
receipt of a controller message. For example, the mod wheel can be set up to reference 
one sample in the down position, when it hits value 40 the sample reference changes to 
another sample, etc. The Emulator X Converter translates this by including all the 
samples and changing the amplitude where the sample comes in per the controller. This 
is not exactly what is done with the source file, as the Emulator X is forced to use up 
polyphony whereas the source file actually turns the samples on and off, saving 
polyphony.

Release Triggering: This is when a sample is programmed to play when the engine 
receives a note-off message, rather than the normal note-on. This is not possible with 
the Emulator X, and such references are ignored.

Locating Referenced Samples
In any multisample format, such as the Emulator X’s, there are two elements: the 
Program and the Sample.

The Program is defined as the information that determines what sample will be played 
when a certain MIDI note is triggering the engine. Programs are called many things on 
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different platforms - on the Emu they are Presets, on the Ensoniq they are called Instru-
ments, and so on.

The Sample is...well, the sample data and maybe a couple immediate parameters, like 
the loop points and the sample rate.

Some formats store all this information in one file; the is called the Monolithic Method. 
A good example of this is a GigaStudio .gig file. A .gig file can be huge if it contains long 
samples or a large quantity of samples.

Other formats store the Program information in a small file, sometimes called the 
control file. In that file, there are file references that instruct the sampler engine to load a 
sample from another file. These sample references can be broken by deleting or moving 
a sample file, or in certain instances, by moving the control file. This organizational 
method is called the Separate File For Samples Method. (Or, it should be called that.)

In this method, the built-in mechanism for finding the sample that is inherent in the 
Monolithic Method is gone. The Separate File For Samples Method needs a method to 
find where the separate file is in order to load it. Below are the ways this is accomplished 
by the supported formats.

Absolute Paths
Formats Who Use this Method: EXS-24, HALion

These control files store a complete absolute path to the sample. An absolute path looks 
something like this: c:\Program Files\My Kazoo Samples\hohner.wav.

Relative Paths
Formats Who Use this Method: None

These control files store relative paths, which look like this: ..\..\My Kazoo 
Samples\hohner.wav. This means “from the control file, go up two folders, then descend 
to this file”.

Fixed Location Folder
Formats Who Use this Method: Akai S-5000, Emulator X

These formats simply assume that the sample is in the same folder as the control file, or, 
in the case of the Emulator X, they must be in a folder called SamplePool that is in the 
same folder as the control file.

Mac Catalog/FSSpec Reference
Formats Who Use this Method: HALion

Mac-oriented files, such as HALion files, use the Mac-format disk system to locate their 
sample files (this is called Catalog Searching, using a FSSpec, but never mind that for 
now).

Monolithic Files
Formats Who Use this Method: GigaStudio, Emu Emax/E3/E3x/ESi, ACID

These files store the samples within the Program files, thus the samples are always in the 
files and do not need “locating.”
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Special Notes
Akai S-1000/3000: This uses separate sample files within it’s own proprietary format, 
and it is possible for a Program to reference missing samples, but not usually.

When the Emulator X Converter encounters the Separate File For Samples Method, it 
uses the control file’s reference to find the sample and expects it to be there. If it is not, 
the Emulator X Converter will still write the reference in the Emulator X’s .exb file, 
pointing to an empty location so you may fill it in later manually within the Emulator X 
.exb file.

Combining Dual-Mono Samples into Stereo Files
Many formats do not support single Stereo files, so they simulate stereo by using two 
separate files (commonly they were sampled in simultaneously in true stereo imaging), 
layer them, and pan one hard left and the other hard right. Commonly they are named 
with the same sample/file name plus a “-L” and “-R”.

The type of samples can also occur in formats that support stereo files; for example, 
some popular Kurzweil titles are ports from original Roland sources, which do not 
support single stereo samples. Thus the Kurzweil files have separated samples that are 
configured to act as stereo. With some additional programming these could’ve been 
combined, but for some reason it was not done.

The Emulator X Converter will automatically look for samples like this and combine 
them when possible. On the whole, every instance will be combined, but there are a 
couple reasons when they will not be. Below are the specific qualifications necessary 
when combining dual mono files into Emulator X stereo files.

Naming: The ends of the samples must have the same name including spaces, plus the 
endings of the sample names need to be similarly formatted with a “L” and “R”. 
Examples: “-L” and “-R”, “L” and “R”, “(L)” and “(R)”, etc.

Loop Points: The loops points need to be the same. If they are not, the Emulator X 
Converter will not combine the samples.

Sample Sizes: Most of the time, the Emulator X Converter WILL combine these, and 
make the new file the size of the largest sample.

Exact Alternative Parameters: Some formats store Root Key, Sample Rate, Fine Tune, 
and other informations with the sample. These need to be exactly the same.

Identical References: There are occasions where a Program, or several Programs that are 
slated to go into the same Bank, will reference both the samples at one point but only 
one of them in another. The Emulator X Converter will combine the two samples but 
also write a mono version to satisfy the mono reference.

Floppy Disk Support
The Emulator X Converter does not support proprietary floppy formats, such as 
Ensoniq, Akai, Roland, Emu, or other.

However, there is a way to get your sounds off the floppies using other programs onto 
your hard drive in a form in which the Emulator X Converter can convert them to 
Emulator X formats. You can use various DOS programs written by various people over 
the years. You can get more information on these at:

www.chickensys.com/floppyprograms

Please be advised that these are frequently not supported and do not run on Windows 
XP, but please see the site for some easily attained workarounds.
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Emulator X VSTI

Launching the VSTI Application
The following instructions apply to Cubase 5.1, which is bundled with your copy of 
Emulator X. Other host applications will have their own unique methods for launching 
a VSTI application. If you are using a host application other than Cubase 5.1, consult 
the documentation that came with your host application.

f Tip: When running 
multiple VSTis, distribute  
the CPU % among the 
VSTIs.  Example: If one 
VSTi does not glitch at 
60%, set the CPU% of 
two VSTis so they add up 
to 60%.

� To Launch the Emulator XVSTI in Cubase 5.1

PatchMix DSP

1. Click the New Session button on the toolbar.

2. Select Default  MultiTrack session.

Cubase

3. Start Cubase 5.1 from the Start Menu or from the desktop icon. The following 
window appears.

4. Select one of the MIDI Tracks as shown above.

5. Click the Inspector icon shown above to open the Track Info.

6. When Cubase is finished loading, select “Panels, VST Instruments” from the menu 
bar. The VST Instruments window appears.

7. Click on “No VST Instrument” and select EmulatorXVSTI from the list.

8. In the Track Info section, click on the “Instrument” field. Select EmulatorXVSTI.

9. To the right of the Emulator X VSTI selection, a pop-up channel selection screen 
appears. Select Any.

Emulator X

10. In the VST Instruments window, click Edit. Emulator X VSTI will open.

11. From the File menu in Emulator X VSTI, select Open and select a bank to open.

12.  Play your MIDI keyboard. The MIDI Activity lights should flash on Emulator X.

Click Here
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Checklist for Launching Emulator XVSTI

Cubase 5.1
Choose the following settings in the Options menu.

• Options, Audio Setup, System

Audio I/O ...................................................... E-MU ASIO 

• Options, MIDI Setup, System
MIDI Input .................................................... E-DSP MIDI port (B800)

• Options, MIDI Setup, System
MIDI Thru...................................................... Enabled, Thru Off Channel- Off

PatchMix DSP
Male sure you have an ASIO 1 & 2 input strip in the mixer.
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Keyboard Shortcuts

File Menu
New.....................................................  Ctrl + N

Open ................................................... Ctrl + O

Merge .................................................. Ctrl + M

Save ......................................................  Ctrl + S

Edit Menu
Undo..................................................... Ctrl + Z

Redo ..................................................... Ctrl + Y

Cut.......................................................  Ctrl + X

Copy ..................................................... Ctrl + C

Paste ....................................................  Ctrl + V

Select All...............................................  Ctrl + A

Sample Edit Menu
Select Loop............................................  Ctrl + L

Select All...............................................  Ctrl + A

Transport Menu
Play from Cursor ...................................... Space

Play from Start ................................ Ctrl + Space

Go To Start .............................................  Home

Go To End .................................................. End

Go To Loop Start............................  Ctrl + Home

Go To Loop End ...............................  Ctrl + End

Go To Beginning of Selection........................... [

Go To End of Selection......................................]

Zoom Menu
Zoom In .............................................. Page Up

Zoom Out ...................................... Page Down

Zoom In Vertically......................  Ctrl + Page Up

Zoom Out Vertically............... Ctrl + Page Down

Sample Loop Menu
Move Start To Previous Zero ...........  Left Ctrl + <-

Move Start To Next Zero.................  Left Ctrl + ->

Move End To Previous Zero.......... Right Ctrl + <-

Move End To Next Zero ............... Right Ctrl + ->

Autocorrelate Loop .................................Ctrl + K
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Options
All Sound Off ...................................Ctrl + Pause

Window
Close .....................................................Alt + F4

Tile Horizontally .......................... Ctrl + Shift + H

Tile Vertically................................Ctrl + Shift + V

Presets
New Preset ........................................... Ctrl + W

Open Voices .................................... Ctrl + Enter

Open Sample ....................................Alt + Enter

New Voice............................................ Ctrl + W

New Sample Zone ..................................Alt + W

Links
New Link.............................................. Ctrl + W

View
Refresh .........................................................  F5

Voice Editor
(Place the cursor over the knob, slider or wheel)

Center Control (Pan, etc.).................. Ctrl + Click

Minimum Setting ....................................  Home

Maximum Setting........................................ End
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Right Click Shortcuts
Use the right mouse button to call up a popup window with these context-sensitive 
shortcuts.

On Instrument (Emulator X icon)
Open Bank
Merge
Import Samples
Acquire Samples
Save As
Preferences

On Preset Icon (tree)
Rename
Delete
Duplicate
Category
Export
Select on Current Channel

On Link Icon (tree)
Open in New Window
New Link

On Voice Processing Icon (tree)
Open in New Window

On Samples Folder Icon (tree)
Open in New Window
Import
Acquire
Delete Unused Samples

On a Sample Icon (tree)
Open in New Window
Rename
Delete
Duplicate
Category
Export

In Waveform Display
Zoom In
Zoom Out
Zoom In Vertically
Zoom Out Vertically
Zoom To Selection
Zoom To All
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Waveform Display - Vert. Scale
Percent-Decimal-db Scale

Waveform Display - Hor. Scale
Samples-Seconds-Loop Start-Loop End

Voice Processing (Synth)
Template List
Save As Template

Voices & Sample Zones 
(Multisample name field)

Open Voices
Open Voices in New Window
Cut Voice
Copy Voice
Paste Voice
Delete Voice
Duplicate Voice
Combine Voice
Expand Voice
New Sample Zones

Voices & Sample Zones 
(Sample name field)

Open Sample
Open Sample in New Window
Delete Sample Zones
Duplicate Sample Zones

Numeric Field
Undo
Cut
Copy
Paste
Delete
Select All

Toolbars
Checkboxes for Tools view: Status, Standard, Sample Edit, Sample Transport, Sample 
Zoom, Keyboard, Toolbars Dialog

Multisetup Icon (in tree)
Open in New Window
New
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Drag & Drop
You can use simple “Drag & Drop” operations for many Emulator X functions.

Drag & Drop Operations

From Drag & Drop To… Action

Bank File in Windows Emulator X Icon Load or Merge Bank

Bank File in Windows Emu-X System Folder Copy Move Bank

Audio File in Windows Instrument Import

Audio File in Windows Samples Folder Import

Audio File in Windows Folder in Windows Copy/Move 

Emulator X Bank File Emulator X Icon Load/Merge

Emulator X Bank File Folder in Windows Copy/Move

Emulator X Bank File Emu-X System Folder Copy/Move

Emulator X Bank Preset Emulator X Icon Merge

Emulator X Bank Preset Presets Folder Merge

Emulator X Bank Preset Multisetup Slot Merge & place

Emulator X Bank Preset Folder in Windows Export as Bank

Emulator X Bank Preset Emu-X System Folder Export as Bank

Emulator X Bank Preset Link Merge & Replace Link

Emulator X Bank Preset Link (null space) Merge & Add Link

Emulator X Bank Sample Samples Folder Import

Emulator X Bank Sample Preset Voice Merge & add to Voice

Emulator X Bank Sample Folder in Windows Export as Bank/Wave/AIFF

Emulator X Bank Sample Emu-X System Folder Export as Bank/Wave/AIFF

Emulator X Bank Sample Preset Zone Replace Zone

Emulator X Bank Sample Preset Voice (null space) Add Voice

Emulator X Bank Multisetup Emulator X Icon Merge

Emulator X Bank Multisetup Multisetup Folder Merge

Preset Multisetup Preset Slot Place

Preset Folder in Windows Export as Bank

Preset Emu-X System Folder Export as Bank

Preset Link Replace Link

Preset Link (null space) Add Link

Sample Preset Voice Add Zone to Voice

Sample Preset Voice (null space) Add Voice
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IFF

IFF
Sample Preset Zone Replace Zone

Sample Folder in Windows Export as Bank/Wave/AIFF

Sample Emu-X System Folder Export as Bank/Wave/AIFF

Multisetup Instrument Load

Instrument Multisetup Folder Save

Instrument Multisetup Replace

E4 Bank File Instrument Load/Merge

E4 Bank File Folder in Windows Copy/Move

E4 Bank File Emu-X System Folder Copy/Move

E4 Bank Preset Instrument Merge

E4 Bank Preset Presets Folder Merge

E4 Bank Preset Multisetup Preset Slot Merge & Place

E4 Bank Preset Folder in Windows Load/Merge

E4 Bank Preset Emu-X System Folder Export as Bank

E4 Bank Preset Link Merge & Replace Link

E4 Bank Preset Link (null space) Merge & Add Link

E4 Bank Sample Instrument Merge

E4 Bank Sample Samples Folder Merge

E4 Bank Sample Folder in Windows Export as Bank/Wave/AIFF

E4 Bank Sample Emu-X System Folder Export as Bank/Wave/AIFF

E4 Bank Sample Preset Zone Replace Zone

E4 Bank Sample Preset Voice (null space) Add Voice

E4 Bank Multisetup Instrument Merge

E4 Bank Multisetup Multisetup Folder Merge

E4 Bank File (CD) Instrument Load/Move

E4 Bank File (CD) Folder in Windows Copy/Move

E4 Bank File (CD) Emu-X System Folder Copy/Move

E4 Bank Preset (CD) Instrument Merge

E4 Bank Preset (CD) Presets Folder Merge

E4 Bank Preset (CD) Multisetup Preset Slot Merge & Place

E4 Bank Preset (CD) Folder in Windows Export

E4 Bank Preset (CD) Emu-X System Folder Export 

Drag & Drop Operations

From Drag & Drop To… Action

E4 Bank Preset (CD) Link Merge & Replace Link

E4 Bank Preset (CD) Link (null space) Merge & Add Link

E4 Bank Sample (CD) Instrument Merge

E4 Bank Sample (CD) Samples Folder Merge

E4 Bank Sample (CD) Preset Voice Merge & Add to Voice

E4 Bank Sample (CD) Folder in Windows Export as Bank/Wave/A

E4 Bank Sample (CD) Emu-X System Folder Export as Bank/Wave/A

E4 Bank Multisetup Instrument Merge

E4 Bank Multisetup Multisetup Folder Merge

Drag & Drop Operations

From Drag & Drop To… Action
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Toolbar Functions

Standard Tools

Back

Forward

New Bank

Open Bank

Save Bank

Cut Sample

Copy Sample

Paste Sample

Undo

RedoUp

Show Name 
Only

Show Object 
Number

Show Bank 
& Prog No.

Show Large 
Icons

Show Small 
Icons

List View

Show 
Details

Help

Status Bar

CPU Usage

Basic
MIDI Channel

Sample Name
& Number

Number of
Samples Playing

Samples In RAM
Current Voice
& KYBD Range

Fade

Normalize

Adjust
Gain Reverse Loop

Truncate DC
Filter

Swap
Channels

Bit
Reduction

Time
Compress

Pitch
Shift

Stereo 
<-> Mono

Sample
Rate Convert

Auto-
correlate

Select 
Loop

Select 
All

Sample Edit Tools

Horizontal 
Zoom In

Horizontal 
Zoom Out

Vertical 
Zoom In

Zoom to All

Zoom to 
Selection

Vertical 
Zoom Out
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MIDI Implementation Chart
MIDI Information Transmitted Recognized Remarks

MIDI Channels No 1-16, 17-32 32 MIDI Chan.

Note Numbers No 0-127

Program Change No 0-127

Bank Select Response? No Yes MSB + LSB

Modes: Omni (Mode 1)
            Mono (Mode 2)
            Poly (Mode 3)
            Mode 4 (Y/N)
            Multi (Mode 5)

No
No
No
No
No

No
No
No
No
No

Responds to all MIDI 
channels

Note On Velocity No Yes

Note Off Velocity No Yes

Channel Aftertouch No Yes

Poly (Key) Aftertouch No No

Pitch Bend No Yes

Active Sensing No No

System Reset No No

Tune Request No No

System Exclusive
Sample Dump Standard
File Dump
MIDI Tuning
Master Volume
Master Balance
Notation Information
Turn GM1 System On
Turn GM2 System On
Turn GM1 System Off
Other (See Remarks)

No
No
No
No
No
No
No
No
No
No
No

No
No
No
No
No
No
No
No
No
No
No

NRPNs No No

RPN 00 (Pitch Bend Sensi.)
RPN 01 (Chan. Fine Tune)
RPN 02 (Chan Coar. Tune)
RPN 03 (Tuning Prog Sel.)
RPN 04 (Tuning Bank Sel.)
RPN 05 (Mod Depth Rang)

No
No
No
No
No
No

No
No
No
No
No
No

MIDI Timing & Sync No No

MIDI Clock Yes Yes

Song Position Pointer No No

Song Select No No

Start
Continue
Stop

No
No
No

No
No
No

MIDI Time Code No No

MIDI Machine Control No No

MIDI Show Control No No

General MIDI Compat?
Is GM default mode?

No
No

No
No

DLS compatible?
Import DLS Files?
Export DLS Files?

No
No
No

No
No
No

Import Std MIDI files
Export Std MIDI files

No
No

No
No
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MIDI Implementation Chart (part 2 - Controllers)
Control # Function Transmitted Recognized Remarks

0 Bank Select MSB No Yes See Note

1 Mod Wheel MSB No Yes *

2 Breath Cntrl MSB No No *

3 No * 

4 Foot Cntrl MSB No No * 

5 Portamento MSB No No * 

6 Data Entry MSB No No * 

7 Chan Volume MSB No Yes *

8 Balance MSB No No *

9 *

10 Pan MSB No Yes *

11 Expression MSB No Yes *

12 Effect Cntrl 1 MSB No No *

13 Effect Cntrl 2 MSB No No *

14 *

15 *

16 GenPur Ctrl 1 MSB *

17 GenPur Ctrl 2 MSB *

18 GenPur Ctrl 3 MSB *

19 GenPur Ctrl 4 MSB *

20 *

21 *

22 *

23 * 

24 *

25 * 

26 * 

27 *

28 *

29 *

30 *

31 *

32 Bank Select LSB *

33 Mod Wheel LSB *

34 Breath Cntrl LSB *

35 *

36 Foot Cntrlr LSB *

37 Portamento LSB *

38 Data Entry LSB *

39 Chan Volume LSB *

40 Balance LSB *

41 *

42 Pan LSB *

43 Expression LSB *

44 Effect Cntrl 1 LSB *
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45 Effect Cntrl 2 LSB *

46 *

47 *

48 Gen Pur Ctrl 1 LSB *

49 Gen Pur Ctrl 2 LSB *

50 Gen Pur Ctrl 3 LSB *

51 Gen Pur Ctrl 4 LSB *

52 *

53 *

54 *

55 *

56 *

57 *

58 *

59 *

60 *

61 * 

62 *

63 *

64 Sustain Pedal No Yes *

65 Portamento on/off No No *

66 Sostenuto No No *

67 Soft Pedal *

68 Legato Footswitch *

69 Hold 2 *

70 Variation *

71 Timbre/Har Inten Yes Yes *

72 Release Time Yes *

73 Attack Time Yes *

74 Brightness Yes *

75 Sound Cntrlr 6 ™ Yes Yes * 

76 Sound Cntrlr 7 *

77 Sound Cntrlr 8 ™ Yes Yes * 

78 Sound Cntrlr 9 ™ Yes Yes *

79 Sound Cntrlr 10 Yes Yes *

80 Gen Purp Cntrlr 5 Yes Yes *

81 Gen Purp Cntrlr 6 *

82 Gen Pur Ctrlr 7 ™ Yes Yes * 

83 Gen Pur Ctrlr 8 ™ Yes Yes *

84 Portamento Cntrl *

85      *

86 *

87 *

88 *

89 *

90 *

Control # Function Transmitted Recognized Remarks
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91 Effects 1 Depth Yes *

92 Effects 2 Depth *

93 Effects 3 Depth Yes *

94 Effects 4 Depth *

95 Effects 5 Depth *

96 Data Increment

97 Data Decrement

98 NRPN (LSB)

99 NRPN (MSB)

100 RPN (LSB)

101 RPN (MSB)

102

103

104

105

106

107

108

109

110

111

112

113

114

115

116

117

118

119

120 All Sound Off No Yes  See note �

121 Reset All Controllers No Yes

122 Local Cntrl on/off No No

123 All Notes Off No Yes

124 Omni Mode Off No No

125 Omni Mode On No No

126 Poly Mode Off No No

127 Poly Mode On No No Poly mode is 
always on.

NOTES:     * Emulator X can receive ANY continuous controller number from 1 to 
95. Because of Emulator X’s powerful synth engine, many of the standard 
MIDI controllers can be user programmed to provide the desired function. 
A “Yes” response in this chart means that a controller is programmed by 
default in Emulator X.

                     � Value of 0 = reset all except vol & pan; value of 127 = reset all.

                      Other: Pan: -64 = hard left, +63 = hard right 

Control # Function Transmitted Recognized Remarks
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Received Channel Commands
Channels number (n) = 0-15. Message bytes are represented in hex. All other numbers 
are decimal. Running Status is supported.

Special Notes:

Command Message Comments

Note Off 8n kk vv

Note On 9n kk vv velocity 0 = note off

Key Aftertouch An kk vv kk = 0-127  vv = 0-127

Program Change Cn vv 0-127

Channel Aftertouch Dn vv 0-127

Pitch Bend En ll  mm l = lsb, m = msb

Real-time Controller Bn cc vv cc = 00-31, 64-95

Footswitch Bn cc vv cc = 64-79, vv ≥ 64 = on

Volume Bn 07 vv 0-127

Pan Bn 0A vv 0=left, 127=right, 64=center

All Sound Off Bn 78 00 turns all sound off

Reset All Controllers Bn 79 00 ignored in omni mode

All Notes Off Bn 7B 00 ignored in omni mode

Omni Mode Off* Bn 7C 00 forces all notes & controls off

Omni Mode On* Bn 7D 00 forces all notes & controls off

Mono Mode On (Poly Off)* Bn 7E 00 forces all notes & controls off

Poly Mode On (Mono Off)* Bn 7F 00 forces all notes & controls off

Bank Select MSB Bn 00 bb bb = bank MSB  Go There!

Bank Select LSB Bn 20 bb bb = bank LSB  Go There!

• From Omni Mode Omni Off turns Poly On.

• From Poly Mode Omni On turns Omni On; Mono On turns Mono On.

• From Mono Mode Mono Off turns Poly On; Omni On turns Omni On.

• From Multi Mode
Omni On turns Omni On; Omni Off or Mono Off turns Poly On; 
Mono On turns Mono On.

All other changes have no effect
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Index

Symbols
~, +, - modulation source polarity 87

Numerics
19-tone tuning 49
4x Gain 135

A
Absolute Value 135
ACID, converting files to Emulator X 159
Acquire Samples 145
Adjust Gain, sample 106
Advanced Preference Settings 9
Aftertouch, modulation source 128
Aftertouch, Mono 128
Akai, converting files to Emulator X 159, 160
Alternate Tunings 49
Amount, patchcord 142
Amp Envelope Depth 82
Amplifer Volume 82
Amplifier Controls 82
Amplifier Pan 82
Analog Oscillator Sound 71
Architecture, description 18
ASIO

audio drivers 8
inputs for sampling 146

Assign Group, voice 91
Audio Setup 8
Auto Balance 154
Autocorrelate Loop 98
Auto-Loop 154
Auto-Normalize 154
Aux Enable 83
Aux Output Diagram 44
Aux Outputs 42
Aux Sends 1-3 83

B
Backwards, playing samples 107
Band-Pass Filter 76, 138
Bank

create new using librarian 37
description 15

Bank Select, MIDI 144
Bit Reduction 108
Body Size 76
BPM Envelopes 74
Buffer Size 9
Buffers, sample 8
Build Preset Options 156

C
Catalog Disks 36
Category

tags, adding to samples/presets 37
CC Window, link 66
Channel Lag Processors 50
Channel Ramp Processor 52
Channel Swap 107
Chorus 71
Chromatic 154
Classic Response 82
Clear Library 36
Clipping

headroom 9
preventing 43

Clock
divisors 133
external MIDI 74, 89
master 41
modulation 132

Coarse Tune/Transpose Differences 70
Coarse Tuning, voice 70
Comb Filter 77
Combine Voices 61
Compression, time of sample 108
Constant Time, pitch change 110
Context Sensitive Menus 126, 171
Continuous Controller 142

cross-switch between voices 60
Controllers

#7 11
initial values 48
MIDI 142
MIDI #7 142
MIDI real-time 142
MIDI setup 12
modify the sound using 25
modulation source 129
sensitivity 11

Convert
24-bit to 16-bit 108
other files to Emulator X format 159
sample rate 111
stereo to mono 112

Copy Section 100
Cords 84, 134

lore 87
modulation 129

CPU Cap 9
CPU Meter 45
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D

Crossfade
looping 114
positional 57
random 132

Crossfade Looping 114
how to use 117

Current Channel Indicator 45
Current MIDI Channel 39
Current Preset, changing 24
Curve

glide 71
velocity 11

Cut Section 100
Cut/Copy/Paste

sample 99, 122
synth settings 122
voices 122

D
DC Filter, sample 106
Delay

LFO 88
voice 72

Delete
region 149
sample 99
sample zone 62
voice 61
voices 61

Destinations, Modulation 134
Diode 135
DirectSound 8
Display Units, changing 97
Divisors, Clock 133
Drag & Drop 120

operations list 173
Duplicate, sample zone 62
Dynamic Range Adjust 9

E
E3, converting files to Emulator X 159
Effect Sends 42
Emagic EXS-24, converting files to Emulator X 159
Emax, converting files to Emulator X 159
Embedded Info 154
Emulator X File Converter 159
Envelope

generators 129
about 130

rates, scaling time of 74, 86
repeating 74
retriggering 130

Envelope Generators, description 73
Equal Power Mix, paste sample 102
Equal Power, crossfade loop 114
Equal Temperment Tuning 49
Expand Voice 61
External Tempo Source 11, 41

F
Fade

bars in voices and zones windows 55
sample 104

Filter
about 137
bandpass 76, 138
comb 77
controls 76
cost on voice count 8
descriptions 76
global type 45
highpass 138
lowpass 137
notch 139
parametric 140
poles 139
swept EQ 140
types 76
Z-plane 141

Find, files using the librarian 36
Fine Tuning 70

linked preset 65
Fingered Glide 92
First Key, modulation 52
Fixed Pitch Mode 70
Flip-Flop 135
Footswitch 129

G
Gain Adjust, sample 106
Gain Fade, sample 104
Gain, filter 76
Gamelan Tuning 49
Gate, modulation source 128
Gate/Chop Controls 148
Gating, samples 148
Generator

envelope 129, 130
noise 129

GigaStudio, converting files to Emulator X 159
Glide 71

modulation source 128
rate 71

Global Controls 41
Gosset-Smith Tuning 110
Groove Loops 115
Groups 54

H
HALion, converting files to Emulator X 159
Hard Drive Requirements 3
Hass-Effect 71
Headroom/Boost Control 9
High Hat Simulation 91
High-Pass Filter 138
Hold, gate/chop control 148
182 Emulator X Operation Manual



Index
I

I
Implementation Chart, MIDI 176, 177
Initital Controllers A-P 48
Input Source, sampling 147
IntelliEdit 10
Inter-Aural Time Delay 71
Inverting, Mod. Sources 132
ITD 71

J
Just C Tuning 49

description 49
Just Intonation 49

K
Key

glide, modulation source 128
ranges & fades, adjusting 121
transpose 70
transpose, voice 68
velocity, modulation source 128

Key Sync, LFO 89
Key Timer, poly 51
Key Window 55

link 66
Key/Velocity Windows

exploring 28
Keyboard

key, modulation source 128
modes 92
pressure modulation source 128
ranges 55
tuning 49

19-tone 49
equal temperment 49
gamelan 49
just C 49
Kirnberger 49
repeating octave 49
Scarlatti 49
Vallotti 49
Werkmeister III 49

Kirnberger Tuning 49

L
Lag Amount, preset lag 50
Lag Processors

preset 50
voice 90, 135

Large Icons 124
Latch Mode 93
Layering

presets, using links 65
voices & samples 56

Level, gate/chop control 148
LFO 88, 129

delay 88
sync 132
tips & tricks 90
variation 89
waveforms 131
waveshapes 88

Librarian 36
Limiter 43
Linear Mix, paste sample 102
Linear, crossfade loop 114
Links 64

preset 64
utilities 65

List View 124
Load Emulator 4 bank 23
Load Last Bank at Startup 13
Lock Loop 115
Lock Region 149
Loop 113

autocorrelation 98
button 115
compression 114
crossfade 114
envelopes 74
how to loop a sample 116
length, locking 115
modulation 90
processing 113
settings 115

Loop in Release 115
Low Frequency Oscillator 88, 129, 131
Low-Pass Filter 137

M
Master Clock 41
Master Transpose 43
Master Tune 43
Master Volume Control 41
Melody (last) 92
Merge, library object into the bank 37
Meters

main output 41
sample input 147

MIDI
bank select commands 144
cc cross-switch voices 60
cc#7 curve 11
channel

current 39
channel in multisetup 40
channel, current 25
clock

using external 74, 89
continuous controller 142
continuus controller setup 12
controller #7 11
controllers

global page 45
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implementation chart 176, 177
note-on 72
preferences 10
program change enable/disable 11
program changes 144
real-time controllers 142
selecting input ports 10
velocity curve 11

MIDI Response 11
Mini Keyboard 45
MiniMoog, solo mode 92
Mix/Tune Tab 53
Mod Wheel, modulation source 128
Mode

fixed pitch 70
mono 180
multi 180
omni 180
poly 180
solo 92

Modulation 127
cords 129
description 127
destination 134

list 134
destinations 134
of loop 90
processors 135
source list 134
source, random 132
sources 128

adding 87
Monitor Input, sampling 147
Mono Aftertouch 128
Mono A-I 91
Mono Mode 180
Mono to Stereo Conversion 112
Morphing Filters 79, 141
Multi Mode 180
Multiple Trigger 92
Multisample Voices

description 20
viewing & editing 53

Multisetup
basic operations 46
description 17
intro 24
MIDI channel 40
output assignment 41
selecting 39
selecting presets 40

N
Network

searching with librarian 36
New

sample zone 62
voice 61

Noise Generator 129
Normalize, sample 105, 106
Notch Filter 139
Note Division, BPM envelopes 75, 89
Number of Samples Playing 45
Numeric Values, entering 120

O
Offset

sample start 72
Omni Mode 180
Open Sample 61
Open Voices 61
Optimizing your Computer 3
Optimizing your computer 3
Original Key 55

setting in region list 149

P
Pan

amplifer 82
in multisetup 41
linked preset 65

Parametric Filter 140
Paste Section 101
Patchcord, amount 142
PatchMix DSP, setting up for sampling 146
Pedal, modulation source 128
Pink Noise 136
Pitch Change, sample 110
Pitch Detect 154
Pitch Wheel 128
Play Button, sampling 147
Polarity, modulation source 87
Poly 16 A-B 91
Poly All 91
Poly Key Timer 51
Poly Mode 180
Poly Normal 92
Poly Release Trig 92
Polyphony, optimizing 8
Positional Crossfade 57
Pre/Post, gate/chop controls 148
Preferences 6
Pre-roll 7
Preroll RAM Indicator 45
Preset

about 17
auditioning 24
changing 24
cords 52
description 17
editing 47, 127
links 64
opening 27
selecting from the tree 25

Preset Global Page 48
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Q

Preset Lag Processor, patchcord destinations 52
Preset Modulators 50
Preset Ramp Processor, patchcord destinations 52
Processor

channel lag 50
channel ramp 52
modulation 135

lag 136
quantizer 136

Program Change Commands 144
Pulse Width Modulation 90

Q
Q 78, 139
Quantizer 135, 136

R
Ramp, channel 52
Random

crossfade 132
crosswitch between voices 59
generator 129
modulation 132

Range, keyboard 55
Realtime Controller, tutorial 142
Realtime Window 58
Receive Program Changes 11
Record Button, sampling 147
Recording Audio 146
Reducing Bits, sample 108
Region List 149
Release Velocity, modulation source 128
Re-order Samples 122
Re-order Voices 122
Resonance

controlling in realtime 86
definition 139
filter 78

Response, amplifier 82
Retrigger 133
Retriggering Envelopes 130
Reverse, sample 107
Right Click Shortcut 171

S
Sample

calculator 111
change pitch of 110
DC filter 106
definition 21
description 18
editing tools 104
fade 104
layering 56
normalize 105, 106
open 61
rate convert, sample 111

rate, setting 9
retrigger 86
reverse 107
start offset 72
truncation 104

Sample Buffers 8
Sample Editor 95
Sample Zone

definition 62
delete 62
duplicate 62
new 62
utilities 62

Sampling 146
Save 15, 35

definition 15
Save As 15, 35
Scarlatti Tuning 49
Scribble Strip 45
SCSI Tips 3
Select All, sample 115
Select Loop 115
Select on Current Channel 40
Send Aux 1-3 86
Send Main 86
Sensitivity, MIDI controller #7 11
Set Keys, sample acquire 149
Set Keys, sample placement 154
Set Names, region 151
Set Names, sample acquire 149
Set Original Key, sample placement 154
Shape, LFO 88
Show Bank & Program Numbers 124
Show/Hide Object Numbers 124
Signal Path, simplified 67
Single Cycle Loop 112
Small Icons 124
Software Installation 2
Solo Release Trig 92
Solo, keyboard modes 92
SoundFont, converting files to Emulator X 159
Sources, Modulation 128
Standardized MIDI Controller Numbers 177
Stereo to Mono Conversion 112
Stereo Width, voice chorus 71
Stop Button, sampling 147
Streaming, description 7
Summing Amps 135

using lag processors 90
Summing Nodes 87
Swap L-R Channels 107
Swept EQ Filter 140
Switch 135
Sync LFO 89

to clock 132
Synth Solo Mode 92
Synthesizer Controls 67
System Requirements 2
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T
Tempered Tuning 49
Templates 68
Tempo Control 41

enable/disable 11
Tempo, fitting a sample to 108
Time Compression, sample 108
Toolbars 119

viewing & hiding 120
Transport/Loop Controls 97
Transpose

key 70
linked preset 65
master 43
non-transpose mode 70
preset global 48

Tree View 124
Tree, exploring 23
Trigger, multiple keyboard mode 92
Triggering Envelopes, from modulation sources 130
Truncate Sample 104
Truncate, after loop 114
Tuning

19-tone 49
coarse 70
equal temperment 49
gamelan 49
just C 49
keyboard 49
Kirnberger 49
repeating octave 49
Scarlatti 49
Vallotti 49
voice fine 70
Werkmeister 49

Tuning Tables 49
Tuning to other instruments 43

U
Ultra-High Precision Interpolation 9
Undo & Redo 99, 126
Update Library 36
Use Optimal Buffer Size 9
Utilities, link 65

V
Vallotti Tuning 49
Variation, LFO 89
Velocity Curve, MIDI 11
Velocity Window 57

link 66
View Menu 123
Voice 29

add to preset 29
assign group 91
coarse tuning 70
combine 61
continuous controller cross-switch 60

crossfading by realtime controller 58
crossfading by velocity 58
delay 72
delete 61
description 17, 19
expand 61
fine tuning 70
fixed pitch mode 70
key transpose 70
keyboard range 55
lag processors 90
layering 56
new 61
random crosswitch 59
realtime crossfade 59
realtime window 58
selection 53
switching by key position 55
switching by realtime controller 58, 60
switching by velocity 58
utilities 61
velocity range 57

Voice & Sample Zone Utilities 61
Voice Editor, overview 68
Voice Effect Sends 83
Voices

& sample zones 53
grouping 54
open 61
selecting multiple 67

Volume
in multisetup 41
linked preset 65
preset global 48

Volume Control, master 41
Volume Curve 11
Volume Sensitivity 11
VU Meter 41

recording 146

W
Waveforms, LFO 131
Wavetable Scanning Synthesis 90
Werkmeister Tuning 49
Wheels, Pitch & Mod. 128
White Keys 154
White Noise 132

Z
Zero Crossing 117
Zoom Tools 96
Z-plane Filter 79, 141
186 Emulator X Operation Manual


	Table of Contents
	1 - Introduction & Installation
	Introduction
	Emulator X
	Before you Begin…
	Notes, Tips and Warnings


	System Requirements
	Software Installation
	Programs installed
	Register your Software
	Optimizing Your Computer for Emulator X
	SCSI and IDE Drive Tips and Considerations

	Setting up your Audio
	Setting up the Preferences
	Audio Preferences
	Streaming
	Pre-roll
	Audio Setup
	VST Output Buses

	MIDI
	MIDI Inputs
	MIDI Response

	Controllers
	Other Settings
	Appearance Settings in Windows



	2 - Emulator Architecture
	A Modular System
	Bank
	Saving
	Multisetup
	Preset
	Voice
	Sample

	Flexible Architecture
	Preset Diagram
	Voices
	Multisample Voices

	The Sample


	3 - Getting Started
	Exploring the Tree
	Multisetup Page
	Changing Presets
	Adjusting the Controllers

	Create Your Own Custom Bank
	Load a New Bank
	Opening a Preset
	Much More…

	Examine a Voice
	Examine the Samples
	Using DSP
	Experiment!

	Save and Save As

	The Librarian

	4 - Multisetup / Global Controls
	The Multisetup
	The Current MIDI Channel
	MIDI Channel
	Preset Assignment
	Channel Volume
	Channel Pan
	Output Assignment
	Aux Send Enables

	Global Controls
	Master Volume Control & VU Meter
	Tempo Control
	Aux Outputs
	Emulator Sessions in PatchMix DSP
	Master Tune
	Master Transpose
	Limiter
	Aux Output Diagram
	Filter Override
	MIDI Controllers & Scribble Strips
	Mini Keyboard
	Preroll RAM Used
	CPU Meter
	Number of Samples Playing
	Current Channel

	Working with Multisetups

	5 - Preset Editor
	Preset Globals
	Transpose & Volume
	Initial Controllers A-P
	Tuning Tables
	Preset Modulators
	Channel Lag 1 & 2 Rate
	Poly Key Timer
	Channel Ramp
	Preset PatchCords


	Voices & Sample Zones
	Mix/Tune Tab
	Voice Selection
	Samples & Multisamples
	Groups

	Key Window Page
	Velocity Window Tab
	Realtime Window Tab
	Continuous Controller Window Tabs

	Voice & Sample Zone Utilities
	Voice Utilities
	Open Voices
	Open Sample
	New Voice
	Delete Voices
	Duplicate Voices
	Combine Voices
	Expand Voice
	Sample Zone Utilities
	New Sample Zone
	Delete Sample Zones
	Duplicate Sample Zones


	Edit Menu Utilities - Cut, Copy & Paste
	Links
	Link Utilities
	Mix/Tune Window
	Key Window
	Velocity Window
	CC Window


	6 - Voice Editor / Synthesizer Level
	Simplified Emulator X Signal Path
	Overview of the Voice Editor
	Templates

	Oscillator
	Pitch Bend Range
	Tuning Controls
	Transpose
	Coarse Tuning
	Fine Tuning
	Fixed Pitch Mode

	Chorus Amount
	Tips for Using Chorus

	Glide Rate & Curve
	Key Controls
	Delay
	Sample Offset
	Sample Start Offset


	Amplifier, Filter & Auxiliary Envelopes
	Adjusting the Envelopes
	Time-based and BPM Envelopes
	BPM Envelopes

	Envelope Repeat
	Filter Controls
	Filter Descriptions
	Filter Types

	Programmable Morphing Filters
	Dual EQ Morph
	2EQ Morph + Expression
	2EQ + Lowpass Morph
	Peak/Shelf Morph


	Amplifier Controls
	Volume
	Pan
	Amp Envelope Dynamic Range
	Response

	Voice Effect Sends
	Modulation Cords
	Modulation Source Polarity
	Summing Nodes
	PatchCord Lore
	LFO 1 & 2
	Delay
	Shape
	Variation
	Sync
	BPM
	LFO Tricks & Tips:

	Lag Processors 1 & 2
	Sample Loop Modulation

	Assign Group
	Keyboard Modes
	Latch Mode


	7 - Editing a Sample
	Sample Editor Window
	Zoom Tools
	Zoom In (Horizontal)
	Zoom Out (Horizontal)
	Zoom In (Vertical)
	Zoom Out (Vertical)
	Zoom To Selection
	Zoom To All

	Exporting & Importing Samples
	Changing the Display Units
	Vertical Units
	Horizontal Units

	Transport/Loop Controls
	Play
	Play from Start
	Stop
	Loop Play
	Go to Sample Start
	Go to Sample End
	Go to Loop Start
	Go to Loop End
	Move Start to Previous Zero
	Move Start to Next Zero
	Move End to Previous Zero
	Move End to Previous/Next Zero
	Autocorrelate Loop

	Cut, Copy, Paste & Delete
	Undo and Redo
	Typical Applications
	Cut Section
	Copy Section
	Paste Section

	Sample Edit Tools
	Truncate
	Fade
	Normalize
	Adjust Gain
	DC Filter
	Reverse
	Swap L-R Channels
	Bit Reduction
	Time Compression
	Pitch Change
	Sample Rate Convert
	Convert to Mono or Stereo
	Loop Processing
	Crossfade Looping
	Truncate after Loop
	Loop Compression

	Loop Settings
	Loop Button
	Loop in Release
	Lock Button

	Select Loop
	Select All
	How to Loop a Sample
	Zero Crossing


	8 - Controls
	The Toolbars
	Viewing and Hiding the Toolbars

	Drag & Drop
	Changing Settings
	Entering Numeric Values

	Adjusting Key Ranges & Fades
	Selecting Voices using your MIDI Keyboard
	Voice Processing Graphic Keyboard Operation

	Adjusting Envelopes
	BPM Mode & Tempo

	Cut, Copy & Paste
	View Menu
	Main Display View
	Tree View
	Tree Navigation using the Keyboard
	Cursor Keys
	Find Items

	Refresh (F5)
	Context Sensitive Menus
	Undo/Redo


	9 - Synthesizer Basics
	Editing Presets
	Modulation
	Modulation Sources
	Keyboard Key
	Key Velocity
	Release Velocity
	Gate
	Key Glide
	Pitch and Mod Wheels
	Keyboard Pressure (mono aftertouch)
	Pedal
	Miscellaneous Controllers A -P
	Low Frequency Oscillators (2 per voice)
	Envelope Generators (3 per voice)
	Noise & Random Generators
	T-switch and Footswitches

	Modulation Cords

	Envelope Generators
	Retriggering

	Low Frequency Oscillators (LFOs)
	Random Sources
	Clock Modulation
	Syncing an LFO to the Clock

	Modulation Destinations
	Modulation Processors
	Modulation Processor Examples

	Dynamic Filters
	What is a Filter?
	Parametric Filters
	The Z-Plane Filter

	MIDI Channels & Real-time Controls
	MIDI Program Change Commands
	MIDI Bank Select Commands
	Background: Bank Select Commands



	10 - Sample to Preset
	Acquire (Sampling)
	Input Controls
	Recording Audio (Sampling)
	Record Audio Controls

	Gating the Samples
	Gate/Chop Controls
	Region List Controls

	Saving your Samples
	Save to Sampler Controls


	Importing Other Sample Formats
	Set Original Keys
	Original Key Algorithms

	Sample Options
	Build Preset Options


	11 - Appendix
	The Emulator X File Converter
	Supported File Types
	Background
	Source Format Information
	Akai S-1000/3000
	Akai S-5000
	Emu E3/ESi
	Emu Emax II
	Tascam GigaStudio
	SoundFont
	Emagic EXS-24 Mark I and Mark II
	Steinberg HALion I and II
	ACID .wav files

	Notes…
	Keyswitching & Other Non-Emulator X Features
	Locating Referenced Samples
	Absolute Paths
	Relative Paths
	Fixed Location Folder
	Mac Catalog/FSSpec Reference
	Monolithic Files

	Special Notes
	Combining Dual-Mono Samples into Stereo Files
	Floppy Disk Support


	Emulator X VSTI
	Launching the VSTI Application
	Checklist for Launching Emulator XVSTI
	Cubase 5.1
	PatchMix DSP


	Keyboard Shortcuts
	Right Click Shortcuts
	Drag & Drop
	Toolbar Functions
	MIDI Implementation Chart
	MIDI Implementation Chart (part 2 - Controllers) Received Channel Commands
	Special Notes:


	Index

